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General information 
This document contains all information for the intended use of the system/product 
delivered. This document is intended for persons with basic knowledge of installation 
and operation of software-controlled systems. General knowledge of operational 
safety as well as basic knowledge of using PCs running Microsoft Windows® and 
basic knowledge of your LPKF system software are required. 

 

When processing the how-to examples, carefully note the safety instructions from the 
applicable user manual of your system! 
 

 

Validity 
This document corresponds to the technical state at the time of publication. 
LPKF Laser & Electronics AG (abbreviated to LPKF in the following) reserves the right 
to make changes in respect to the content of this document. The figures in this 
document serve as basic understanding and can differ from the actual state of the 
system. 

Structure of warning messages and safety notes 
The safety notes and warning messages in this document identify hazards and risks 
and they are created in accordance with ANSI Z535.6-2011 and the standards series 
ISO 3864. 

The warning messages are structured as follows: 

• Warning sign (only for injuries) 
• Signal word indicating the hazard class 
• Type and source of the hazard 
• Consequences of non-observance 
• Measures to avoid the hazard 

 + SIGNAL WORD 
Type and source of the hazard! 
Consequences of non-observance. 
 Measures to avoid the hazard.  
 Further measure(s) to avoid the hazard. 

 
Warning messages can also be embedded in the format of the surrounding text in 
order to avoid a visual disruption in a sequence. In this case, they are distinguished as 
follows: 

Type and source of the hazard! 
Consequences of non-observance. 
 Measure(s) to avoid the hazard. 



 

 

General information 
 

ProtoLaser U4/S4/R4 

4/274  LPKF Laser & Electronics d.o.o. | V. 4.0 

Warning messages are classified in hazard classes represented by the signal word. In 
the following, the warning messages are described in accordance to their hazard 
classes: 

 DANGER 
Type and source of the hazard! 
This warning message indicates a hazard of high risk that causes death or serious 
injury if not avoided. 
 Measures to avoid the hazard. 

 

 WARNING 
Type and source of the hazard! 
This warning message indicates a hazard of medium risk that can cause death or 
serious injury if not avoided. 
 Measures to avoid the hazard. 

 

 CAUTION 
Type and source of the hazard! 
This warning message indicates a hazard of low risk that can cause minor or 
moderate injury if not avoided. 
 Measures to avoid the hazard. 

 

NOTICE 

Type and source of the hazard! 
This warning message indicates a hazard that can lead to possible property 
damage. 
 Measures to avoid the hazard. 
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Text styles 
Various text attributes, notations, and text structures facilitate reading the document. 
The text attributes (highlightings) inside this document are defined as follows: 

Attribute Function 

italic highlights elements of the user interface and of control elements of 
the system 

bold highlights important information and keyboard input 

Courier New highlights file paths 

[  ] highlights elements of buttons on software user interfaces 

highlights keys of the keyboard 
 

Tasks or procedures that are described in steps are compiled to sequences in this 
document. A sequence consists of at least three components: objective, step, and 
result. 

Component Description 

 Indication of an objective. The sequence starts here. 

1. 
2. 
3. 

Indication of a sorted list of steps. The specified order must be 
observed. 

 Indication of an intermediate result that is followed by further steps or 
the result. 

 Indication of the result. The sequence is finished. 

 Indication of a single step. 
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Additional information 
The following symbols are used to indicate additional information: 

 

This note indicates especially useful information. 

  

 
Advanced information 

This advanced information indicates special knowledge. 

  

Registered Trademarks 
Product and brand names are trademarks of LPKF Laser & Electronics AG, registered 
among others at the US Patent and Trademark Office: LPKF® and the company logo, 
# 2,385,062 and # 2,374,780; SolarQuipment®, # 3,494,986; ProConduct®, # 
3,219,251; Allegro®, # 3,514,950. 

Microsoft® and Windows® are brand names or registered trademarks of Microsoft 
Corporation in the USA and/or other countries. All other trademarks belong to the 
respective owner. 

Issued patents, if applicable, are listed in the appendix. 

Customer service 
For technical information contact our LPKF Service: 

Address LPKF Laser & Electronics AG 
Service & Support Rapid Prototyping 
Osteriede 7 
30827 Garbsen 
Germany 

Phone + 49 5131 7095-1333 

Fax + 49 5131 7095-90 

Email support.rp@lpkf.com 

Internet http://www.lpkf.com/en 

 

In our continuous effort to improve our documentation we are asking you to give us 
your feedback if you notice any discrepancy when working with the system/product, or 
if you have any comments or suggestions for improvement.  

At the moment of packaging, the system/product has been equipped with the latest 
software version and with the software and hardware documentation currently valid. 
By now, new versions of the documentation as well as new software versions might be 
available. 

For all the latest news and updates visit the support area of our homepage: 
www.lpkf.com/en/support-services. 
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http://www.lpkf.com/en
http://www.lpkf.com/en/support-services


 
 

 

ProtoLaser U4/S4/R4 
 

Contents 

V. 4.0 | LPKF Laser & Electronics d.o.o.  7/274 

Contents 
Introduction ..................................................................................................................8 

1 Basics ................................................................................................................. 10 

1.1 Project placement ....................................................................................... 10 
1.2 Recognizing fiducials .................................................................................. 15 
1.3 Measuring the material thickness ............................................................... 20 

1.3.1 Material thickness measurement settings ..................................... 20 
1.3.2 Measurement strategies................................................................ 22 
1.3.3 Measuring the material thickness automatically ........................... 23 
1.3.4 Measuring the material thickness manually (at a single point) ..... 25 
1.3.5 Referencing the material thickness measurement sensor ............ 27 

1.4 Working with mixed PCB layouts in CircuitPro PL ...................................... 29 
1.5 Testing and tuning the tool settings ............................................................ 39 
1.6 Processing multi layers ............................................................................... 48 
1.7 Processing methods of the ProtoLaser ....................................................... 51 

1.7.1 Delamination method .................................................................... 52 
1.7.2 Hatching method ........................................................................... 54 

1.8 Design guidelines for the production of multi-layer PCBs .......................... 56 

1.8.1 Structures of multi-layer PCBs ...................................................... 56 
1.8.2 Required files/layers ...................................................................... 57 
1.8.3 Through holes and via sizes before plating .................................. 58 
1.8.4 Annular rings ................................................................................. 58 
1.8.5 Inner layers fill ............................................................................... 59 
1.8.6 Staggered vias .............................................................................. 60 
1.8.7 Stacked vias .................................................................................. 61 

2 Producing double-sided PCBs ......................................................................... 63 

2.1 How to produce a double-sided PCB without through-hole plating ............ 63 
2.2 How to produce a double-sided PCB with galvanic through-hole 

plating ......................................................................................................... 83 
2.3 How to produce a double-sided PCB with non-galvanic through-hole 

plating ....................................................................................................... 104 
2.4 Producing a double-sided flexible PCB with galvanic through-hole 

plating ....................................................................................................... 110 

3 Producing multi-layer PCBs ........................................................................... 124 

3.1 How to produce a multi-layer PCB with galvanic through-hole plating 
by using a laser system only .................................................................... 124 

3.2 How to produce a multi-layer PCB with galvanic through-hole plating ..... 140 
3.3 How to produce a multi-layer PCB with non-galvanic through-hole 

plating ....................................................................................................... 153 
3.4 How to produce a multi-layer PCB with blind vias and buried vias .......... 165 

4 Other how-to examples ................................................................................... 188 

4.1 Producing a polyimide stencil ................................................................... 188 
4.2 Producing a flex-rigid PCB ........................................................................ 193 
4.3 Structuring the solder mask with the laser system ................................... 224 
4.4 Producing an RF PCB ............................................................................... 230 

5 Processing files ............................................................................................... 238 

5.1 Processing DXF files in CircuitPro PL ...................................................... 238 
5.2 Processing Gerber and Ecxellon files in CircuitPro PL ............................. 245 

6 Appendix .......................................................................................................... 266 

6.1 List of figures ............................................................................................. 266 
6.2 List of tables .............................................................................................. 272 



 
 

 

ProtoLaser U4/S4/R4 
 

Introduction 

LPKF Laser & Electronics AG | V. 4.0 8/274 

 

Introduction 
This document describes the most common applications for the production of double-
sided and multi-layer PCBs with the LPKF ProtoLaser U4/S4/R4. The document also 
provides numerous useful tips that facilitate your work with the system and the 
applicable system software. 

The first how-to examples are explained in detail to facilitate your start. Further on in 
this document, recurrent actions are described only briefly. The document contains 
corresponding references to precedent chapters so that you have access to more 
detailed information at any time. 

Only certain features may be available after the software installation depending on 
whether you use the license level Basic or the license level Advanced.  
All how-to guides require the license level Advanced; the user level Advanced user 
has to be selected in the options. 
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1 Basics 
This chapter describes some basic steps in CircuitPro PL. You learn how to set 
processing data correctly in the software after having placed the processing material 
in the system. Furthermore, the fiducial recognition is described in detail. You perform 
these steps in almost each how-to example. Each step contains corresponding 
references to these chapters. 

This chapter also describes working with mixed PCB layouts, measuring the material 
thickness and testing the tool settings. Moreover, this chapter describes the multi-layer 
process, as well as specific design guidelines for the production of multi-layer PCBs 
with blind vias and buried vias. Observe these information, since they provide a base 
for a successful production of multi-layer PCBs. 

1.1 Project placement 
This chapter describes how to place your project easily in CircuitPro PL. The project 
can be placed in two different ways: 

− Matching the fiducial positions. 
− Determining the processing area. 

Both procedures are described in the following. Use one of them. 

Ensure that the following prerequisites are fulfilled before performing the described 
tasks: 

Prerequisites  
• The user guidance step Processing is active. 
• The dialog Placement is displayed. 

 

 

 

The following table provides tips for positioning and fiducial recognition: 

Tip Description Figure 

Pilot laser  The pilot laser is used for 
positioning. The position of the pilot 
laser can only be changed by 
moving the processing table. Move 
the processing table so the position 
of the pilot laser and the fiducial on 
the material match. Click on  to 
switch the pilot laser on/off. 

 

Zooming in Zoom in the processing area by 
using the mouse wheel for more 
precise positioning. 
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Tip Description Figure 

Illumination 
settings 

Depending on the material surface 
you may need to adjust the image 
until a proper contrast and lighting 
is achieved. Thus a bright surface 
and a dark fiducial have to be set. 
Move the sliders in the tab Image 

settings. 
 
(Image settings are not available for 
the user level Operator.) 

 
Movement 
control 

Control the movement as follows: 
− Use the arrow buttons in the 

tab Navigation for movement 
control. If necessary, adjust the 
Step size for more precise 
control. 

− Double-click on the camera 
image. 

 
Autofocus If the camera image is not sharp, 

click on  in the tab Navigation to 
start the autofocus procedure. The 
message Executing autofocus is 
displayed. 
 

 

Removing 
drilling 
debris 

If a fiducial recognition problem 
occurs, check the fiducial holes for 
drilling debris. 

 

Polishing 
fiducial 
area 

If the surface surrounding the 
fiducial is of very poor quality, use a 
fine sanding paper to polish the 
fiducial area. 

 

Table 1: Tips for positioning and fiducial recognition 
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 Matching the fiducial position 

By performing this procedure before processing starts you save time, since the Spiral 

search will be avoided. 

 

Icon explanation in the user guidance step Processing: 
− Red crosshairs ( ): is the current position of the processing head 
− Purple circle ( ): displays a fiducial 

 

1. Move the dialog Placement to get a better overview. 
2. Click on the tab Processing data. 
3. Double-click on the processing area. 
 The processing table starts moving and the red crosshairs are displayed at the 

point of your double click. The pilot laser is switched on automatically. 

 

The position of the pilot laser beam on the material represents the position of the 
processing head. 
 

4. Use the arrow buttons for movement control. 
5. If necessary, adjust the Step size for more precise control. 

 

Use the tips for positioning that are described in Table 1. 

 

6. Move the processing table so the beam of the pilot laser matches a fiducial. 
7. Switch to the view Camera. 
 The pilot laser is switched off. One of the fiducials is displayed: 

 

Fig. 1: Fiducial in the view Camera 

The processing head in the system is now positioned directly above one of the 
fiducials on the material. 

 

The real image in the view Camera needs to be reflected in the user guidance step 
Processing as well. 
 

8. Switch to the user guidance step Processing. 



 
 

 

ProtoLaser U4/S4/R4 
 

Basics 

V. 4.0 | LPKF Laser & Electronics d.o.o.  13/274 

 The position of the layout is displayed as follows: 

 

Fig. 2: Inaccurate position of the layout (example image) 

The position of the red crosshairs represents not only the position of the 
processing head but also the actual position of the fiducial on the material. 
The entire layout needs to be moved so that the fiducial ( ) and the red 
crosshairs ( ) overlap. 

9. Move the mouse cursor over the layout. 
 The mouse cursor turns into the hand symbol ( ). 
10. Move the layout with Drag & Drop to match the location of the fiducial and the red 

crosshairs: 

 

Fig. 3: Matching processing head and fiducial position 

 The red crosshairs are now aligned to the fiducial. 
11. Click on [OK] in the dialog Placement. 
 The fiducial recognition is initiated (see chapter 1.2). 

 The fiducial position has been matched. 
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 Determining the processing area 

This procedure is an alternative to the step Matching the fiducial position described 
above. The aim of this procedure is to precisely match the base material position and 
base material size to the processing area used by the software CircuitPro PL. 

 

This method is most suitable for working with large designs. This is the case when 
producing multi-layer PCBs. 
 

1. Move the dialog Placement to get a better overview. 
2. Double-click on the processing area. 
 The processing table starts moving and the red crosshairs are displayed at the 

point of your double click. The pilot laser is switched on automatically. 
3. Use the arrow buttons for movement control. 
4. If necessary, adjust the Step size for more precise control. 

 

Use the tips for positioning that are described in Table 1. 

 

5. Switch to the view Camera. 
 The pilot laser is switched off. 
6. Move the processing table until the left front corner of the material is displayed. 

 

Fig. 4: Matching position of crosshair to base material edge 

7. Confirm the position by clicking on  in the dialog Placement. 
8. Switch to the user guidance step Processing. 
9. Repeat the steps 2 to 6 for the right rear corner. 
10. Confirm the position by clicking on  in the dialog Placement. 
11. Click on the tab Processing data in the dialog Placement. 
12. Click on [Center on material]. 



 
 

 

ProtoLaser U4/S4/R4 
 

Basics 

V. 4.0 | LPKF Laser & Electronics d.o.o.  15/274 

 The processing data are now precisely aligned and in the center of the base 
material. 

13. Click on [OK]. 
 The crosshairs position to the base material edge has been matched and the 

fiducial recognition is initiated (see chapter 1.2). 

 The processing area has been determined. 

1.2 Recognizing fiducials 
This chapter describes how to recognize fiducials in CircuitPro PL, especially such 
with low quality. This procedure follows the project placement procedures described in 
the previous chapter. 

 Recognizing fiducials 

The camera moves to the position of the first fiducial and determines its exact 
position. The recognized fiducial and the following dialog are displayed: 

 

Fig. 5: Recognized fiducial 

1. Click on Use the current position. 
 The position of the fiducial has been confirmed. The camera proceeds to read the 

other fiducials. 
If the fiducial is not displayed in the view Camera, a spiral search is performed to 
locate the fiducial and the following message is displayed:  

 

Fig. 6: Message Spiral search active 

 

To determine the size of the spiral search area, click on Processing > Alignment 

settings… and set the value of the Spiral search area. 
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 If the fiducial is not recognized inside the spiral search area, the view Camera is 
displayed as follows: 

 

Fig. 7: Manual fiducial search 

2. Move the processing table until the fiducial is visible by performing one of the 
following steps: 
− Use the arrow buttons in the pane Navigation. 
− Use double- clicks in the camera image. 

3. If necessary, adjust the Step size for more precise movement control. 

 

Use the tips for positioning that are described in Table 1. 

 

 The fiducial approximately matches the yellow circle and is displayed as follows: 

 

Fig. 8: Visible fiducial 

4. Click on Execute a new fiducial search. 
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 The camera moves to the position of the fiducial and determines its exact position. 
The recognized fiducial is displayed: 

 
Fig. 9: Recognized fiducial 

5. Click on Use the current position. 
 The position of the fiducial has been confirmed. The camera proceeds to read the 

other fiducials. The fiducial recognition is finished after all fiducials have been read 
successfully. 

 The fiducials have been recognized. 
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Disabling manual confirmation of fiducials 

1. Click on Processing > Alignment settings... 
2. Deactivate the check box Manual confirmation of fiducials. 
3. Click on [OK]. 
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In some cases, the fiducial quality is too poor for the camera to find the fiducial. 

 Recognizing a fiducial of poor quality 

This is an example of an unidentified fiducial due to poor quality: 

 

Fig. 10: Fiducial of poor quality 

1. Manually move to the exact fiducial position (yellow circle exactly matches the 
fiducial position). 

 

Fig. 11: Matched position of poor quality fiducial 

2. Click on Use the current position. 
 The system saves the fiducial position. 

 A fiducial of poor quality has been recognized. 
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1.3 Measuring the material thickness 
This chapter describes the material thickness measurement in CircuitPro PL. 

1.3.1 Material thickness measurement settings 
The dialog Material thickness measurement settings contains functions for measuring 
the material thickness and for referencing the material thickness measurement sensor. 

To open the dialog, click on Processing > Material thickness measurement setting. 

 
Fig. 12: Dialog Material thickness measurement settings (default settings) 
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Button/Element Description 

Perform thickness measurement during 
process 

Activates the material thickness measurement during 
processing. 

Material thickness tolerance Specifies the permissible measurement deviation 
from the specified material thickness. 
If the measured material thickness exceeds the 
specified tolerance, a dialog for further actions is 
displayed (see chapter 1.3.3). 

Min hole distance Specifies the minimum distance from the hole to the 
point of measurement. This ensures that the material 
thickness measurement is not executed in a hole or a 
pocket on the material. The toolpaths for the holes 
must be calculated in the layout. 

Measurement strategy Sets the measurement strategy (see chapter 1.3.2). 

Referencing Displays the coordinates of the reference points. 

Material thickness Specifies the material thickness that is used for the 
referencing process (see chapter 1.3.5). 

Reference Displays the average referencing values (Old value 
and New value). The Difference is displayed for 
orientation. 

Perform referencing Starts the referencing of the material thickness 
measurement sensor. Referencing should always be 
carried out after cleaning or replacing the sinter plate 
and after transport to ensure the highest possible 
precision of the system. 

Table 2: Functions in the dialog Material thickness measurement settings 
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1.3.2 Measurement strategies 
If the check box Perform thickness measurement during process is activated, the 
system will perform the material thickness measurement automatically during 
processing. The system uses three different measurement strategies that can be 
selected from the drop-down list: 

 
Fig. 13: Drop-down list Measurement strategy 

 

Measurement strategy Description 

Measure three points The measurement is performed at three points on the 
layout: 
• At the right rear corner 
• At the left rear corner 
• At the front in the middle 
The average value is considered. 

Measure five points The measurement is performed at five points on the 
layout: 
• At the right rear corner 
• At the left rear corner 
• At the right front corner 
• At the left front corner 
• At the center 
The average value is considered. 

Measure one point per scan field The measurement is performed at one point in the 
center of each scan field. The measured value is 
considered for each scan field separately. 

 

 

In case of a small layout with only one scan field, the system will always use the 
strategy Measure one point per scan field. 
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1.3.3 Measuring the material thickness automatically 
This chapter describes how to perform material thickness measurement automatically 
during processing. 

Ensure that the following prerequisites are fulfilled before performing the described 
tasks: 

Prerequisites 
• The material thickness measurement during processing is activated (see page 20). 
• Processing is started and the dialog Placement is displayed. 

 

 

 Measuring the material thickness automatically 

1. Place the processing data. 
2. Click on [OK]. 

 
Fig. 14: Dialog Placement 

 The laser system starts the material thickness measurement, following the 
measurement strategy you selected. The following message is displayed: 

 
Fig. 15: Message Thickness measurement running 

When the material thickness measurement is finished, processing continues. 
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If the deviation from the Material thickness (displayed in the dialog Placement) is 
higher than the Material thickness tolerance (see page 20), the following dialog is 
displayed: 

 
Fig. 16: Dialog Measurement result confirmation 
 

3. If necessary, move the processing table to a more suitable position using 
double-clicks in the processing area or the arrow buttons in the pane Navigation. 

4. Click on Retry at current position. 
 The laser system starts the material thickness measurement, and the message 

Thickness measurement running is displayed. 
When the material thickness measurement is finished, processing continues. 

 The material thickness has been measured automatically. 
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1.3.4 Measuring the material thickness manually (at a single point) 
This chapter describes how to perform material thickness measurement manually at a 
single point on the base material before processing starts. 

Ensure that the following prerequisites are fulfilled before performing the described 
tasks: 

Prerequisites 
• The user guidance step Processing is active. 
• The processing head is located above the base material. 

 

 

 Measuring the material thickness manually 

1. Right-click on the processing area. 
 The following context menu is displayed: 

 
Fig. 17: Context menu 

2. Select the menu item Placement… 
 The following dialog is displayed: 

 
Fig. 18: Dialog Placement 
 

 

The input field Material thickness displays the material thickness defined in the 
selected material. 
 

3. Click on [Measure material thickness]. 
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 The laser system starts the material thickness measurement at the position of the 
processing head. The following message is displayed: 

 
Fig. 19: Message Thickness measurement running 

The measured value is displayed in the dialog Placement: 

 
Fig. 20: Measured value 

4. Click on [OK]. 

 The material thickness has been measured manually. 

  



 
 

 

ProtoLaser U4/S4/R4 
 

Basics 

V. 4.0 | LPKF Laser & Electronics d.o.o.  27/274 

1.3.5 Referencing the material thickness measurement sensor 
This chapter describes how to perform referencing the material thickness 
measurement sensor. The referencing should be performed in the following situations: 

− After replacing or cleaning the sinter plate. 
− After transporting the system. 
− In case of unexpected results during the material thickness measurement. 

Ensure that the following prerequisites are fulfilled before performing the described 
tasks: 

Prerequisites Auxiliaries 
• The user guidance step Processing is 

active. 
• Base material of a uniform thickness, 

229 mm × 305 mm (~9 in × ~12 in) 
(e.g., metal sheet for stencil production) 

 

 

 Referencing the material thickness measurement sensor 

1. Mount the base material onto the processing table. 

 

It is extremely important that you use a base material of uniform thickness. The 
flatness of the base material has a direct influence on the measurement result. 
 

2. Click on Processing > Material thickness measurement setting. 
 The dialog Material thickness measurement settings is displayed. 
3. Enter the exact material thickness into the input field Material thickness  

(in this example 0.15 mm). 

  
Fig. 21: Entering Material thickness 

4. Click on [Perform referencing]. 
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 The system measures the material thickness at five reference points. The 
measured values are displayed in the column Z. The average value is displayed in 
the column New value. 

 
Fig. 22: Measured values and average value of the reference points 
 

 

If the deviation between the minimum measured value and the maximum measured 
value exceeds 0.15 mm, repeat the referencing and/or use a base material that has a 
more uniform thickness. 
 

5. Click on [OK]. 
 The system saves the measured values of the reference points. 

 

The value in the field New value is used for calculating the offset between the tip of 
the material thickness measurement sensor and the laser focus. 
 

 The material thickness measurement sensor has been referenced. 
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1.4 Working with mixed PCB layouts in CircuitPro PL 

 

Working with mixed PCB layouts is only available in the license level Advanced of 
CircuitPro PL. If you have any questions contact the LPKF sales department. 
 

This chapter describes how to import and process mixed PCB layouts at the same 
time in CircuitPro PL. 

 

The following steps are performed in this tutorial: 

• Preparing the individual PCB layouts 
• Importing the individual PCB layouts 

 Preparing the individual PCB layouts 

1. In the user guidance step New, select the template that suits the type of project 
you have. 
In this example the template Double-sided, ProtoLaser S4, galvanic through-hole 

plating is used. 
2. Click on [Load template] or double-click on the template. 
 The user guidance step Material is displayed. 
3. Select a suitable material.  

In this example the material FR4, Double-sided, 1.5 mm, 5/5 µm is used. 

 
Fig. 23: Select material 

4. Click on [Select material] or double-click on the material. 
 The user guidance step Import is displayed. 
5. Click on . 
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6. Select the files you want to import. 
7. Click on [Open]. 
 The data are automatically assigned to the correct layers and the user guidance 

step Import is displayed. 
8. Click on [Import]. 
 The imported data are displayed in the user guidance step Layout. 

 

You can add the fiducials to each individual PCB layout or add them after you have 
imported the individual PCB layouts into a single project. When you add the fiducials 
to each individual layout a more precise positioning is achieved. 
In this example the fiducials are added to each individual PCB layout. 
 

9. Click on Insert > Automatic fiducial creation or click on . 
 The dialog Automatic fiducial creation is displayed. 
10. Adapt the settings for the fiducials. 
11. Click on [OK]. 
 The fiducials are automatically added to the layout. 

 

You can compute the toolpaths of each individual PCB layout or compute them after 
you have imported the individual PCB layouts into a single project. 
In this example the toolpaths of each individual PCB layout are computed. 
 

12. Click on [Compute toolpaths] or on . 
 The dialog Computing toolpaths is displayed. 
13. Click on [Continue]. 
 The toolpaths are being calculated. The message Computation results is 

displayed. 
14. Check the computation results for any possible warnings or errors and make 

corrections, if needed. 
15. Click on [Close]. 
16. Click on File > Save As… or on . 
17. Select a suitable folder, name the file and click on [Save]. 
 The file is saved in the .cp2d file format. 
18. Repeat all the steps in this procedure to prepare all the other individual PCB 

layouts. 

 

Make sure you use the same template and same material for each imported PCB 
layout! 
 

 The individual PCB layouts have been prepared. 
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 Importing the individual PCB layouts 

 

Note that this project is an example. The layout of your project will be different. 

 

1. In the user guidance step New, select the template that you have used for the 
preparation of your individual PCB layouts. 
In this example the template Double-sided, ProtoLaser S4, galvanic through-hole 

plating is used. 
2. Click on [Load template] or double-click on the template. 
 The user guidance step Material is displayed. 
3. Select the material that you have used for the preparation of your individual PCB 

layouts. 
In this example the material FR4, Double-sided, 1.5 mm, 5/5 µm is used. 

4. Click on [Select material] or double-click on the material. 
 The user guidance step Import is displayed. 
5. Click on . 
6. Navigate to the folder that contains the .cp2d files you saved in the previous 

procedure. 
7. Press and hold the  key and select the files you want to import. 
8. Click on [Open]. 
 The user guidance step Import is displayed. 

 
Fig. 24: User guidance step Import 
 

9. Click on [Import]. 
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 The imported PCB layouts are displayed in the user guidance step Layout: 

 
Fig. 25: Imported PCB layouts 
 

 

In this example, one of the PCB layouts is multiplied (by using instances). 

 

10. Select one PCB layout by clicking on the dashed line surrounding it. 
 The layout is selected and changes its color. 

 
Fig. 26: One PCB layout selected 
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11. Right-click on the black background and select Edit instance type… from the 
context menu. 

 
Fig. 27: Menu Edit instance type 

 The following dialog is displayed: 

 
Fig. 28: Dialog Edit instance type 

12. Enter the desired number of instances in the input fields Count.  
In this example, enter 3 counts for the y axis. 

13. Increase the entered value under Distance in the input field y by 10 mm. 
 The dialog Edit instance type changes as follows: 

 
Fig. 29: Dialog Edit instance type | Values 

14. Click on [OK]. 
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 The selected layout is multiplied: 

 
Fig. 30: Layout multiplied 
 

15. Compute toolpaths, if you have not computed them in the individual PCB layouts 
yet.  
In this example, the toolpaths have already been computed in the individual PCB 
layouts. 

16. Switch to the user guidance step Processing. 
 The PCB layouts are displayed in the center of the base material: 

 
Fig. 31: User guidance step Processing 
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17. Click on  to arrange the PCB layouts automatically. 

 
Fig. 32: Automatic arrangement of PCB layouts 

18. Right-click on the background. 
19. Select the menu item Placement… from the menu. 

 
Fig. 33: Menu item Placement 

 The dialog Placement is displayed. 
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20. Click on the tab Processing data. 
21. Enter 15 mm in the input field Job distance. 

22. Click on [Arrange all]. 
23. Click on [OK]. 
 The distance between individual PCB layouts is increased. 

 
Fig. 35: Distance between PCB layouts increased 
 

 
Fig. 34: Dialog Placement | Processing data 
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Alternatively, arrange the PCB layouts manually. Open the dialog Placement, click on 
the tab Processing data, and perform one of the following steps: 

− Drag & drop each individual PCB layout to the desired location. 
− Select the individual PCB layout in the drop-down list Project and enter the 

values in the input fields x and y for Center of processing data. 

 

 
 

 

24. Save your project. 

 The individual PCB layouts have been imported. 

The individual PCB layouts have successfully been prepared and imported. You can 
now start processing the mixed PCB layouts. 
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Creating fiducials after importing the individual PCB layouts 

If you have not created fiducials in the individual PCB layouts, you can create them 
after importing the .cp2d files into a single project. 
 
1. Multiply the individual layouts in the user guidance step Layout, if desired. 
2. Calculate the toolpaths, if necessary. 
3. Switch to the user guidance step Processing. 
4. Arrange the layouts on the base material. 
5. Click on . 
 The dialog Automatic fiducial creation is displayed. 
6. Adapt the settings for the fiducials, if necessary. 
7. Click on [OK]. 
 The fiducials are created automatically with calculated scan fields and toolpaths. 
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1.5 Testing and tuning the tool settings 
This chapter describes testing and tuning the tool settings in the software 
CircuitPro PL. The procedure follows the project placement, the fiducial recognition 
and the material thickness measurement described in the previous chapters. 

The aim of this procedure is to check the processing quality on a small test sample on 
your material before you start to process your project. You can modify the tool settings 
to improve the processing quality. 

 

The procedure is especially useful for checking the processing quality of the 
galvanically through-hole plated material. 
 

Ensure that the following prerequisites are fulfilled before performing the described 
tasks: 

Prerequisites Spare parts and auxiliaries 
• The user guidance step Processing is active. 
• The dialog Test tool settings is displayed. 

• Portable hand-held microscope 

 

 

 

The dialog Test tool settings is automatically displayed during processing before 
structuring starts. 
 
You can also display the dialog by performing the following steps: 
 

1. Switch to the user guidance step Processing. 
2. Expand the group Processing in the pane Workflow setup. 
3. Expand a desired phase. 
4. Right-click on the desired work package Structure or work package Drill. 
5. Select Check tool settings in the context menu. 
 

 

The following steps are described: 

• Placing and processing the test sample 
• Checking the processed test sample 
• Tuning the tool settings 
• Saving the tool settings globally 
• Resuming the processing procedure 
• Disabling the test procedure of the tool settings (optional) 
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 Placing and processing the test sample 

1. Move the dialog Test tool settings to get a better overview. 
2. Click on Place and process “Small test sample 7x7 mm”. 

 
Fig. 36: Place and process “Small test sample 7x7 mm” 

 The input fields for specifying the position of the test sample are displayed: 

 
Fig. 37: Specifying the position 
 

 

The best position of the test sample is just outside of the outer contour. 

 

3. Perform one of the following steps: 
− Click on a desired point in the processing area to specify the position of the 

test sample. 
− Enter the values in the input fields for x and y. 



 
 

 

ProtoLaser U4/S4/R4 
 

Basics 

V. 4.0 | LPKF Laser & Electronics d.o.o.  41/274 

 The test sample is displayed in the processing area.  
The following dialog is displayed: 

 
Fig. 38: Dialog Test tool settings 

4. Click on [Process]. 
 Processing the test sample is started. 

When processing the test sample is finished, the following dialog is displayed: 

 
Fig. 39: Dialog Check test tool finished 

5. Click on [Close]. 
 The dialog Test tool settings is displayed. 

 The test sample has been placed and processed. 

 Checking the processed test sample 

1. Check the processed test sample using a portable hand-held microscope. 
2. Identify possible faults in the processing quality. 
3. If the processing quality of the test sample is acceptable, proceed with the step 

Resuming the processing procedure (see page 45). 
4. If the processing quality of the test sample is not acceptable, proceed with the step 

Tuning the tool settings (see page 42). 

 The processed test sample has been checked. 

 

For detailed information on optimizing the processing quality, refer to the TechNote 
ProtoLaser: Optimizing the processing quality. 
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 Tuning the tool settings 

1. Click on Tune tool settings. 

 
Fig. 40: Tune tool settings 

 The view Tool Settings is displayed: 

 
Fig. 41: View Tool Settings 
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2. In the pane Workflow setup select a specific tool, whose settings you wish to 
modify (in this example the tool Heat is selected). 

 
Fig. 42: Tool selected 
 

 

Alternatively, you can select a tool from the drop-down list: 

 
 

 

3. Modify the tool settings in the tab General and/or tab Advanced. 

 
Fig. 43: Modifying the tool settings 
 

 

For detailed information on modifying the tool settings (i.e., parameters), refer to the 
TechNote ProtoLaser: Optimizing the processing quality. 
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4. Click on [Apply]. 
 A copy of the tool with the modified settings is created. The green  

check mark ( ) next to the tool name indicates that this tool will be used for 
processing in this project. 

  
Fig. 44: Copy of the tool with the modified settings 

5. Perform steps 2 to 4, if you wish to modify the settings of another tool. 

 The tool settings have been tuned. 

 Saving the tool settings globally 

The new tools with the modified settings will be used for processing only in your 
current project. Save the new tools to the global catalog, if you wish to use them 
for your other projects in CircuitPro PL. 

1. Click on  next to the tool name with the modified settings. 

  
Fig. 45: Saving the tool 
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 The tool is saved to the global catalog and is displayed in the pane Workflow 

setup as follows: 

 
Fig. 46: Tool saved 

2. Click on the user guidance step Processing to leave the view Tool Settings. 

 The tool settings have been saved globally. 

 

In order to check if the processing quality is optimal now, perform the sequences 
Placing and processing the test sample (see page 40) and Checking the processed 

test sample (see page 41) again. 
 

 Resuming the processing procedure 

 In the dialog Test tool settings click on [Resume]. 

 
Fig. 47: Resuming the processing procedure 

 The processing procedure has been resumed. 
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 Disabling the test procedure of the tool settings (optional) 

If desired, you can disable the test procedure of the tool settings for your project. 
1. Switch to the user guidance step Workflow. 
2. Select a phase that includes a work package Structure (or more of them) from the 

drop-down list. 

 
Fig. 48: Phase Bottom Side selected 

3. Select the work package Structure. 

 
Fig. 49: Work package Structure Bottom selected  
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4. Deactivate the check box Test tool settings. 

 
Fig. 50: Test tool settings disabled 

5. Repeat the steps 2 to 4 for other phases that include a work package Structure. 
6. Click on [Apply]. 

 The test procedure of the tool settings has been disabled. 
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1.6 Processing multi layers 
This chapter describes the multi-layer process using the MultiPress S. The processing 
steps are explained briefly and some useful production tips are given. 

 

For detailed information on the multi-layer process refer to the user manual of 
MultiPress S. 
 

The following steps are described: 

• Starting the preheating stage 
• Preparing the materials 
• Assembling the multi-layer stack 
• Pressing and curing the multi-layer stack 

 Starting the preheating stage 

1. Switch on the MultiPress S. 
2. Make sure that the profile LPKF Set is shown in the display. 

 

If the LPKF Set profile is not shown in the display, refer to the user manual of 
MultiPress S. 
 

3. In the main menu, select the entry Start and press the button ENT. 
4. Select the entry Preheating and press the button ENT. 
 The system will heat up to the preset temperature. The display shows the current 

data of the preheating stage. 

 

Assemble the multi-layer stack during the preheating stage (described in the following 
two procedures). 
 

 The preheating stage has been started. 

 Preparing the materials 

 

Keep the materials at ambient temperature for 24 hours before use.  
To avoid skin fat deposit and dust on the materials, work with lint-free gloves. 
 

1. Clean the press molds and press sheets with isopropyl alcohol or acetone. Scrape 
off any resin residues from previous cycles. 

2. Clean the core materials and laminate materials with isopropyl alcohol or acetone. 
3. Heat-treat the core materials and laminate materials before assembly at 100 °C 

(~212 °F) for 30 minutes (to reduce moisture content). 

 

Do not heat-treat prepreg materials! 

 

4. Cool the materials for 10 minutes at ambient temperature. 

 The materials have been prepared. 

 

After cooling, immediately proceed with assembling the multi-layer stack! 
For detailed information on assembling the multi-layer stack refer to the user manual 
of MultiPress S. 
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 Assembling the multi-layer stack 
 

 

Dowel pins in the press mold align the individual layers. Rings between the bonded 
layers protect the register holes and the fiducials from being covered with prepreg 
resin. 
 

1. Assemble the press mold and the materials (starting with the lower press mold) 
according to the following figure: 

 

Fig. 51: Assembly of the press mold and the materials 

1 Dowel pins 
2 Aluminum press mold (lower part) 
3 Press cushion 
4 Steel press sheet 
5 Bottom laminate (copper side facing 

downwards) 
6 Sealing rings (1 or 2 rings) 
7 Prepreg (1 or 2 sheets) 

 8 Sealing rings (1 or 2 rings) 
9 Core material  
10 Prepreg (1 or 2 sheets) 
11 Top laminate (copper side facing upwards) 
12 Steel press sheet 
13 Press cushion 
14 Aluminum press mold (upper part) 

 

 

When using one sheet of prepreg, one ring should be used on each dowel pin. When 
using two sheets of prepreg, two rings should be used on each dowel pin. 
 

2. Place the press mold containing the materials to be pressed between two blue 
press cardboard sheets. 

 

Use original LPKF press cardboard sheets, since press cardboards that are not 
heat-resistant can ignite during operation and set the system on fire. 
 

 The multi-layer stack has been assembled. 
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 Pressing and curing the multi-layer stack 

 

For detailed information on pressing the multi-layer stack refer to the user manual of 
MultiPress S. 

After preheating, the MultiPress S will prompt you by an acoustic signal and a display 
message to insert the multi-layer stack. 

1. Press the button ENT and wait for the press jaws to open. 
2. Open the sliding door and insert the assembled press mold together with the press 

cardboards into the system. 
3. Close the sliding door. 
4. Press the button ENT to start the pressing process. 
 The pressing jaws close. The cooling phase starts automatically. 

 

Prepressing and main pressing combined last 70 minutes. The cooling phase runs 
until the temperature drops below 50 °C (~122 °F). 
 

 An acoustic signal indicates that the cooling phase has finished. The multi-layer 
stack has been pressed. 

5. When the message finished appears on the display, open the sliding door and 
remove the press mold and the press cardboards from the system. 

6. Leave the assembled multi-layer stack in the press mold to rest at ambient 
temperature in horizontal position for at least 12 to 18 hours. The resin needs to 
cure completely. 

 

 

Alternatively, you can accelerate the curing cycle. Heat the pressed multi-layer stack 
in a convection oven for 50 minutes at 100 °C (~212 °F) for the epoxy resin to fully 
cure. This way the long curing at ambient temperature can be skipped. After heating, 
cool the multi-layer stack at ambient temperature for 5 minutes before proceeding with 
production. 
 

7. Carefully remove the multi-layer stack from the press mold. 

 The multi-layer stack has been pressed and cured. 
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1.7 Processing methods of the ProtoLaser 
This chapter describes the processing methods of the ProtoLaser systems. There are 
two methods of material removal: 

• Delamination method 
• Hatching method 

The delamination method is only used for processing laminated PCB materials. The 
hatching method is used for processing laminated PCB materials and non-laminated 
PCB materials. 

Laminated PCB materials usually consist of a conductive layer (e.g. copper) that is 
laminated with a bonding layer onto a non-conductive substrate (e.g. FR4): 

 
Fig. 52: Example of a laminated PCB material 
 

Non-laminated PCB materials usually consist of a conductive layer (e.g. gold, copper) 
that is electroplated/electrodeposited onto a non-conductive substrate (e.g. Aluminum 
oxide – Al2O3): 

 
Fig. 53: Example of a non-laminated PCB material 
 

 

The conductive layer to be removed is called the rubout area. Both terms are used in 
this document. 
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1.7.1 Delamination method 
The following figure shows an example layout of a PCB in the user guidance step 
Toolpaths. It is used for explaining the delamination method: 

 
Fig. 54: PCB layout 

1 Annular ring 
2 Hole 

 3 Conductive track 

 

 

The delamination method consists of the following stages: 

1. Creating the isolation channels 
2. Creating strips 
3. Delaminating strips 

Creating the isolation channels 
Processing starts by creating isolation channels (i.e. “contours”) around the objects 
(conductive tracks, pads, etc.). The isolation channels separate the rubout area from 
the PCB layout on the conductive layer. The following figure shows the isolation 
channel around the conductive track in the user guidance step Toolpaths: 

 
Fig. 55: PCB layout | isolation channel 
1 Isolation channel  2 Rubout area 
 

  

1 

2 

1 

2 

3 
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Creating strips 
The process is continued by creating strips on the rubout area. The following figure 
shows the strips with the hatching lines in the user guidance step Toolpaths: 

 
Fig. 56: PCB layout | creating strips 
1 Isolation channel 
2 Strips of the rubout area 

 3 Hatching line 

 

 

Delaminating strips 
The final stage is the delamination of strips. Each strip of the rubout area is being 
heated up until the conductive layer is removed from the substrate. The following 
figure shows heating lines in the user guidance step Toolpaths that are used for 
removing the strips of the conductive layer: 

 
Fig. 57: PCB layout | delaminating strips 
1 Isolation channel 
2 Strip of the rubout area 

 3 Heating line 
4 Short heating line 
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1.7.2 Hatching method 
The following figure shows an example layout of an RF PCB in the user guidance step 
Toolpaths. 

 
Fig. 58: RF PCB layout | RF geometry 
 

The hatching method consists of the following stages: 

1. Creating the isolation channels 
2. Hatching 
 
In comparison to the delamination method, the conductive layer is removed by 
ablation and not by delamination. 

 

Creating the isolation channels 
Processing starts by creating isolation channels (i.e. contours) around the objects (e.g. 
RF geometries). The isolation channels separate the rubout area from the PCB layout 
on the conductive layer. The following figure shows the isolation channel around the 
RF geometry in the user guidance step Toolpaths: 

    
Fig. 59: PCB layout | Isolation channel 
1 Isolation channel  2 Rubout area 
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Hatching 
The process is continued. The rubout area is cut into lines that are very close to each 
other (vertically, horizontally or in both directions). The following figure shows the 
hatching lines (displayed as a grid) in the user guidance step Toolpaths: 

 
Fig. 60: PCB layout | Hatching 
1 Isolation channel  2 Hatching line 
 

 

The laser beam is wider than the hatching lines displayed in figure 10, so that the 
structured hatching lines overlap during processing. This way all the material is 
removed from the rubout area. 

  

1 

2 
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1.8 Design guidelines for the production of multi-layer PCBs 
This chapter describes basic design guidelines that should be observed when 
designing a layout for a multi-layer PCB or a multi-layer PCB with blind vias and 
buried vias. These design guidelines apply to the production of multi-layer PCBs with 
LPKF systems and with materials approved by LPKF. 

1.8.1 Structures of multi-layer PCBs 
This section explains the structures of multi-layer PCBs and multi-layer PCBs with 
blind vias and buried vias. 

The following figures show the following information: 

• The sequence of the materials used; 
• Identification of layers; 
• Illustration of different hole types; 
• The materials used in a specific procedure. 

 

The drill layer names indicate which two layers are connected by a hole.  
For example: The drill layer Blind via (Top-L2) connects the Top layer and Layer 2. 
 

 

 
Fig. 61: A 4-layer PCB structure 

 

 
Fig. 62: A 4-layer PCB structure with blind vias and buried vias 
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Fig. 63: A 6-layer PCB structure 

 

 
Fig. 64: A 6-layer PCB structure with blind vias and buried vias 
 

 

 

To produce an 8-layer PCB structure use one additional core material and two 
additional prepreg materials (compared to the 6-layer PCB structure). 
 

 

1.8.2 Required files/layers 
The following table contains the required files for designing 4-layer PCBs: 

Structuring Drilling Other 

TopLayer DrillPlated (plated through hole) BoardOutline 

Layer 2 DrillUnplated (unplated through hole) SolderMaskTop 

Layer 3 Blind via (Top-L2)* SolderMaskBottom 

BottomLayer Buried via (L2-L3)*  

 Blind via (Bottom-L3)*  

Table 2: Required files/layers 

 

* Applicable for 4-layer PCBs with blind vias and buried vias. 
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1.8.3 Through holes and via sizes before plating 
When designing the layout of a multi-layer PCB, it is important to observe the size 
range of the holes. 

The following table specifies the size range for a certain hole type: 

Hole type Minimum size Maximum size 

Through hole 200 µm / 

Buried via 200 µm 400 µm 

Blind via 100 µm 300 µm 

Table 3: Size range according to hole type 

A multi-layer PCB with hole sizes different from these will not function properly. 

1.8.4 Annular rings 
An annular ring is a copper ring around a plated hole and its width is an important 
design and manufacturing consideration. If a wide annular ring area is provided in the 
design, it ensures that in the manufactured printed circuit board a good electrical 
connectivity between pad and hole is retained. 

The following figure shows an examplary annular ring: 

 
Fig. 65: Annular ring 

The minimum width of the annular ring is the minimum amount of copper between 
the edge of the hole and the edge of the pad after plating of the finished hole. The 
PCB production process using LPKF systems complies with the IPC 2221-B standard. 
According to this standard the minimum annular ring for Class 3 shall not be less 
than 150 µm. 

External annular ring 
An external annular ring is an annular ring on the external layers of a multi-layer PCB. 
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Internal annular ring 
An internal annular ring is an annular ring on the internal layers of a multi-layer PCB. A 
through hole should always have an annular ring on every passing layer, regardless of 
its electrical connectivity. 

The following figure shows a through hole crossing four layers, as well as its internal 
and external annular rings: 

 
Fig. 66: A through hole with external and internal annular rings 
1 External annular ring 
2 Internal annular rings 

 3 External annular ring 
4 Conductive track 

 

 

 

Always use a minimum width of at least 100 µm for internal annular rings. 

 

 

1.8.5 Inner layers fill 
All inner layers should be filled with copper as much as possible. In case of larger 
rubout areas, the epoxy content of the prepreg may not be sufficient to fill all gaps. 
Consequently, air filled voids between layers can expand during the reflow process 
and cause a blister effect on a multi-layer PCB. 

The following figure shows an incorrect inner layer fill: 

 
Fig. 67: Incorrect inner layer fill in the user guidance step Layout 
1 Hole 
2 Annular ring 

 3 Rubout area 
4 Via 
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The following figure shows a correct inner layer fill: 

 
Fig. 68: Correct inner layer fill in the user guidance step Layout 
1 Rubout area 
2 Hole 
3 Annular ring (=copper) 

 4 Copper pour 
5 Via 

 

 

 

If the inner layers are less than 75 % filled with copper (a rough estimation), two 
prepreg sheets must be used. 
 

 

1.8.6 Staggered vias 
Staggered vias are vias on neighboring layers that are located close to each other, but 
do not overlap. Staggered vias only apply to multi-layer PCBs with blind vias and 
buried vias. 

Before plating, a minimum offset of 150 µm between vias on neighboring layers 
must be observed during the design of the PCB layout. 

The following figure shows staggered vias and the minimum distance between them: 

 
Fig. 69: Staggered vias and minimum distance 
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1.8.7 Stacked vias 
Stacked vias are vias on neighboring layers that overlap. Stacked vias only apply to 
multi-layer PCBs with blind vias and buried vias. The PCB production process with 
LPKF systems and software does not support stacking of vias. Use staggered vias 
instead. 

The following figure shows stacked vias: 

 
Fig. 70: Stacked vias 
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2 Producing double-sided PCBs 
This chapter describes the production of four different types of double-sided PCBs: 

1. Producing a double-sided PCB without through-hole plating. 

2. Producing a double-sided PCB with galvanic through-hole plating. 

3. Producing a double-sided PCB with non-galvanic through-hole plating. 

4. Producing a double-sided flexible PCB with galvanic through-hole plating. 

The following LPKF systems are required for the procedures: 

Procedure LPKF system 

1 ProtoLaser U4/S4/R4 

2 ProtoLaser U4/S4/R4, ProtoMat S or E, Contac S4 

3 ProtoLaser U4/S4/R4, ProtoMat S or E, ProConduct 

4 ProtoLaser R4, Contac S4 

Table 4: Required LPKF systems 

 

2.1 How to produce a double-sided PCB without through-hole 
plating 

This chapter describes how to create a double-sided PCB without through-hole plating 
using a laser system only. 

Ensure that the following consumables and auxiliaries are available before performing 
the described tasks: 

Consumables Auxiliaries System 
• Base material FR4, 

229 mm × 305 mm × 
1.5 mm, 18/18 μm 
copper-plated 
(order code: 115967) 

• LPKF Cleaner  
(order code: 115891) 

• Oil-free compressed air 
• Brush 
• Tap water 

• ProtoLaser U4/S4/R4 

 

 

The following steps are performed in this tutorial: 

• Switching on the system 
• Selecting the material 
• Importing the data 
• Multiplying the layout (optional) 
• Creating fiducials 
• Computing toolpaths and scan fields automatically 
• Processing the PCB 
• Cleaning the system 
• Cleaning the PCB 
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 Switching on the system 

1. Press the on/off button at the system front. 
 The system is started up. The PC boots automatically. 

The on/off button is lit. 
2. Double-click on the desktop icon of LPKF CircuitPro PL. 

 
Fig. 71: Desktop icon CircuitPro PL 

 The following message is displayed: 

 
Fig. 72: Message System connection 

 The system software recognizes the system automatically and establishes the 
connection. The following dialog is displayed: 

 
Fig. 73: Dialog Signal light check 

3. If all lamps of the stack light are lit, click on [Yes]. 
 The user guidance step New is displayed: 

 
Fig. 74: User guidance step New 
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4. Select Double-sided from the drop-down list. 

 
Fig. 75: Drop-down list material 

5. Select your laser system from the drop-down list (in this example PL U4). 

 
Fig. 76: Drop-down list system 

 A list of templates for double-sided materials is displayed: 

 
Fig. 77: List of templates 

6. Select the template Double-sided, ProtoLaser U4, no through-hole plating. 
7. Click on [Load template] or double-click on the template. 
 The user guidance step Material is displayed. 

 The system has been switched on. 
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Connecting the system manually 

If automatic connection of the system fails, you can connect the system manually 
with the system software: Click on Processing > Connect to machine…, select your 
system in the drop-down list and click on [Connect]. 

  
 

  

 
The system requires a warm-up time of up to 20 minutes for the laser source to attain 
a constant diode temperature. The warm-up phase starts automatically when 
processing the first job. 
Alternatively, you can start the warm-up phase manually. In the user guidance step 
Processing, click on . You can continue to work in the user guidance step Layout 
during the warm-up phase. 

  
 

 

Tips for selecting a template: 
 

 Select the template according to the number of layers. 
 Select the template according to the metallization type. 
 Select the template according to the type of multi-layer press. 

 

 Selecting the material 

1. In the user guidance step Material select the material FR4 Double-sided, 1.5 mm, 

18/18 µm. 

 
Fig. 78: User guidance step Material 

2. Click on [Select material] or double-click on the material. 
 The user guidance step Import is displayed. 

 The material has been selected. 
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Selecting the material type 

When selecting the Material you are also selecting the tools with laser parameters for 
a specific material. 
 
Example of the material name composition: 
 

 
 

 FR4 Double-sided – material type 
 1.55 mm – material thickness 
 18/18 µm – copper thickness 

  
 

 Importing the data 

1. In the user guidance step Import click on . 
 The following dialog is displayed: 

 
Fig. 79: Dialog Open 

2. Navigate to the folder that contains the data you wish to import. The example data 
used for this tutorial are located in the folder: 
C:\Program Files\LPKF Laser & Electronics AG\ 

LPKF CircuitPro PL\Example Data\UseCase_DoubleSidedPCB. 
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3. Select the desired files for import (in this example Tutor.BOA, Tutor.BOT, 

Tutor.DRL and Tutor.TOP). 
4. Click on [Open]. 
 The data are automatically assigned to the correct layers and the user guidance 

step Import is displayed: 

 
Fig. 80: User guidance step Import 

5. Assign the holes to the layer DrillUnplated. 
 

 
Fig. 81: Assigning holes to layer 

6. Check in the preview of the layout whether the graphics and size (in the 
Size/Format column) are correct. If not, you can adjust the settings in the sub-tab 
File. 

7. Click on [Import]. 
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 The user guidance step Layout is displayed: 

 
Fig. 82: User guidance step Layout 

 The data have been imported. 

  

 
Assigning the layers manually 

If the data have not been assigned to the correct layers automatically, they can be 
assigned manually. In the drop-down list in the column Target, select which layer is 
to be assigned to the imported source data. 
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 Multiplying the layout (optional) 

If desired, you can multiply the layout. In this example multiplies of the layout are not 
necessary. 

 

The functions Step and Repeat and Create instance type are only available in the 
license level Advanced of CircuitPro PL. If you have any questions contact the LPKF 
sales department. 
 

1. In the user guidance step Layout select the entire layout by pressing  + . 
 The layout is selected. 
2. Right-click on the layout. 
 The following context menu is displayed: 

 
Fig. 83: Context menu Step and repeat 

3. Click on Step and repeat... 



 
 

 

ProtoLaser U4/S4/R4 
 

Producing double-sided PCBs 

V. 4.0 | LPKF Laser & Electronics d.o.o.  71/274 

 The following dialog is displayed: 

 
Fig. 84: Dialog Step and repeat 

4. Enter the desired number of repetitions along each axis in the fields Count. 
For this example, four multiples of the layout have been made. Enter 2 counts for 
the x axis and 2 counts for the y axis. 

 

Some space for cutout is required between the copies, so the Gap distance has to be 
specified for the x and y direction. 
 

5. Enter 2 mm in the fields Gap distance. 
 After entering all the values, the dialog is displayed as follows: 

 
Fig. 85: Dialog Step and repeat after entering values 
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6. Click on [OK]. 
 The multiplied layouts are created. 
7. In order to zoom out and get an overview of the multiplied layouts, perform one of 

the following steps: 
− Scroll the mouse wheel. 
− Press the  key. 
− Click on . 

8. Press  or click anywhere on the black background to deselect the highlighted 
layout. 

 The user guidance step Layout changes as follows: 

 
Fig. 86: Multiplied layout 

 The layout has been multiplied. 
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Creating an instance type 

As an alternative to multiplying the layout data, you can use instances. The 
advantages are: 

− Less memory is needed. 
− The calculation of the toolpaths is speeded up. 

You can create an instance type by performing the following steps: 
 

 

1. Select the entire layout by pressing  + . 
2. Click on Insert > Create instance type or on . 
 The following dialog is displayed: 

 
 

3. Enter the desired number of instances in the input fields Count. 
For this example, enter 2 counts for the x axis and 2 counts for the y axis. 

4. Increase the entered values in the input fields Distance by 2 mm. 
5. Click on [OK]. 
 The instance type has been created: 

 
 

  
 

  



 

 

Producing double-sided PCBs 
 

ProtoLaser U4/S4/R4 

74/274  LPKF Laser & Electronics d.o.o. | V. 4.0 

 Creating fiducials 

 

The function Automatic fiducial creation is only available in the license level Advanced 
of CircuitPro PL. If you have any questions contact the LPKF sales department. 
 

1. In the user guidance step Layout, click on Insert > Automatic fiducial creation or 
click on . 

 
Fig. 87: Create fiducials automatically 

 The following dialog is displayed: 

 
Fig. 88: Dialog Automatic fiducial creation 
 

 

For optimum alignment results it is recommended to create four fiducials and to place 
them outside the outer contour. 
You can prevent a faulty alignment of the base material with three fiducials. 
At least two fiducials are required for correct operation of the process; 
arrange them diagonally. 
 

2. Adapt the settings for the fiducials. 
In this example four fiducials with a distance of 4 mm from the BoardOutline are 
created. 

3. Click on [OK]. 
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 The fiducials are automatically added to the layout: 

 
Fig. 89: Fiducials created 

 The fiducials have been created. 

  

 
Creating fiducials manually 

You can add fiducials to the layout manually by performing the following steps: 
 

1. Click on Insert > Fiducial or click on . 
 The input fields for Specify center point are displayed: 

 

2. To insert the fiducial, perform one of the following steps: 
− Click on a desired point in the layout. 
− Enter the values for x and y in the input fields. 

3. Repeat step 2 for all other fiducials. 
4. Press  to close the function. 
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 Computing toolpaths and scan fields automatically 

1. Switch to the user guidance step Scan fields. 
2. Click on [Compute scan fields] or on . 

 
Fig. 90: Compute scan fields 

 The following dialog is displayed: 

 
Fig. 91: Dialog Compute scan fields 

3. Adapt the settings for the scan fields, if necessary. In this example, the default 
settings are used. 

4. Click on [Compute]. 
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 The scan fields are computed automatically. 

 
Fig. 92: Scan fields computed 

5. Click on [Compute toolpaths] or on . 

 
Fig. 93: Computing toolpaths 

 The following message is displayed: 

 
Fig. 94: Message Toolpaths calculation 
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 The toolpaths are computed automatically with default settings. 
The following message is displayed: 

 
Fig. 95: Message Computation results 

6. Check the computation results for any possible warnings or errors and make 
corrections, if required. 

7. Click on [Close]. 

 The toolpaths and scan fields have been computed. 

 Processing the PCB 

 

Clean the material surface with LPKF Cleaner, if a discoloration (oxide layer) is 
discernible. Thus, a surface is achieved that always has the same characteristics. 
 

1. Switch to the user guidance step Processing. 

 
Fig. 96: User guidance step Processing 

2. Click on  or click on [Start production]. 
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 The following message is displayed: 

 
Fig. 97: Dialog Processing phase: Mount material 

3. Open the cover. 
4. Place the base material onto the processing table. 
5. Click on . 
 The base material is fastened onto the processing table by vacuum. 

 

If the base material is bent too much and the vacuum does not allow to fasten it 
correctly, fasten it with adhesive tape. 

6. Close the cover. 
7. Click on [OK]. 
 The following dialog is displayed: 

 
Fig. 98: Dialog Placement 

8. Move the dialog Placement to get a better overview. 
9. Determine the processing area. The base material position and base material size 

must match the processing area used by the CircuitPro PL software. 

 

For detailed information on project placement by determining the processing area, 
refer to chapter 1.1. 
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10. Click on the tab Processing data. 

 
Fig. 99: Dialog Placement | Processing data 

11. Place the processing data by performing one of the following steps: 
− Use drag & drop. 
− Enter the values in the fields x and y. 
− Click on [Center on material] to place the processing data on the center of the 

base material. 

12. Click on [OK]. 
 The laser system starts the material thickness measurement. The following 

message is displayed: 

 
Fig. 100: Message Thickness measurement running 
 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, the following message is displayed: 

 
Fig. 101: Message Laser warm-up phase in progress 
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After warm-up, the fiducials and the through-holes are drilled and the following 
dialog is displayed: 

 
Fig. 102: Dialog Test tool settings 
 

 

In this example, testing and setting the tools is to be skipped. 
 
For detailed information on testing and setting the tools, refer to chapter 1.5. 
 

13. Click on [Resume]. 
 The Bottom side (BottomLayer) is structured and the following message is 

displayed: 

 
Fig. 103: Message Processing phase: Flip material 

14. Turn the base material over around the symmetry axis of the system. 
15. Click on [OK]. 
 The dialog Placement is displayed. 
16. Place the processing data. The location of the layout must match the location of 

the PCB and fiducials on the processing table. 

 

For detailed information on project placement according to fiducial positions, refer to 
chapter 1.1. 
 

17. When project placement is complete, click on [OK]. 
 The laser system reads the fiducials on the Top side (TopLayer). 

 

For detailed information on fiducial recognition, refer to chapter 1.2. 

 

After fiducial recognition, the laser system starts the material thickness 
measurement and the message Thickness measurement running is displayed. 
When finished, the dialog Test tool settings is displayed. 

18. Click on [Resume]. 
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 The Top side (TopLayer) is structured and the following message is displayed: 

 
Fig. 104: Message Board production finished 

19. Click on [Close]. 
20. Open the cover. 
21. Remove the PCB from the system. 

 The PCB has been processed. 

 Cleaning the system 

The processing area has to be cleaned if heavily soiled. 

 Use a vacuum cleaner to remove chips and residues from the processing area. 

 The system has been cleaned. 

 Cleaning the PCB 

1. Check for any remaining copper strips on the PCB that have not been removed by 
the laser. 

2. Spray the PCB with LPKF Cleaner and use a brush to clean it.  
3. Rinse the PCB with tap water and dry it with compressed air. 

 

If the PCB is still not free of unwanted copper strips, apply a piece of adhesive tape 
that does not leave glue residues on the PCB and pull it off. Any remaining copper 
strips should be attached to the adhesive tape. 
 

 The PCB has been cleaned. 

 
Residual copper strips  

If despite all cleaning any copper strips still remain on the PCB, check the material 
and the tools with laser parameters for a specific material. 
 
Modify the parameters of the tools so that there are no more copper strips on the 
PCB after processing. For detailed information on adjusting the tools, refer to  
chapter 1.5. 
 

 

The PCB production is finished. 
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2.2 How to produce a double-sided PCB with galvanic 
through-hole plating 

This chapter describes how to create a double-sided PCB using a laser system, a 
circuit board plotter and a galvanic through-hole plating system. 

Ensure that the following consumables and auxiliaries are available before performing 
the described tasks: 

Consumables Auxiliaries System 
• Base material FR4, 

229 mm × 305 mm × 
1.5 mm, 5/5 μm 
copper-plated with 
protection foil 
(order code: 
SET-10-1053) 

• 1 set of tools for ProtoMat 
• LPKF Cleaner  

(order code: 115891) 
• Brush 
• Oil-free compressed air 
• Tap water 

• ProtoLaser U4/S4/R4 
• ProtoMat S or E 
• Contac S4 

 

 

The following steps are performed in this tutorial: 

• Switching on the ProtoMat 
• Importing the data in CircuitPro PM 
• Assigning holes to the layer DrillUnplated in CircuitPro PM 
• Multiplying the layout in CircuitPro PM 
• Creating fiducials in CircuitPro PM 
• Saving the file in CircuitPro PM 
• Generating toolpaths in CircuitPro PM 
• Processing a PCB (with ProtoMat) 
• Galvanic through-hole plating the PCB (with Contac S4) 
• Preparing the data in CircuitPro PL 
• Structuring the PCB (with ProtoLaser) 
• Drilling unplated through holes and cutting out the PCB (with ProtoMat) 
• Cleaning the PCB 
• Cleaning the ProtoMat 

 Switching on the ProtoMat 

1. Press the on/off switch. 
 The system is switched on. 
2. Turn on the PC that is connected to the system. 
3. Double-click on the desktop icon of CircuitPro PM. 

 

Fig. 105: Desktop icon CircuitPro PM 

4. Wait for the system to connect and initialize. 
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 The following dialog is displayed: 

 

Fig. 106: Dialog Connection steps 

 The following dialog is displayed: 

 

Fig. 107: Dialog New document 

5. In the tab Templates select the template: PM_PL_DoubleSided_GalvanicTHP.cbf. 

 The ProtoMat has been switched on. 
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 Importing the data in CircuitPro PM 

1. Click on File > Import or on . 
 The following dialog is displayed: 

 

Fig. 108: Dialog Open 

2. Navigate to the folder that contains the data you wish to import. For the example 
data used for this tutorial refer to the folder:  
C:\Program Files (x86)\LPKF Laser & Electronics\ 

LPKF CircuitPro PM\Example Data\UseCase_DoubleSidedPCB. 
3. Select the files you wish to import (in this example Tutor.BOA, Tutor.BOT, 

Tutor.DRL, and Tutor.TOP). 
4. Click on [Open]. 
 The data should automatically be assigned to the correct layers and the following 

dialog is displayed: 

 

Fig. 109: Dialog Import | Assigned layers 

5. Assign the holes to the layers DrillPlated or DrillUnplated, depending whether the 
holes are to be plated or not. In this example the option DrillPlated is used. 

 

If there are no separate files for plated and unplated holes, they can be manually 
reassigned to the proper layer later (refer to step Assigning holes to the layer 
DrillUnplated in CircuitPro PM on page 87). 
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6. Look at the preview and check whether the graphics and size (in the Size/Format 
column) of the drilling file are correct. If not, you can adapt the settings in the 
sub-tab General. 

7. Click on [OK]. 
 The CAM view changes as follows: 

 

Fig. 110: Imported data in the CAM view 

 The data have been imported in CircuitPro PM. 

  

 

Assigning the layers manually 

If the data have not been assigned to the correct layers automatically, they can be 
assigned manually. In the drop-down list in the column Layer/Template, select which 
layer is to be assigned to the imported source data. 
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 Assigning holes to the layer DrillUnplated in CircuitPro PM 

The holes that do not have a copper ring (i.e. they are not directly surrounded by 
copper), as well as the holes that should not be galvanically plated, must be assigned 
to the DrillUnplated layer. 

1. Press and hold the  key and click on all holes that are to be assigned to the 
layer DrillUnplated. 

 The holes are highlighted in gray: 

 

Fig. 111: CAM view after selecting holes 

2. Right-click on the layout and select DrillUnplated in the context menu under 
Assign objects to layer. 

 

Fig. 112: Context menu Assign objects to DrillUnplated layer 

 An additional layer is created automatically. 

 The holes have been assigned to the layer DrillUnplated in CircuitPro PM. 
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 Multiplying the layout in CircuitPro PM 

The layout can be copied and placed freely for panel production depending on the size 
of the layout and the size of the base material. 

1. Select the entire layout by pressing  + . 
 The layout is highlighted. 
2. Right-click on the highlighted layout. 
 The following context menu is displayed: 

 

Fig. 113: Context menu Step & Repeat 

3. Click on Step & Repeat... 
 The following dialog is displayed: 

 

Fig. 114: Dialog Step & Repeat 

4. Enter the desired repetitions along each axis in the Repetition fields. In this 
example the layer is multiplied by 4 exemplars. Enter 2 repetitions for the x axis 
and 2 repetitions for the y axis. 

 

Some space for cutout is required between copies, so the distance should be 
increased in both x and y direction. 
 

5. Increase the values in the Distance fields by 5 mm, if you are using a contour 
routing tool with 2 mm. 
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 After entering all values, the dialog Step & Repeat changes as follows: 

 

Fig. 115: Dialog Step & Repeat after entering values 

6. Click on [Apply]. 
7. Click on [Close]. 
8. In order to zoom out and get an overview of the multiplied projects, perform one of 

the following steps: 
− Scroll the mouse wheel. 
− Press the key . 
− Click on . 

 The CAM view changes as follows: 

 

Fig. 116: CAM view of the multiplied layout 

 The layout has been multiplied in CircuitPro PM. 
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 Creating fiducials in CircuitPro PM 

1. Click on Insert > Fiducial > Fiducial… or on  and Fiducial... 
 The following dialog is displayed: 

 

Fig. 117: Dialog Create fiducial 

2. Perform one of the following steps: 
− Click on the positions in the layout where you want to place the fiducials. 
− Create the fiducials by entering the x and y position in the dialog. 

 

For optimum alignment results it is recommended to create four fiducials and to place 
them outside the outer contour. 
Using three fiducials is a good way to avoid wrong orientation of the base material. 
At least two fiducials are required for correct operation of the process; arrange them 
diagonally. 
 

3. Click on [Close] or press . 
 The CAM view changes as follows: 

 

Fig. 118: CAM view after creating fiducials 

 The fiducials have been created in CircuitPro PM. 
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 Saving the file in CircuitPro PM 

1. Click on File > Save As… 
2. Select a suitable folder, name the file and click on [Save]. 

 The file has been saved in CircuitPro PM. 

 Generating toolpaths in CircuitPro PM 

1. Click on Toolpath > Technology Dialog… or on . 
 The dialog Technology Dialog is displayed. 

 
Fig. 119: Tab Isolate 

2. In the tab Contour routing use the arrow buttons to select the entry Edge gaps. 
This is usually the preferred method of contour routing. 

 
Fig. 120: Tab Contour routing 
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3. Click on the tab Pockets and deactivate the check box Process, since there are no 
pockets in this project. 

 
Fig. 121: Tab Pockets 

4. Click on [Start]. 
 The software generates all toolpaths and identifies all required tools. A report of 

the required tools is displayed: 

 

Fig. 122: Message Computation Results 

5. Check the computation results for any possible warnings or errors and make 
corrections, if needed. 

6. Click on [Close]. 
7. Click on File > Save or on  to save the changes. 

 The toolpaths have been generated in CircuitPro PM. 

 

For detailed information on contour routing types and settings refer to the 
compendium of CircuitPro PM. 
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 Processing a PCB (with ProtoMat) 

 

Milling phases will be skipped, as this will be done by the ProtoLaser. 

 

1. Load the tool magazine and assign the tools to positions. 
2. Click on Machining > Process all or in the pane Processing on . 
3. Perform the following phases: 

− MountMaterial 
− MaterialSettings 
− Placement 

 The phases DrillFiducial, MarkingDrills and DrillingPlated are performed. 
4. Remove the PCB from the system. 
5. Rinse the PCB with tap water and dry it using compressed air. 
6. When the message Processing Phase: ThroughHolePlating is displayed, remove 

the PCB from the system and click on [Cancel] to temporarily stop the process. 

 The PCB has been processed. 

 

For detailed information on the ProtoMat phases refer to the how-to guides of 
ProtoMat. 
 

 Galvanic through-hole plating the PCB (with Contac S4) 

1. Switch on the system. 
2. Select a profile. 

 

The recommended total copper thickness after through-hole plating is 30 µm to 
35 µm. 
 

3. Start the process. 
4. Prepare the PCB for through-hole plating. 
5. Clean the PCB. 
6. Condition the PCB. 
7. Activate the PCB. 
8. Clean the holes with LPKF ViaCleaner. 
9. Copper-plate the PCB. 
10. Switch off the system. 

 The PCB has been galvanically through-hole plated. 

 

For detailed information on galvanic through-hole plating, refer to the user manual of 
Contac S4. 
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Tips for more efficient galvanic through-hole plating 

 In case of oxidation, clean it using a soft brush and LPKF Cleaner. 
 Use compressed air to remove drilling debris from the through holes. 
 Use compressed air to remove water from the through holes before activation in 

tank 3. 
 Turn the board over at half of plating time in order to achieve equal copper 

deposition on both sides. 

  
 

 Preparing the data in CircuitPro PL 

 

For detailed information on preparing the data with CircuitPro PL refer to chapter 2.1. 

 

1. Switch to the user guidance step New. 
2. Click on [Open project...]. 

 
Fig. 123: Open project 

 The dialog Open is displayed. 
3. Navigate to the folder that contains the file you previously saved in CircuitPro PM. 
4. Select CBF document (*.cbf) from the drop-down list. 
5. Select the appropriate .cbf file and click on [Open]. 
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 The following dialog is displayed: 

 
Fig. 124: Dialog Upgrade project 

6. Perform the following steps: 
− Select Double-sided from the drop-down list. 
− Select your laser system from the drop-down list (in this example PL S4). 
− Activate the check box Supported by ProtoMat. 
− Select the template Double-sided, ProtoLaser S4, ProtoMat, galvanic 

through-hole plating. 

 The view changes as follows: 

  
Fig. 125: Upgrade selected 

7. Click on [Upgrade] or double click on the template. 
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 The user guidance step Material is displayed. 
8. Select the material FR4 Double-sided, 1.5 mm, 5/5 µm. 

 
Fig. 126: Material selection 

9. Click on [Select material] or double-click on the material. 
 The opened project is displayed in the user guidance step Layout. 
10. Switch to the user guidance step Toolpaths. 

 
Fig. 127: Opened project in the user guidance step Toolpaths 

11. Click on [Compute toolpaths] or on . 
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 The following dialog is displayed: 

 
Fig. 128: Dialog Computing toolpaths 

12. Click on [Continue]. 
 The message Computation results is displayed. 
13. Check the computation results for any possible warnings or errors and make 

corrections, if needed. 
14. Click on [Close]. 
15. Click on File > Save or on . 
16. Select a suitable folder, name the file and click on [Save]. 
 The file is saved in the .cp2d file format. 

 The data have been prepared in CircuitPro PL. 

 Structuring the PCB (with ProtoLaser) 

 

For detailed information on structuring the PCB with the ProtoLaser refer to 
chapter 2.1. 

 

1. Switch to the user guidance step Processing. 
2. Click on  or click on [Start production]. 
 The following message is displayed: 

 
Fig. 129: Message Processing phase: Process drilling on a ProtoMat 

3. Click on [OK]. 
 The following message is displayed: 

 
Fig. 130: Message Processing phase: Galvanic through-hole plating 

4. Click on [OK]. 
 The following message is displayed: 

 
Fig. 131: Message Processing phase: Mount material bottom 

5. Open the cover. 
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6. Place the base material with the Bottom side (BottomLayer) facing upwards 
onto the processing table. 

7. Click on . 
 The base material is fastened onto the processing table by vacuum. 
8. Close the cover. 
9. Click on [OK]. 
 The following dialog is displayed: 

 
Fig. 132: Dialog Copper thickness 

10. Enter the total copper thickness after galvanic through-hole plating in the input 
field. 

 

You can determine the total copper thickness by performing one of the following 
steps: 
 

− Calculate the copper thickness from the copper deposition rate in Contac S4 
(approx. 0.15 µm/min). 

− Measure the copper thickness with the ProtoMat S104. 

 

11. Click on [OK]. 
 The following dialog is displayed: 

 
Fig. 133: Dialog Placement 

12. Move the dialog Placement to get a better overview. 
13. Click on the tab Processing data. 
14. Place the processing data. The location of the layout must match the location of 

the PCB and fiducials on the processing table. 

 

For detailed information on project placement according to fiducial positions, refer to 
chapter 1.1. 
 

15. After project placement is complete click on [OK]. 
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 The laser system reads the fiducials on the Bottom side (BottomLayer). 

 

For detailed information on fiducial recognition, refer to chapter 1.2. 

 

After fiducial recognition, the laser system starts the material thickness 
measurement. The message Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, the dialog Test tool settings is displayed. 

 

In this example, testing and setting the tools is to be skipped. 
 
For detailed information on testing and setting the tools, refer to chapter 1.5. 
 

16. Click on [Resume]. 
 The Bottom side (BottomLayer) is structured and the following message is 

displayed: 

 
Fig. 134: Message Processing phase: Flip material 

17. Turn the base material over around the symmetry axis of the system. 
18. Click on [OK]. 
 The dialog Placement is displayed. 
19. Place the processing data matching the location of the PCB and fiducials on the 

processing table. 
20. When project placement is complete, click on [OK]. 
 The laser system reads the fiducials on the Top side (TopLayer). 

After fiducial recognition, the laser system starts the material thickness 
measurement and the message Thickness measurement running is displayed. 
When finished, the dialog Test tool settings is displayed. 

21. Click on [Resume]. 
 Structuring the Top side (TopLayer) is started. 

When the message Processing phase: Process drilling on a ProtoMat is displayed, 
remove the PCB and proceed with drilling and cutting on the ProtoMat. 

 The PCB has been structured. 
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 Drilling unplated through holes and cutting out the PCB (with ProtoMat) 

1. In CircuitPro PM click on File > Open or on . 
 The following dialog is displayed: 

 

Fig. 135: Dialog Open 

2. Navigate to the folder that contains the file you previously saved in CircuitPro PM. 
3. Select the *.cbf file and click on [Open]. 
 Your project is displayed in the CAM view: 

 

Fig. 136: CAM view of the opened project 

4. Switch to the Machining view. 
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 Your project is displayed in the Machining view: 

 

Fig. 137: Machining view of the opened project 

5. In the pane Processing, select MountMaterialTop in the drop-down list. 

 

Fig. 138: Drop-down list of the processing phases 
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 The Machining view displays the drilling and contour-routing data: 

 

Fig. 139: Machining view of drilling and contour-routing data 

6. Click on . 
 The message Processing Phase: MountMaterialTop is displayed. 
7. Place the board onto the system’s processing table with the Top side (TopLayer) 

facing upwards and fasten it using adhesive tape. 
8. Perform the following phases: 

− MaterialSettings_1 

− Placement_1 

 The phase ReadFiducialsTop is performed. 

 

For detailed information on fiducial recognition refer to the how-to guides of 
ProtoMat. 

 

 The phases DrillingUnplated and ContourRouting are performed. 

 The unplated through holes have been drilled and the PCB has been cut out. 
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 Cleaning the PCB 

1. Remove the PCB from the system. 
2. Spray the PCB with LPKF Cleaner and use a brush to clean it. 
3. Rinse the PCB with tap water and dry it with compressed air. 
4. Break or cut the breakout tabs. 

 The PCB has been cleaned. 

The PCB production is finished. 

 Cleaning the ProtoMat 

The processing area has to be cleaned if heavily soiled. 

 Use a brush and a dry antistatic cloth to remove residues from the processing 
table. 

 Use a vacuum cleaner to remove residues from the interior. 

 The ProtoMat has been cleaned. 
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2.3 How to produce a double-sided PCB with non-galvanic 
through-hole plating 

This chapter describes how to create a double-sided PCB using a circuit board plotter, 
a laser system and a non-galvanic through-hole plating system. 

Ensure that the following consumables and auxiliaries are available before performing 
the described tasks: 

Consumables Auxiliaries System 
• Base material FR4, 

229 mm × 305 mm × 
1.5 mm, 18/18 μm 
copper-plated 
(order code: 115967) 

• 1 set of tools for ProtoMat 
• Convection oven  

(order code: 115877) 
• LPKF Cleaner  

(order code: 115891) 
• Brush 
• Oil-free compressed air 
• Tap water 

• ProtoLaser U4/S4/R4 
• ProtoMat S or E 
• ProConduct 

 

 

The following steps are performed in this tutorial: 

• Preparing the data in CircuitPro PM 
• Drilling fiducials (with ProtoMat) 
• Preparing the data in CircuitPro PL 
• Structuring the PCB (with ProtoLaser) 
• Drilling unplated through holes and cutting out the PCB (with ProtoMat) 
• Drilling plated through holes (with ProtoMat) 
• Plating through holes (with ProConduct) 

 Preparing the data in CircuitPro PM 

 

For detailed information on preparing the data in CircuitPro PM refer to chapter 2.2. 

 

1. In the tab Templates of the dialog New document, select the template: 
PM_PL_DoubleSided_ProConduct.cbf. 

2. Click on File > Import or on . 
3. Navigate to the folder that contains the data you wish to import. For the example 

data used for this tutorial refer to the folder:  
C:\Program Files (x86)\LPKF Laser & Electronics\ 

LPKF CircuitPro PM\Example Data\UseCase_DoubleSidedPCB. 
4. Select the files you wish to import (in this example Tutor.BOA, Tutor.BOT, 

Tutor.DRL and Tutor.TOP). 
5. Click on [Open]. 
 The data are automatically assigned to the corresponding layers. 
6. Correct the layer assignments, if necessary. 
7. Click on [OK]. 
8. You can make multiples of the layout, if desired. 
9. Add fiducials to the layout. 
10. Click on Toolpath > Technology Dialog or on . 
 The dialog Technology Dialog is displayed. 
11. Click on [Start]. 
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 The computation results are displayed in a dialog. 
12. Click on [Close]. 
13. Save the file. 

 The data have been prepared in CircuitPro PM. 

 Drilling fiducials (with ProtoMat) 

1. Load the tool magazine and assign the tools to positions. 
2. Click on Machining > Process all or on . 
3. Perform the following phases: 

− MountMaterial 
− MaterialSettings 
− Placement 

 The DrillFiducial phase is performed. 
4. When the message Processing Phase: ProtoLaserStructuring is displayed, 

remove the PCB from the system and click on [Cancel] to temporarily stop the 
process. 

 The fiducials have been drilled. 

 

For detailed information on the ProtoMat phases refer to the how-to guides of 
ProtoMat. 
 

 Preparing the data in CircuitPro PL 

 

For detailed information on preparing the data in CircuitPro PL refer to chapter 2.2. 

 

1. In the user guidance step New click on [Open project...]. 
 The dialog Open is displayed. 
2. Navigate to the folder that contains the file you previously saved in CircuitPro PM. 
3. Set the file type to CBF document (*.cbf). 
4. Select the appropriate .cbf file and click on [Open]. 
 The dialog Upgrade project is displayed. 
5. Perform the following steps: 

− Select Double-sided from the drop-down list. 
− Select your laser system from the drop-down list (in this example PL U4). 
− Activate the check box Supported by ProtoMat. 
− Select the template Double-sided, ProtoLaser U4, ProtoMat, ProConduct. 
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 The view changes as follows: 

 
Fig. 140: Upgrade selected 

6. Click on [Upgrade] or double-click on the template. 
 The user guidance step Material is displayed. 
7. Select the material FR4 Double-sided, 1.5 mm, 18/18 µm. 
8. Click on [Select material] or double-click on the material. 
 The opened project is displayed in the user guidance step Layout. 
9. Switch to the user guidance step Toolpaths. 
10. Click on [Compute toolpaths] or on . 
 The dialog Computing toolpaths is displayed. 
11. Click on [Continue]. 
 The message Computation results is displayed. 
12. Check the computation results for any possible warnings or errors and make 

corrections, if needed. 
13. Click on [Close]. 
14. Save your project. 

 The data have been prepared in CircuitPro PL. 
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 Structuring the PCB (with ProtoLaser) 

 

For detailed information on structuring the PCB with the ProtoLaser refer to 
chapter 2.2. 

 

1. Switch to the user guidance step Processing. 
2. Click on  or click on [Start production]. 
3. When the message Processing phase: Process drilling on a ProtoMat is displayed, 

click on [OK]. 
4. When the message Processing phase: Mount material bottom is displayed, place 

the base material with the Bottom side (BottomLayer) facing upwards onto the 
processing table. 

5. Click on . 
 The base material is fastened onto the processing table by vacuum. 
6. Click on [OK]. 
 The dialog Placement is displayed. 
7. Move the dialog Placement to get a better overview. 
8. Click on the tab Processing data. 
9. Place the processing data. The location of the layout must match the location of 

the PCB and fiducials on the processing table. 

 

For detailed information on project placement according to fiducial positions, refer to 
chapter 1.1. 
 

10. After project placement is complete click on [OK]. 
 The laser system reads the fiducials on the Bottom side (BottomLayer). 

 

For detailed information on fiducial recognition, refer to chapter 1.2. 

 

After fiducial recognition, the laser system starts the material thickness 
measurement. The message Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, the dialog Test tool settings is displayed. 

 

In this example, testing and setting the tools is to be skipped. 
 
For detailed information on testing and setting the tools, refer to chapter 1.5. 
 

11. Click on [Resume]. 
 Structuring the Bottom side (BottomLayer) is started. 
12. When the message Processing phase: Flip material is displayed, turn the PCB 

over around the symmetry axis of the system and click on [OK]. 
 The dialog Placement is displayed. 
13. Place the processing data matching the location of the PCB and fiducials on the 

processing table. 
14. When project placement is complete, click on [OK]. 
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 The laser system reads the fiducials on the Top side (TopLayer).  
After fiducial recognition, the laser system starts the material thickness 
measurement and the message Thickness measurement running is displayed. 
When finished, the dialog Test tool settings is displayed. 

15. Click on [Resume]. 
16. Structuring the Top side (TopLayer) is started. 
 When the message Processing phase: Process drilling on a ProtoMat is 

displayed, remove the PCB and proceed with drilling and cutting on the ProtoMat. 

 The PCB has been structured. 

 Drilling unplated through holes and cutting out the PCB (with ProtoMat) 

 

For detailed information on drilling unplated through holes and cutting out the PCB 
with ProtoMat refer to chapter 2.2. 
 

1. Open the *.cbf file you previously saved in CircuitPro PM. 
2. Switch to the pane Processing. 
3. Select MountMaterialTop from the drop-down list and click on . 
4. Place the board onto the system’s processing table with the Top side (TopLayer) 

facing upwards and fasten it using adhesive tape. 
5. Perform the following phases: 

− MaterialSettings_1 

− Placement_1 

 The phases ReadFiducialsTop, MarkingDrills, DrillingUnplated and 
ContourRouting are performed. 

6. When the message Processing Phase: DismountMaterial is displayed, remove the 
PCB from the system and click on [OK]. 

7. Rinse the PCB with tap water and dry it using compressed air. 

 The unplated through holes have been drilled and the PCB has been cut out. 

 

The PCB must remain attached to the original material. Do not break or cut the 
breakout tabs yet. 
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 Drilling plated through holes (with ProtoMat) 

1. When the message Processing Phase: ApplyProtectionFilm is displayed, apply the 
protective film onto both sides of the board and click on [OK]. 

2. When the message Processing Phase: MountMaterialTop_1 is displayed, place 
the board with the Top side (TopLayer) facing upwards onto the system’s 
processing table and click on [OK]. 

3. Perform the phase Placement_2. 
 The phases ReadFiducialsTop_1 and DrillingPlated are performed. 
4. When the message Processing Phase: DismountMaterial_1 is displayed, remove 

the board from the system and check it for burrs and blockages. 

 

Check whether the fiducials are covered by the protective film and expose them if 
necessary. 
 

 The plated through holes have been drilled. 

 Plating through holes (with ProConduct) 

1. Place the mat onto the vacuum table (ProtoMat mounted or standalone). 
2. Place the board onto the mat. 
3. Apply the ProConduct paste along the edge of the PCB. 
4. Spread the paste on the whole surface of the PCB (do not spread over the 

fiducials). 
5. Turn on the extraction system on the highest setting and wait for at least 

30 seconds. 
6. Spread the paste remaining on the PCB surface with the vacuum turned on. 
7. Switch off the extraction system. 
8. Turn the board over and repeat the steps 2 to 7 on the other side. 
9. Slowly peel off the protective film at an angle of 90° from both sides of the board. 
10. Place the board horizontally into the convection oven for 30 minutes (160 °C / 

320 °F). 
11. Remove the board and let it cool down to ambient temperature. 
12. Spray the board with LPKF Cleaner and use a brush to clean the PCB.  
13. Rinse the board with tap water and dry it with compressed air. 
14. Cut out or break out the PCB from the board. 

 The through holes have been plated. 

 

For detailed information on non-galvanic through-hole plating refer to the process 
description of ProConduct. 
 

 

The PCB production is finished. 
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2.4 Producing a double-sided flexible PCB with galvanic 
through-hole plating 

This chapter describes how to create a double-sided flexible PCB using a laser 
system and a galvanic through-hole plating system. 

 

If you do not want to perform the through-hole plating: 
 

− Select the following template in the system software: 
Double-sided, ProtoLaser R4, no through-hole plating. 

− Skip the step Galvanic through-hole plating the flexible PCB. 

The processing order changes slightly. 
 

 

Ensure that the following consumables and auxiliaries are available before performing 
the described tasks: 

Consumables Auxiliaries System 
• 1 × Pyralux® CG185018E • LPKF Cleaner  

(order code: 115891) 
• Hand-held microscope 
• Brush 
• Tap water 
• PCB holder for flexible PCBs  

(order code: 10067533) 

• ProtoLaser R4 
• Contac S4 

 

 

The following steps are performed in this tutorial: 

• Prepairing the data in CircuitPro PL 
• Computing toolpaths and scan fields 
• Preparing the flexible material 
• Galvanic through-hole plating the flexible PCB (with Contac S4) 
• Structuring the flexible PCB 
• Cleaning the flexible PCB 

 Prepairing the data in CircuitPro PL 

 

For detailed information on preparing the data in CircuitPro PL refer to chapter 2.1. 

 

1. In the user guidance step New, select Double-sided from the drop-down list. 
2. Select your laser system from the drop-down list (in this example PL R4). 
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 A list of templates for double-sided materials is displayed: 

 
Fig. 141: List of templates 

3. Select the template Double-sided, ProtoLaser R4, galvanic through-hole plating. 
4. Click on [Load template] or double-click on the template. 
 The user guidance step Material is displayed. 
5. Select the material Pyralux CG185018E. 

 
Fig. 142: Material selection 

6. Click on [Select material] or double-click on the material. 
 The user guidance step Import is displayed. 
7. Click on . 
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 The dialog Open is displayed. 
8. Navigate to the folder that contains the data you want to import. For the example 

data that are used for this tutorial, refer to the folder: 
C:\Program Files\LPKF Laser & Electronics AG\ 

LPKF CircuitPro PL\Example Data\UseCase_DoubleSidedPCB. 
9. Select the desired files for import (in this example Tutor.BOA, Tutor.BOT, 

Tutor.DRL and Tutor.TOP). 
10. Click on [Open]. 
 The data are automatically assigned to the correct layers in the user guidance 

step Import: 

 
Fig. 143: User guidance step Import 

11. Assign the holes to the layer DrillPlated (in the column Target). 
12. Click on [Import]. 
 The user guidance step Layout is displayed: 

 
Fig. 144: User guidance step Layout 
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13. Click on Insert > Automatic fiducial creation or click on . 

 

The function Automatic fiducial creation is only available in the license level Advanced 
of CircuitPro PL. If you have any questions contact the LPKF sales department. 
 

 The dialog Automatic fiducial creation is displayed: 
14. Adapt the settings for the fiducials. 

In this example four fiducials with a distance of 4 mm from the BoardOutline are 
created. 

15. Click on [OK]. 
 The fiducials are automatically added to the layout. 

 

For detailed information on creating fiducials refer to page 74. 

 

 The data have been prepared in CircuitPro PL. 

 Computing toolpaths and scan fields 

 

For detailed information on computing toolpaths and scan fields refer to page 76. 

 

1. Switch to the user guidance step Scan fields. 
2. Click on [Compute scan fields] or on . 
 The dialog Compute scan fields is displayed. 

 

CircuitPro PL computes different points at the scan field intersections for each task of 
the tool Hatch in order to prevent damage to the substrate at the scan field 
intersections. Thus, computing the scan fields should be done with the function 
Overlap. 
 

The function Offset creates an offset between the scan fields of the layers Top and 
Bottom. This avoids the perforation of flexible substrates at the scan field 
intersections. 
 

For detailed information on the overlap and on the offset between the scan fields, 
refer to the TechNote ProtoLaser: Optimizing the processing quality. 
 

 

3. Deactivate the check box Without top to bottom scan field offset. 

 
Fig. 145: Dialog Compute scan fields 

4. Click on [Compute]. 
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 The scan fields are computed automatically. The Overlap is displayed: 

 
Fig. 146: Scan fields computed | Overlap displayed 

5. Click on [Compute toolpaths] or on . 

 
Fig. 147: Computing toolpaths 

 The toolpaths are computed automatically with default settings. The message 
Computation results is displayed. 

6. Check the computation results for any possible warnings or errors and make 
corrections, if needed. 

7. Click on [Close]. 
8. Save your project. 

 The toolpaths and scan fields have been computed. 
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Computing toolpaths for processing flexible PCBs 

Flexible materials require a hatching processing method in most cases. You can 
adjust the parameters in the user guidance step Workflow by selecting the work 
package Structure. 
The recommended Pattern is xy parallel with a Hatching grid that is approximately 
half the beam diameter of the tool Hatch. The parameter Hatching contour overlap 
determines how much overlap there is between the isolation toolpath and the 
hatching toolpaths. In most cases it should be set to 100 %. A lower value can result 
in incomplete copper removal on the scan field intersections. 
 

 

 
 
When processing sensitive materials, it is recommended to activate and adjust the 
Skywriting parameters of the tool Hatch in the user guidance step Tools. 
 

 

 

 
For detailed information on the hatching processing method and on the Skywriting 
parameters, refer to the TechNote ProtoLaser: Optimizing the processing quality. 
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 Preparing the flexible material 

 

The flexible material is very thin and delicate. Handle it with care! 

 

1. Switch to the user guidance step Processing. 
2. Click on  or click on [Start production]. 
3. When the message Processing phase: Mount material is displayed, place the 

flexible material onto the processing table and fasten it with adhesive tape. 

 
Fig. 148: Flexible material fastened to the processing table 

4. Click on . 
 The flexible material is fastened onto the processing table by vacuum. 
5. Click on [OK]. 
 The following dialog is displayed: 

 
Fig. 149: Dialog Placement 

6. Move the dialog Placement to get a better overview. 
7. Determine the processing area. The base material position and base material size 

must match the processing area used by the CircuitPro PL software. 

 

For detailed information on project placement by determining the processing area, 
refer to chapter 1.1. 
 

8. Click on the tab Processing data. 
9. Click on [Center on material]. 
10. Click on [OK]. 
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 The laser system starts the material thickness measurement. The message 
Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, the flexible material is being prepared (fiducials and plated through 
holes are being drilled). 

11. When the message Processing phase: Dismount material is displayed, remove the 
flexible material from the system and click on [OK]. 

 The following message is displayed: 

 
Fig. 150: Message Processing phase: Galvanic through-hole plating 

12. Click on [Cancel]. 

 The flexible material has been prepared. 

 Galvanic through-hole plating the flexible PCB (with Contac S4) 

1. Switch on the system. 
2. Select a profile. 

 

It is recommended that the total copper thickness after through-hole plating is as 
low as possible. Too much copper deposition can lead to poorer processing quality. 
 
The required copper deposition depends on the actual application. In this example 
5 µm were added to the original copper cladding. 
 

 

3. Start the process. 
4. Insert the flexible PCB into the PCB holder for flexible PCBs. 

 
Fig. 151: PCB holder for flexible PCBs 
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The flexible PCB is fastened on three sides in the PCB holder. Thus, it remains 
properly secured and flat during plating. This way a good plating quality is achieved. 
 

5. Tighten the screws on the sides until the flexible PCB is safely fastened. 
6. Rinse the flexible PCB for at least 30 seconds with tap water. 
7. Clean the flexible PCB. 
8. Condition the flexible PCB. 
9. Activate the flexible PCB. 

 
Fig. 152: Inserting the flexible PCB into tank 3 

10. Clean the holes with LPKF ViaCleaner. 
11. Copper-plate the flexible PCB. 
12. Switch off the system. 

 The flexible PCB has been galvanically through-hole plated. 

 

For detailed information on galvanic through-hole plating, refer to the user manual of 
Contac S4. 
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 Structuring the flexible PCB 

1. Open the *.cp2d file you previously saved in CircuitPro PL. 
 The opened project is displayed in the user guidance step Processing. 
2. In the pane Workflow setup expand the group Processing. 

 
Fig. 153: Pane Workflow setup 

3. Right-click on the entry Bottom Side. 
 The following context menu is displayed: 

 
Fig. 154: Context menu Process from here 

4. Select Process from here. 
5. When the message Processing phase: Mount material bottom is displayed, place 

the flexible PCB with the Bottom side (BottomLayer) facing upwards onto the 
processing table and fasten it with adhesive tape. 

6. Click on . 
 The flexible PCB is fastened onto the processing table by vacuum. 
7. Click on [OK]. 
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 The following dialog is displayed: 

 
Fig. 155: Dialog Copper thickness 

8. Enter the total copper thickness after galvanic through-hole plating into the input 
field (in this example 23 μm). 

 

You can determine the total copper thickness by calculating the thickness from the 
copper deposition rate in Contac S4 (approx. 0.15 μm/min). 
 

9. Click on [OK]. 
 The dialog Placement is displayed. 
10. Move the dialog Placement to get a better overview. 
11. Place the processing data. 

The location of the layout must match the location of the flexible PCB and 
fiducials on the processing table. 

 

For detailed information on project placement according to fiducial positions, refer to 
chapter 1.1. 
 

12. After project placement is complete click on [OK]. 
 The laser system reads the fiducials on the Bottom side (BottomLayer). 

 

For detailed information on fiducial recognition, refer to chapter 1.2. 

 

After fiducial recognition, the laser system starts the material thickness 
measurement. The message Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, the following dialog is displayed: 

 
Fig. 156: Dialog Test tool settings 
 

 

It is recommended that you process a test sample on your flexible PCB before you 
continue with production. 
 

13. Select Place and process “Large test sample 35x25 mm”. 
 

 

For detailed information on testing and setting the tools, refer to chapter 1.5. 
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14. Check the processed test sample with a hand-held microscope. 
15. Determine whether the processing quality is satisfactory. 
16. If the processing quality is not satisfactory, tune the tool settings. 

 

For detailed information on tuning the tool settings, refer to chapter 1.5. 

 

17. If the processing quality is satisfactory, click on [Resume]. 
 Structuring of the Bottom side (BottomLayer) is started. 
18. When the message Processing phase: Flip material is displayed, turn the flexible 

PCB over around the symmetry axis of the system and fasten it using adhesive 
tape. 

19. Click on [OK]. 
 The dialog Placement is displayed. 
20. Place the processing data matching the location of the flexible PCB and fiducials 

on the processing table. 
21. When project placement is complete, click on [OK]. 
22. The laser system reads the fiducials on the Top side (TopLayer). 

After fiducial recognition, the laser system starts the material thickness 
measurement and the message Thickness measurement running is displayed. 
When finished, the dialog Test tool settings is displayed. 

23. Repeat the steps 13 to 17. 
24. If the processing quality is satisfactory, click on [Resume]. 
 The laser system structures the Top side (TopLayer), drills the unplated through 

holes and cuts out the flexible PCB. 
25. When the message Board production finished is displayed, remove the flexible 

PCB from the system. 

 The flexible PCB has been structured. 
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 Cleaning the flexible PCB 

 

The flexible PCB is extremely thin and needs to be handled with care! 

 

1. Spray the flexible PCB with LPKF Cleaner and use a brush to clean it. 
2. Rinse the flexible PCB with tap water and dry it. 

 The flexible PCB has been cleaned. 

The PCB production is finished. 
 

  

 
Residual copper or damaged substrate 

If there is still copper on the PCB or if the substrate is damaged, check the material 
and the tools with the laser parameters specific to the material. 
 
Adjust the parameters of the tools in such a way that no copper remains on the PCB 
after processing. For detailed information on the tool settings, refer to chapter 1.5. 
 
In some cases, it is not possible to remove all copper by structuring without 
damaging the delicate substrate. Use the LPKF ViaCleaner to remove the remaining 
copper. 
 
For detailed information on cleaning the PCB with LPKF ViaCleaner, refer to the 
TechNote ProtoLaser: Optimizing the processing quality. 
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3 Producing multi-layer PCBs 

 

The production of multi-layer PCBs is only available in the license level Advanced of 
CircuitPro PL. If you have any questions contact the LPKF sales department. 

This chapter describes the production of four different types of multi-layer PCBs: 

1. Producing a multi-layer PCB with galvanic through-hole plating by using a 
laser system only. 

2. Producing a multi-layer PCB with galvanic through-hole plating. 

3. Producing a multi-layer PCB with non-galvanic through-hole plating. 

4. Producing a multi-layer PCB with blind vias and buried vias. 

The following LPKF systems are required for the procedures: 

Procedure LPKF system 

1 ProtoLaser U4/S4/R4, MultiPress S, Contac S4 

2 ProtoLaser U4/S4/R4, ProtoMat S or E, MultiPress S, Contac S4 

3 ProtoLaser U4/S4/R4, ProtoMat S or E, MultiPress S, ProConduct 

4 ProtoLaser U4/S4/R4, ProtoMat S or E, MultiPress S, Contac S4 

Table 5: Required LPKF systems 

 

3.1 How to produce a multi-layer PCB with galvanic 
through-hole plating by using a laser system only 

This chapter describes how to create a 4-layer PCB using a laser system, a 
multi-layer press and a galvanic through-hole plating system. 

Ensure that the following consumables and auxiliaries are available before performing 
the described tasks: 

Consumables Auxiliaries System 
• 1 × Base material FR4 

229 mm × 305 mm × 
1 mm, 18/18 μm 
copper-clad 
(order code: 119574) 

• 2 × Thin Laminate 104 ML 
0/5 μm, 229 mm × 
305 mm × 0.2 mm with 
protection foil  
(order code: 119571) 

• 4 × Prepreg Type 2125, 
200 mm × 275 mm × 
0.1 mm  
(order code: 119572) 

• Convection oven  
(order code: 115877) 

• LPKF Cleaner  
(order code: 115891) 

• Brush 
• Oil-free compressed air 
• Tap water 

• ProtoLaser U4/S4/R4 
• MultiPress S 
• Contac S4 
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The following steps are performed in this tutorial: 

• Preparing the data in CircuitPro PL 
• Preparing the laminate materials (with ProtoLaser) 
• Structuring the core material (with ProtoLaser) 
• Assembling and pressing the multi-layer stack (with MultiPress S) 
• Drilling plated through holes into the multi-layer PCB (with ProtoLaser) 
• Galvanic through-hole plating the multi-layer PCB (with Contac S4) 
• Structuring the outer layers of the multi-layer PCB (with ProtoLaser) 

 

 Preparing the data in CircuitPro PL 

 

For detailed information on preparing the data in CircuitPro PL refer to chapter 2.1. 

 

1. In the user guidance step New select 4-layer-Multilayer from the drop-down list. 
2. Select your laser system from the drop-down list (in this example PL U4). 
 A list of templates for 4-layer multi-layer materials is displayed: 

 
Fig. 157: List of multi-layer templates 

3. Select the template 4 Layers, ProtoLaser U4, galvanic through-hole plating, 

MultiPress S. 
4. Click on [Load template] or double-click on the template. 
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 The user guidance step Material is displayed. 
5. Select the material LPKF 4-Layer_Galvanic. 

 
Fig. 158: Material selection 

6. Click on [Select material] or double-click on the material. 
 The user guidance step Import is displayed. 
7. Click on . 
 The dialog Open is displayed. 
8. Navigate to the folder that contains the data you want to import. For the example 

data that are used for this tutorial, refer to the folder: 
C:\Program Files\LPKF Laser & Electronics AG\ 

LPKF CircuitPro PL\Example Data\UseCase_Multilayer. 
9. Select the files you want to import. In this example: 

Tutor_MultiLayer_4_Lagen.BOA, Tutor_MultiLayer_4_Lagen.BOT, 

Tutor_MultiLayer_4_Lagen.DRL, Tutor_MultiLayer_4_Lagen.LY2, 

Tutor_MultiLayer_4_Lagen.LY3 and Tutor_MultiLayer_4_Lagen.TOP. 

10. Click on [Open]. 
 The data are automatically assigned to the correct layers and the user guidance 

step Import is displayed: 

 
Fig. 159: User guidance step Import 

11. Assign the holes to the layer DrillPlated (in the column Target). 
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12. Click on [Import]. 
 The layout is displayed in the user guidance step Layout. 

 
Fig. 160: Layout of a multi-layer PCB 

 

Multi-layer templates already include among others fiducials, register holes, prepreg 
area, base material area etc. that are required for precise layer assembly in the press 
mold. 
 

13. If desired, multiply the layout (in this example the layout is not multiplied). 

 

The layout has to be within the prepreg material frame. It is preferable to move it to 
the center. 
 

14. Select the entire layout. 
 The layout is highlighted and changes its color. 
15. Right-click on the highlighted layout. 
 The following context menu is displayed: 

 
Fig. 161: Context menu Move object 

16. Select Move object or click on . 
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 The input fields for Specify reference point are displayed: 

 
Fig. 162: Specify reference point 

17. Click on a point in the original layout to specify the reference point. 
18. A copy of the layout (in orange) and the input fields for Specify distance are 

displayed: 

 
Fig. 163: Specify distance 
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19. Move the copied layout with the mouse to the desired position: 

 
Fig. 164: Desired position of the copied layout 

20. When you reach the desired position, left-click to specify the target point. 
21. In the user guidance step Layout click anywhere on the black background or press 

 to disable the Move object function. 
 The layout has been moved to the desired position: 

 
Fig. 165: Layout moved to the desired position 
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22. Switch to the user guidance step Toolpaths. 

 
Fig. 166: Opened project 

23. Click on [Compute toolpaths] or on . 
 The following dialog is displayed: 

 
Fig. 167: Dialog Computing toolpaths 

24. Click on [Continue]. 
 The toolpaths are being calculated. The message Computation results is 

displayed. 
25. Check the computation results for any possible warnings or errors and make 

corrections, if needed. 
26. Click on [Close]. 
27. Save your project. 

 The data have been prepared in CircuitPro PL. 
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 Preparing the laminate materials (with ProtoLaser) 

1. Switch to the user guidance step Processing. 

  
Fig. 168: User guidance step Processing 

2. Click on [Start production] or on . 
 The following message is displayed: 

 
Fig. 169: Message Processing phase: Mount laminate 

3. Place the first laminate with the copper side facing upwards in the center of the 
processing table. 

 

The laminate material is very thin and therefore usually bent. Click on  and fasten 
the laminate material along its edges with adhesive tape. 
 

4. Click on [OK]. 
 The following dialog is displayed. 

 
Fig. 170: Dialog Placement 

5. Move the dialog Placement to get a better overview. 
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6. Determine the processing area. The base material position and base material size 
must match the processing area used by the CircuitPro PL software. 

 

For detailed information on project placement by determining the processing area, 
refer to chapter 1.1. 
 

7. Click on the tab Processing data. 
8. Click on [Center on material]. 
9. Click on [OK]. 
 The laser system starts the material thickness measurement. The message 

Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, the first laminate (BottomLayer) is being prepared (positioning 
holes and register holes are being drilled). 

10. When the message Processing phase: Dismount material is displayed, remove the 
first laminate from the system and click on [OK]. 

11. When the message Processing phase: Mount laminate is displayed, place the 
second laminate with the copper side facing upwards in the center of the 
processing table. 

12. Click on [OK]. 
 The dialog Placement is displayed. 
13. Move the dialog Placement to get a better overview. 
14. Determine the processing area. The base material position and base material size 

must match the processing area used by the CircuitPro PL software. 
15. Click on the tab Processing data. 
16. Click on [Center on material]. 
17. Click on [OK]. 
 The laser system starts the material thickness measurement. The message 

Thickness measurement running is displayed. 
When finished, the second laminate (TopLayer) is being prepared (positioning 
holes and register holes are being drilled). 

18. When the message Processing phase: Dismount material is displayed, remove the 
second laminate from the system. 

 The laminate materials have been prepared. 
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 Structuring the core material (with ProtoLaser) 

1. In the message Processing phase: Dismount material click on [OK]. 
 The following message is displayed: 

 
Fig. 171: Message Processing phase: Mount core 

2. Place the core material in the center of the processing table. 
3. Click on . 
 The core material is fastened onto the processing table by vacuum. 
4. Click on [OK]. 
 The dialog Placement is displayed. 
5. Move the dialog Placement to get a better overview. 
6. Determine the processing area. The base material position and base material size 

must match the processing area used by the CircuitPro PL software. 

 

For detailed information on project placement by determining the processing area, 
refer to chapter 1.1. 
 

7. Click on the tab Processing data. 
8. Click on [Center on material]. 
9. Click on [OK]. 
 The laser system starts the material thickness measurement. The message 

Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

After material thickness measurement, the core material is being prepared 
(fiducials and register holes are being drilled). 
When finished, the dialog Test tool settings is displayed. 

 

In this example, testing and setting the tools is to be skipped. 
 
For detailed information on testing and setting the tools, refer to chapter 1.5. 
 

10. Click on [Resume]. 
 Structuring the Bottom side of the core material (Layer3) is started. 
11. When the message Processing phase: Flip material is displayed, turn the core 

material over around the symmetry axis of the system and click on [OK]. 
Ensure that the positioning holes are located in the right front corner. 
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Two positioning holes (3 mm) help you with the correct orientation of the core 
material. When the Top side of the core is facing upwards, the positioning holes 
should be located in the right front corner of the core material: 
 

 
 

 

 The dialog Placement is displayed. 
12. Place the processing data. 

The location of the layout must match the location of the core material and 
fiducials on the processing table. 

 

For detailed information on project placement according to fiducial positions refer to 
chapter 1.1. 
 

13. When project placement is complete, click on [OK]. 
 The laser system reads the fiducials on the Top side of the core material (Layer2). 

 

For detailed information on fiducial recognition refer to chapter 1.2. 

 

After fiducial recognition, the laser system starts the material thickness 
measurement and the message Thickness measurement running is displayed. 
When finished, the dialog Test tool settings is displayed. 

14. Click on [Resume]. 
 Structuring the Top side of the core material (Layer2) is started. 

The following message is displayed: 

 
Fig. 172: Message Processing phase: Press all layers 

15. Click on [Cancel] to temporarily stop the process. 
16. Remove the core material from the system. 
17. Spray the core material with LPKF Cleaner and use a brush to clean it. 
18. Rinse the core material with tap water and dry it with compressed air. 

 The core material has been structured. 
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 Assembling and pressing the multi-layer stack (with MultiPress S) 

 

For detailed information on assembling and pressing the multi-layer stack refer to 
chapter 1.6. 
 

1. Start the pre-heating process of the MultiPress S. 
2. Prepare the materials. 

 

Dry the materials in a convection oven at 100 °C (212 °F) for 30 minutes before 
assembling them in the press mold. Do not dry the prepreg material. 
 

3. Assemble the multi-layer stack in the press mold. 
4. Press the multi-layer stack. 

 The multi-layer stack has been assembled and pressed. 

 Drilling plated through holes into the multi-layer PCB (with ProtoLaser) 

1. Click on File > Open or . 

 

You can open the file also by clicking in the user guidance step New on 
[Open project…]. 
 

 The dialog Open is displayed. 
2. Select the file you previously saved. 
3. Click on [Open]. 
 The opened project is displayed in the user guidance step Processing. 
4. In the pane Workflow setup expand the entry [Top-Bot] Galvanic THP. 

 
Fig. 173: Pane Workflow setup 
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5. Right-click on Mount Material Top. 
 The following context menu is displayed: 

 
Fig. 174: Context menu Process from here 

6. Select Process from here. 
 The following message is displayed: 

 
Fig. 175: Message Processing phase: Mount material top 

7. Place the multi-layer PCB with the Top side (TopLayer) facing upwards onto the 
processing table. 
Ensure that the positioning holes are located in the right front corner. 

8. Click on . 
 The multi-layer PCB is fastened to the processing table by vacuum. 
9. Click on [OK]. 
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 The dialog Placement is displayed: 

 
Fig. 176: Dialog Placement 

10. Move the dialog Placement to get a better overview. 
11. Click on the tab Processing data. 
12. Place the processing data. The location of the layout must match the location of 

the multi-layer PCB and fiducials on the processing table. 

 

For detailed information on project placement according to fiducial positions, refer to 
chapter 1.1. 
 

13. After project placement is complete click on [OK]. 
 The laser system reads the fiducials on the Top side (TopLayer). 

 

For detailed information on fiducial recognition, refer to chapter 1.2. 

 

After fiducial recognition, the laser system starts the material thickness 
measurement. The message Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, the laser system drills the plated through holes. 
The following message is displayed: 

 
Fig. 177: Message Processing phase: Galvanic through-hole plating 

14. Click on [Cancel]. 
15. Remove the multi-layer PCB from the system. 

 The plated through holes have been drilled into the multi-layer PCB. 
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 Galvanic through-hole plating the multi-layer PCB (with Contac S4) 

1. Switch on the system. 
2. Select a profile. 

 

The recommended total copper thickness after through-hole plating is 30 µm to 
35 µm. 
 

3. Start the process. 
4. Prepare the multi-layer PCB for through-hole plating. 
5. Clean the multi-layer PCB. 
6. Condition the multi-layer PCB. 
7. Activate the multi-layer PCB. 
8. Clean the holes with LPKF ViaCleaner. 
9. Copper-plate the multi-layer PCB. 
10. Switch off the system. 

 The multi-layer PCB has been galvanically through-hole plated. 

 

For detailed information on galvanic through-hole plating, refer to the user manual of 
Contac S4. 
 

 Structuring the outer layers of the multi-layer PCB (with ProtoLaser) 

1. Open the *cp2d file you previously saved in CircuitPro PL. 
 The opened project is displayed in the user guidance step Processing. 
2. In the pane Workflow setup expand the group Processing. 
3. Right-click on the entry [Top-Bot] Bottom Side. 
4. Select Process from here in the context menu. 
5. When the message Processing phase: Mount material bottom is displayed, place 

the multi-layer PCB with the Bottom side (BottomLayer) facing upwards onto the 
processing table. 
Ensure that the positioning holes are located in the right rear corner. 

6. Click on . 
7. The multi-layer PCB is fastened to the processing table by vacuum. 

8. Click on [OK]. 
9. The following dialog is displayed: 

 
Fig. 178: Dialog Copper thickness 

10. Enter the total copper thickness after galvanic through-hole plating into the input 
field. 

 

You can determine the total copper thickness by calculating the thickness from the 
copper deposition rate in Contac S4 (approx. 0.15 μm/min). 
 

11. Click on [OK]. 
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 The dialog Placement is displayed. 
12. Move the dialog Placement to get a better overview. 
13. Click on the tab Processing data. 
14. Place the processing data. The location of the layout must match the location of 

the multi-layer PCB and fiducials on the processing table. 

 

For detailed information on project placement according to fiducial positions, refer to 
chapter 1.1. 
 

15. After project placement is complete click on [OK]. 
 The laser system reads the fiducials on the Bottom side (BottomLayer). 

 

For detailed information on fiducial recognition, refer to chapter 1.2. 

 

After fiducial recognition, the laser system starts the material thickness 
measurement. The message Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, the dialog Test tool settings is displayed. 

 

In this example, testing and setting the tools is to be skipped. 
 
For detailed information on testing and setting the tools, refer to chapter 1.5. 
 

16. Click on [Resume]. 
 Structuring the Bottom side (BottomLayer) is started. 
17. When the message Processing phase: Flip material is displayed, turn the 

multi-layer PCB over around the symmetry axis of the system and click on [OK]. 
Ensure that the positioning holes are located in the right front corner. 

 The dialog Placement is displayed. 
18. Place the processing data matching the location of the multi-layer PCB and 

fiducials on the processing table. 
19. When project placement is complete, click on [OK]. 
 The laser system reads the fiducials on the Top side (TopLayer). 

After fiducial recognition, the laser system starts the material thickness 
measurement and the message Thickness measurement running is displayed. 
When finished, the dialog Test tool settings is displayed. 

20. Click on [Resume]. 
 Structuring the Top side (TopLayer) is started. 
21. When the message Board production finished is displayed, remove the multi-layer 

PCB from the system. 
22. Spray the multi-layer PCB with LPKF Cleaner and use a brush to clean it. 
23. Rinse the multi-layer PCB with tap water and dry it with compressed air. 

 The outer layers of the multi-layer PCB have been structured. 

The multi-layer PCB production is finished. 
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3.2 How to produce a multi-layer PCB with galvanic 
through-hole plating 

This chapter describes how to create a 4-layer PCB using a laser system, a circuit 
board plotter, a multi-layer press, and a galvanic through-hole plating system. 

Ensure that the following consumables and auxiliaries are available before performing 
the described tasks: 

Consumables Auxiliaries System 
• 1 × Base material FR4 

229 mm × 305 mm × 
1 mm, 18/18 μm 
copper-clad 
(order code: 119574) 

• 2 × Thin Laminate 104 ML 
0/5 μm, 229 mm × 
305 mm × 0.2 mm with 
protection foil  
(order code: 119571) 

• 4 × Prepreg Type 2125, 
200 mm × 275 mm × 
0.1 mm  
(order code: 119572) 

• 1 set of tools for ProtoMat 
• Convection oven  

(order code: 115877) 
• LPKF Cleaner  

(order code: 115891) 
• Brush 
• Oil-free compressed air 
• Tap water 

• ProtoLaser U4/S4/R4 
• MultiPress S 
• ProtoMat S or E 
• Contac S4 

 

 

The following steps are performed in this tutorial: 

• Preparing the data in CircuitPro PM 
• Preparing the core material and laminate materials (with ProtoMat) 
• Preparing the data in CircuitPro PL 
• Structuring the core material (with ProtoLaser) 
• Assembling and pressing the multi-layer stack (with MultiPress S) 
• Drilling plated through holes into the multi-layer PCB (with ProtoMat) 
• Galvanic through-hole plating the multi-layer PCB (with Contac S4) 
• Structuring the outer layers of the multi-layer PCB (with ProtoLaser) 
• Drilling unplated through holes and cutting out the multi-layer PCB (with ProtoMat) 
 

 Preparing the data in CircuitPro PM 

 

For detailed information on preparing the data in CircuitPro PM refer to chapter 2.2. 

 

1. In the tab Templates of the dialog New document, select the template: 
PM_PL_4Layer_GalvanicTHP_MultiPressS.cbf. 

2. Click on File > Import or on . 
3. Navigate to the folder that contains the data you wish to import. The example data 

used for this tutorial are located in the folder:  
C:\Program Files (x86)\LPKF Laser & Electronics\ 

LPKF CircuitPro PM\Example Data\UseCase_Multilayer. 
4. Select the files you wish to import. In this example: 

Tutor_MultiLayer_4_Lagen.BOA, Tutor_MultiLayer_4_Lagen.BOT, 
Tutor_MultiLayer_4_Lagen.DRL, Tutor_MultiLayer_4_Lagen.LY2, 
Tutor_MultiLayer_4_Lagen.LY3 and Tutor_MultiLayer_4_Lagen.TOP. 

5. Click on [Open]. 
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 The data are automatically assigned to the correct layers and the following dialog 
is displayed: 

 
Fig. 179: Dialog Import | Assigned layers 

6. Assign the holes to the layer DrillPlated (in the Layer/Template column). 
7. Click on [OK]. 
 The imported data is displayed in the CAM view: 

 
Fig. 180: CAM view multi-layer PCB 
 

 

Multi-layer templates already include fiducials, register holes, working area frames 
etc., which are needed for precise layer assembly in the press mold. 
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8. Press and hold the  key and click on all holes that are not to be plated. 
 The selected holes are highlighted. 
9. Right-click on the layout and under Assign objects to layer select DrillUnplated. 
 An additional layer is created automatically. Holes that are not to be plated are 

assigned to the layer DrillUnplated. 
10. If desired, multiply the layout (in this example the layout is not multiplied). 

 

The layout has to be within the working area and prepreg material frame. It is 
preferable to move it to the center. 
 

11. Select the layout. 
 The layout is highlighted in gray. 
12. Click on . 
13. Using the left mouse button, drag and drop the layout to the desired location. 
 The layout has been moved. 
14. Click on Toolpath > Technology Dialog… or on . 
 The dialog Technology Dialog is displayed. 
15. Click on the tab Contour routing and select Edge gaps using the arrow buttons. 

This is usually the preferred method of contour routing. 
16. Click on the tab Pockets and deactivate the check box Process, since there are no 

pockets in this project. 
17. Click on [Start]. 
 The Computation results are displayed in a dialog. 
18. Click on [Close]. 
 The toolpaths have been calculated. 
19. Save the file. 

 The data have been prepared in CircuitPro PM. 
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 Preparing the core material and laminate materials (with ProtoMat) 

1. Load the tool magazine and assign the tools to positions. 
2. Click on Machining > Process all or on . 
3. Perform the following phases with the core material: 

− MountMaterial 
− MaterialSettings 
− Placement 

 The phases DrillFiducial and PrepareCore are performed. 
4. When the message Processing Phase: DismountMaterial is displayed, remove the 

core material from the system and click on [OK]. 
5. Rinse the core material with tap water and dry it with compressed air. 
6. Perform the following phases with the first laminate: 

− MountLaminate 
− MaterialSettings_1 
− Placement_1 

 The PrepareLaminateBottom phase is performed. 
7. When the message Processing Phase: DismountMaterial_1 is displayed, remove 

the first laminate from the system and click on [OK]. 
8. Perform the following phases with the second laminate: 

− MountLaminate_1 
− MaterialSettings_2 
− Placement_2 

 The PrepareLaminateTop phase is performed. 
9. When the message Processing Phase: ProtoLaserStructuring is displayed, 

remove the second laminate from the system and click on [Cancel] to temporarily 
stop the process. 

 The core material and laminate materials have been prepared. 

 

For detailed information on ProtoMat phases refer to the how-to guides of ProtoMat. 
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 Preparing the data in CircuitPro PL 

 

For detailed information on preparing the data in CircuitPro PL refer to chapter 2.2. 

 

1. Switch to the user guidance step New. 
2. Click on [Open project...]. 
 The dialog Open is displayed. 
3. Navigate to the folder that contains the file you previously saved in CircuitPro PM. 
4. Select CBF document (*.cbf) from the drop-down list. 
 Only .cbf files are displayed. 
5. Select the appropriate file and click on [Open]. 
 The dialog Upgrade project is displayed. 
6. Perform the following steps: 

− Select 4-layer-Multilayer from the drop-down list. 
− Select your laser system from the drop-down list (in this example PL U4). 
− Activate the check box Supported by ProtoMat. 
− Select the template 4 Layers, ProtoLaser U4, ProtoMat, galvanic through-hole 

plating, MultiPress S. 

 The dialog Upgrade project changes as follows: 

 
Fig. 181: Upgrade selected 

7. Click on [Upgrade] or double-click on the template. 
 The user guidance step Material is displayed. 
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8. Select the material LPKF 4-Layer_Galvanic. 

 
Fig. 182: Material selection 

9. Click on [Select material] or double-click on the material. 
 The layout of the opened project is displayed in the user guidance step Layout. 
10. Switch to the user guidance step Toolpaths. 

 
Fig. 183: Opened project 

11. Click on [Compute toolpaths] or on . 
 The following dialog is displayed: 

 
Fig. 184: Dialog Computing toolpaths 

12. Click on [Continue]. 
 The toolpaths are being calculated. The message Computation results is 

displayed. 
13. Check the computation results for any possible warnings or errors and make 

corrections, if needed. 
14. Click on [Close]. 
15. Save your project. 

 The data have been prepared in CircuitPro PL. 
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 Structuring the core material (with ProtoLaser) 

1. Switch to the user guidance step Processing. 

 
Fig. 185: User guidance step Processing 

2. Click on  or click on [Start production]. 
 The following message is displayed: 

 
Fig. 186: Message Processing phase: Custom instruction 

3. Click on [OK]. 
 The following message is displayed: 

 
Fig. 187: Message Processing phase: Mount core 

4. Place the core material with the Bottom side (Layer3) facing upwards in the 
center of the processing table. 
Ensure that the positioning holes are located in the right rear corner. 

5. Click on . 
 The core material is fastened onto the processing table by vacuum. 
6. Click on [OK]. 
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 The dialog Placement is displayed: 

 
Fig. 188: Dialog Placement 

7. Move the dialog Placement to get a better overview. 
8. Click on the tab Processing data. 
9. Place the processing data.  

The location of the layout must match the location of the core material and 
fiducials on the processing table. 

 

For detailed information on project placement according to fiducial positions refer to 
chapter 1.1. 
 

10. After project placement is complete click on [OK]. 
 The laser system reads the fiducials on the Bottom side of the core material 

(Layer3). 

 

For detailed information on fiducial recognition refer to chapter 1.2. 

 

After fiducial recognition, the laser system starts the material thickness 
measurement. The message Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, the dialog Test tool settings is displayed. 

 

In this example, testing and setting the tools is to be skipped. 
 
For detailed information on testing and setting the tools, refer to chapter 1.5. 
 

11. Click on [Resume]. 
 Structuring the Bottom side of the core material (Layer3) is started. 
12. When the message Processing phase: Flip material is displayed, turn the core 

material over around the symmetry axis of the system and click on [OK]. 
Ensure that the positioning holes are located in the right front corner. 

 The dialog Placement is displayed. 
13. Place the processing data matching the location of the core material and fiducials 

on the processing table. 
14. When project placement is complete, click on [OK]. 
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 The laser system reads the fiducials on the Top side of the core material (Layer2).  
After fiducial recognition, the laser system starts the material thickness 
measurement and the message Thickness measurement running is displayed. 
When finished, the dialog Test tool settings is displayed. 

15. Click on [Resume]. 
 Structuring the Top side of the core material (Layer2) is started. 

The following message is displayed: 

 
Fig. 189: Message Processing phase: Press all layers 

16. Click on [Cancel] to temporarily stop the process. 
17. Remove the core material from the system. 
18. Spray the core material with LPKF Cleaner and use a brush to clean it. 
19. Rinse the core material with tap water and dry it with compressed air. 

 The core material has been structured. 

 Assembling and pressing the multi-layer stack (with MultiPress S) 

 

For detailed information on assembling and pressing the multi-layer stack refer to 
chapter 1.6. 
 

1. Start the pre-heating process of the MultiPress S. 
2. Prepare the materials. 

 

Dry the materials in a convection oven at 100 °C (212 °F) for 30 minutes before 
assembling them in the press mold. Do not dry the prepreg material. 
 

3. Assemble the multi-layer stack in the press mold. 
4. Press the multi-layer stack. 

 The multi-layer stack has been assembled and pressed. 
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 Drilling plated through holes into the multi-layer PCB (with ProtoMat) 

1. Open the *.cbf file you previously saved in CircuitPro PM. 
2. Switch to the pane Processing. 
3. Select MountMaterialTop from the drop-down list and click on . 
 The message Processing Phase: MountMaterialTop is displayed. 
4. Place the multi-layer PCB onto the system’s processing table with the Top side 

(TopLayer) facing upwards and fasten it using adhesive tape. 
Ensure that the positioning holes are located in the right front corner. 

5. Perform the following phases: 
− MaterialSettings_3 
− Placement_3 

 The phases ReadFiducialsTop, MarkingDrills and DrillingPlated are performed. 
6. When the message Processing Phase: ThroughHolePlating is displayed, remove 

the multi-layer PCB from the system and click on [Cancel] to temporarily stop the 
process. 

 The plated through holes have been drilled into the multi-layer PCB. 

 

For detailed information on ProtoMat phases refer to the how-to guides of ProtoMat. 

 

 Galvanic through-hole plating the multi-layer PCB (with Contac S4) 

1. Switch on the system. 
2. Select a profile. 

 

The recommended total copper thickness after through-hole plating is 30 µm to 
35 µm. 
 

3. Start the process. 
4. Prepare the multi-layer PCB for through-hole plating. 
5. Clean the multi-layer PCB. 
6. Condition the multi-layer PCB. 
7. Activate the multi-layer PCB. 
8. Clean the holes with LPKF ViaCleaner. 
9. Copper-plate the multi-layer PCB. 
10. Switch off the system. 

 The multi-layer PCB has been galvanically through-hole plated. 

 

For detailed information on galvanic through-hole plating, refer to the user manual of 
Contac S4. 
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 Structuring the outer layers of the multi-layer PCB (with ProtoLaser) 

1. Open the *cp2d file you previously saved in CircuitPro PL. 
 The opened project is displayed in the user guidance step Layout. 
2. Switch to the user guidance step Processing. 
3. In the pane Workflow setup expand the group Processing. 
4. Right-click on [Top-Bot] Bottom Side and select Process from here. 

 
Fig. 190: Context menu Process from here 

5. When the message Processing phase: Mount material bottom is displayed, place 
the multi-layer PCB with the Bottom side (BottomLayer) facing upwards onto the 
processing table. 
Ensure that the positioning holes are located in the right rear corner. 

6. Click on . 
 The multi-layer PCB is fastened to the processing table by vacuum. 
7. Click on [OK]. 
 The following dialog is displayed: 

 
Fig. 191: Dialog Copper thickness 
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8. Enter the total copper thickness after galvanic through-hole plating into the input 
field. 

 

You can determine the total copper thickness by performing one of the following 
steps: 

− Calculate the copper thickness from the copper deposition rate in Contac S4 
(approx. 0.15 μm/min).  

− Measure the copper thickness with the ProtoMat S104. 

 

9. Click on [OK]. 
 The dialog Placement is displayed. 
10. Move the dialog Placement to get a better overview. 
11. Click on the tab Processing data. 
12. Place the processing data. The location of the layout must match the location of 

the multi-layer PCB and fiducials on the processing table. 

 

For detailed information on project placement according to fiducial positions, refer to 
chapter 1.1. 
 

13. After project placement is complete click on [OK]. 
 The laser system reads the fiducials on the Bottom side (BottomLayer). 

 

For detailed information on fiducial recognition, refer to chapter 1.2. 

 

After fiducial recognition, the laser system starts the material thickness 
measurement. The message Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, the dialog Test tool settings is displayed. 

 

In this example, testing and setting the tools is to be skipped. 
 
For detailed information on testing and setting the tools, refer to chapter 1.5. 
 

14. Click on [Resume]. 
 Structuring the Bottom side (BottomLayer) is started. 
15. When the message Processing phase: Flip material is displayed, turn the 

multi-layer PCB over around the symmetry axis of the system and click on [OK]. 
Ensure that the positioning holes are located in the right front corner. 

 The dialog Placement is displayed. 
16. Place the processing data matching the location of the multi-layer PCB and 

fiducials on the processing table. 
17. When project placement is complete, click on [OK]. 
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 The laser system reads the fiducials on the Top side (TopLayer). 
After fiducial recognition, the laser system starts the material thickness 
measurement and the message Thickness measurement running is displayed. 
When finished, the dialog Test tool settings is displayed. 

18. Click on [Resume]. 
 Structuring the Top side (TopLayer) is started. 

The following message is displayed: 

 
Fig. 192: Message Processing phase: Process drilling on a ProtoMat 

19. Click on [Cancel]. 
20. Remove the multi-layer PCB from the system. 
21. Spray the multi-layer PCB with LPKF Cleaner and use a brush to clean it. 
22. Rinse the multi-layer PCB with tap water and dry it with compressed air. 

 The outer layers of the multi-layer PCB have been structured. 

 Drilling unplated through holes and cutting out the multi-layer PCB 
(with ProtoMat) 

1. Open the *.cbf file you previously saved in CircuitPro PM. 
2. Switch to the pane Processing. 
3. Select MountMaterialTop_1 from the drop-down list and click on . 
 The message Processing Phase: MountMaterialTop_1 is displayed. 
4. Place the multi-layer PCB onto the system’s processing table with the Top side 

(TopLayer) facing upwards and fasten it using adhesive tape. 
Ensure that the positioning holes are located in the right front corner. 

5. Perform the following phases: 
− MaterialSettings_4 

− Placement_4 

 The phases ReadFiducialsTop_1, DrillingUnplated and ContourRouting are 
performed. 

6. When the message Process finished is displayed, remove the multi-layer PCB 
from the system. 

 The unplated through holes have been drilled and the multi-layer PCB has been 
cut out. 

 

For detailed information on ProtoMat phases refer to the how-to guides of ProtoMat. 

 

 

The multi-layer PCB production is finished. 
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3.3 How to produce a multi-layer PCB with non-galvanic 
through-hole plating 

This chapter describes how to create a 4-layer PCB using a laser system, a circuit 
board plotter, a multi-layer press, and a non-galvanic through-hole plating system. 

Ensure that the following consumables and auxiliaries are available before performing 
the described tasks: 

Consumables Auxiliaries System 
• 1 × Base material FR4 

229 mm × 305 mm × 
1 mm, 18/18 μm 
copper-clad 
(order code: 119574) 

• 2 × Thin Laminate 104 ML 
0/18 μm, 229 mm × 
305 mm × 0.2 mm 
(order code: 119818) 

• 4 × Prepreg Type 2125, 
200 mm × 275 mm × 
0.1 mm  
(order code: 119572) 

• 1 set of tools for ProtoMat 
• Convection oven  

(order code: 115877) 
• LPKF Cleaner  

(order code: 115891) 
• Brush 
• Oil-free compressed air 
• Tap water 

• ProtoLaser U4/S4/R4 
• MultiPress S 
• ProtoMat S or E 
• ProConduct 

 

 

The following steps are performed in this tutorial: 

• Preparing the data in CircuitPro PM 
• Preparing the core material and laminate materials (with ProtoMat) 
• Preparing the data in CircuitPro PL 
• Structuring the core material (with ProtoLaser) 
• Assembling and pressing the multi-layer stack (with MultiPress S) 
• Structuring the outer layers of the multi-layer PCB (with ProtoLaser) 
• Drilling unplated through holes and cutting out the multi-layer PCB (with ProtoMat) 
• Drilling plated through holes into the multi-layer PCB (with ProtoMat) 
• Plating through holes (with ProConduct) 

 

 Preparing the data in CircuitPro PM 

 

For detailed information on preparing the data in CircuitPro PM refer to chapter 2.2. 

 

1. In the tab Templates of the dialog New document, select the template: 
PM_PL_4Layer_ProConduct_MultiPressS.cbf. 

2. Click on File > Import or on . 
3. Navigate to the folder that contains the data you wish to import. The example data 

used for this tutorial are located in the folder:  
C:\Program Files (x86)\LPKF Laser & Electronics\ 

LPKF CircuitPro PM\Example Data\UseCase_Multilayer. 
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4. Select the files you wish to import. In this example: 
Tutor_MultiLayer_4_Lagen.BOA, Tutor_MultiLayer_4_Lagen.BOT, 
Tutor_MultiLayer_4_Lagen.DRL, Tutor_MultiLayer_4_Lagen.LY2, 
Tutor_MultiLayer_4_Lagen.LY3 and Tutor_MultiLayer_4_Lagen.TOP. 

5. Click on [Open]. 
 The data are automatically assigned to the correct layers and the following dialog 

is displayed: 

 
Fig. 193: Dialog Import | Assigned layers 

6. Assign the holes to the layer DrillPlated (in the Layer/Template column). 
7. Click on [OK]. 
 The imported data is displayed in the CAM view: 

 
Fig. 194: CAM view multi-layer PCB 
 

 

Multi-layer templates already include fiducials, register holes, working area frames 
etc., which are needed for precise layer assembly in the press mold. 
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8. Press and hold the  key and click on all holes that are not to be plated. 
 The selected holes are highlighted. 
9. Right-click on the layout and under Assign objects to layer select DrillUnplated. 
 An additional layer is created automatically. Holes that are not to be plated are 

assigned to the layer DrillUnplated. 
10. If desired, multiply the layout (in this example the layout is not multiplied). 

 

The layout has to be within the multi-layer working area and prepreg material frame. It 
is preferable to move it to the center. 
 

11. Select the layout. 
 The layout is highlighted in gray. 
12. Click on . 
13. Using the left mouse button, drag and drop the layout to the desired location. 
 The layout has been moved. 
14. Click on Toolpath > Technology Dialog… or on . 
 The dialog Technology Dialog is displayed. 
15. Click on the tab Contour routing and select Edge gaps using the arrow buttons. 

This is usually the preferred method of contour routing. 
16. Click on the tab Pockets and deactivate the check box Process, since there are no 

pockets in this project. 
17. Click on [Start]. 
 The Computation results are displayed in a dialog. 
18. Click on [Close]. 
 The toolpaths have been calculated. 
19. Save the file. 

 The data have been prepared in CircuitPro PM. 
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 Preparing the core material and laminate materials (with ProtoMat) 

1. Load the tool magazine and assign the tools to positions. 
2. Click on Machining > Process all or on . 
3. Perform the following phases with the core material: 

− MountMaterial 
− MaterialSettings 
− Placement 

 The phases DrillFiducial and PrepareCore are performed. 
4. When the message Processing Phase: DismountMaterial is displayed, remove the 

core material from the system and click on [OK]. 
5. Rinse the core material with tap water and dry it with compressed air. 
6. Perform the following phases with the first laminate: 

− MountLaminate 
− MaterialSettings_1 
− Placement_1 

 The PrepareLaminateBottom phase is performed. 
7. When the message Processing Phase: DismountMaterial_1 is displayed, remove 

the first laminate from the system and click on [OK]. 
8. Perform the following phases with the second laminate: 

− MountLaminate_1 
− MaterialSettings_2 
− Placement_2 

 The PrepareLaminateTop phase is performed. 
9. When the message Processing Phase: ProtoLaserStructuring is displayed, 

remove the second laminate from the system and click on [Cancel] to temporarily 
stop the process. 

 The core material and laminate materials have been prepared. 

 

For detailed information on ProtoMat phases refer to the how-to guides of ProtoMat. 
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 Preparing the data in CircuitPro PL 

 

For detailed information on preparing the data in CircuitPro PL refer to chapter 2.2. 

 

1. Switch to the user guidance step New. 
2. Click on [Open project...]. 
 The dialog Open is displayed. 
3. Navigate to the folder that contains the file you previously saved in CircuitPro PM. 
4. Select CBF document (*.cbf) from the drop-down list. 
 Only .cbf files are displayed. 
5. Select the appropriate file and click on [Open]. 
 The dialog Upgrade project is displayed. 
6. Perform the following steps: 

− Select 4-layer-Multilayer from the drop-down list. 
− Select your laser system from the drop-down list (in this example PL S4). 
− Activate the check box Supported by ProtoMat. 
− Select the template 4 Layers, ProtoLaser S4, ProtoMat, ProConduct, 

MultiPress S. 

 The dialog Upgrade project changes as follows: 

 
Fig. 195: Upgrade selected 

7. Click on [Upgrade] or double-click on the template. 
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 The user guidance step Material is displayed. 
8. Select the material LPKF 4-Layer_ProConduct. 

 
Fig. 196: Material selection 

9. Click on [Select material] or double-click on the material. 
 The layout of the opened project is displayed in the user guidance step Layout. 
10. Switch to the user guidance step Toolpaths. 
11. Click on [Compute toolpaths] or on . 
 The dialog Computing toolpaths is displayed: 
12. Click on [Continue]. 
 The toolpaths are being calculated. The message Computation results is 

displayed. 
13. Check the computation results for any possible warnings or errors and make 

corrections, if needed. 
14. Click on [Close]. 
15. Save your project. 

 The data have been prepared in CircuitPro PL. 

 Structuring the core material (with ProtoLaser) 

1. Switch to the user guidance step Processing. 

 
Fig. 197: User guidance step Processing 

2. Click on  or click on [Start production]. 
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 The following message is displayed: 

 
Fig. 198: Message Processing phase: Custom instruction 

3. Click on [OK]. 
 The following message is displayed: 

 
Fig. 199: Message Processing phase: Mount core 

4. Place the core material with the Bottom side (Layer3) facing upwards in the 
center of the processing table. 
Ensure that the positioning holes are located in the right rear corner. 

5. Click on . 
 The core material is fastened onto the processing table by vacuum. 
6. Click on [OK]. 
 The dialog Placement is displayed: 

 
Fig. 200: Dialog Placement 

7. Move the dialog Placement to get a better overview. 
8. Click on the tab Processing data. 
9. Place the processing data.  

The location of the layout must match the location of the core material and 
fiducials on the processing table. 

 

For detailed information on project placement according to fiducial positions refer to 
chapter 1.1. 
 

10. After project placement is complete click on [OK]. 
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 The laser system reads the fiducials on the Bottom side of the core material 
(Layer3). 

 

For detailed information on fiducial recognition refer to chapter 1.2. 

 

After fiducial recognition, the laser system starts the material thickness 
measurement. The message Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.5. 

 

When finished, the dialog Test tool settings is displayed. 

 

In this example, testing and setting the tools is to be skipped. 
 
For detailed information on testing and setting the tools, refer to chapter . 
 

11. Click on [Resume]. 
 Structuring the Bottom side of the core material (Layer3) is started. 
12. When the message Processing phase: Flip material is displayed, turn the core 

material over around the symmetry axis of the system and click on [OK]. 
Ensure that the positioning holes are located in the right front corner. 

 The dialog Placement is displayed. 
13. Place the processing data matching the location of the core material and fiducials 

on the processing table. 
14. When project placement is complete, click on [OK]. 
 The laser system reads the fiducials on the Top side of the core material (Layer2).  

After fiducial recognition, the laser system starts the material thickness 
measurement and the message Thickness measurement running is displayed. 
When finished, the dialog Test tool settings is displayed. 

15. Click on [Resume]. 
 Structuring the Top side of the core material (Layer2) is started. 

The following message is displayed: 

 
Fig. 201: Message Processing phase: Press all layers 

16. Click on [Cancel] to temporarily stop the process. 
17. Remove the core material from the system. 
18. Spray the core material with LPKF Cleaner and use a brush to clean it. 
19. Rinse the core material with tap water and dry it with compressed air. 

 The core material has been structured. 
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 Assembling and pressing the multi-layer stack (with MultiPress S) 

 

For detailed information on assembling and pressing the multi-layer stack refer to 
chapter 1.6. 
 

1. Start the pre-heating process of the MultiPress S. 
2. Prepare the materials. 

 

Dry the materials in a convection oven at 100 °C (212 °F) for 30 minutes before 
assembling them in the press mold. Do not dry the prepreg material. 
 

3. Assemble the multi-layer stack in the press mold. 
4. Press the multi-layer stack. 

 The multi-layer stack has been assembled and pressed. 

 Structuring the outer layers of the multi-layer PCB (with ProtoLaser) 

1. Open the *cp2d file you previously saved in CircuitPro PL. 
 The opened project is displayed in the user guidance step Layout. 
2. Switch to the user guidance step Processing. 
3. In the pane Workflow setup expand the group Processing. 
4. Right-click on [Top-Bot] Bottom Side and select Process from here. 

 
Fig. 202: Context menu Process from here 

5. When the message Processing phase: Mount material bottom is displayed, place 
the multi-layer PCB with the Bottom side (BottomLayer) facing upwards onto the 
processing table. 
Ensure that the positioning holes are located in the right rear corner. 

6. Click on . 
 The multi-layer PCB is fastened to the processing table by vacuum. 
7. Click on [OK]. 
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 The dialog Placement is displayed. 
8. Move the dialog Placement to get a better overview. 
9. Click on the tab Processing data. 
10. Place the processing data. The location of the layout must match the location of 

the multi-layer PCB and fiducials on the processing table. 

 

For detailed information on project placement according to fiducial positions, refer to 
chapter 1.1. 
 

11. After project placement is complete click on [OK]. 
 The laser system reads the fiducials on the Bottom side (BottomLayer). 

 

For detailed information on fiducial recognition, refer to chapter 1.2. 

 

After fiducial recognition, the laser system starts the material thickness 
measurement. The message Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, the dialog Test tool settings is displayed. 

 

In this example, testing and setting the tools is to be skipped. 
 
For detailed information on testing and setting the tools, refer to chapter 1.5. 
 

12. Click on [Resume]. 
 Structuring the Bottom side (BottomLayer) is started. 
13. When the message Processing phase: Flip material is displayed, turn the 

multi-layer PCB over around the symmetry axis of the system and click on [OK]. 
Ensure that the positioning holes are located in the right front corner. 

 The dialog Placement is displayed. 
14. Place the processing data matching the location of the multi-layer PCB and 

fiducials on the processing table. 
15. When project placement is complete, click on [OK]. 
 The laser system reads the fiducials on the Top side (TopLayer). 

After fiducial recognition, the laser system starts the material thickness 
measurement and the message Thickness measurement running is displayed. 
When finished, the dialog Test tool settings is displayed. 

16. Click on [Resume]. 
 Structuring the Top side (TopLayer) is started. 

The message Processing phase: Process drilling on a ProtoMat is displayed. 
17. Click on [Cancel]. 
18. Remove the multi-layer PCB from the system. 
19. Spray the multi-layer PCB with LPKF Cleaner and use a brush to clean it. 
20. Rinse the multi-layer PCB with tap water and dry it with compressed air. 

 The outer layers of the multi-layer PCB have been structured. 
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 Drilling unplated through holes and cutting out the multi-layer PCB (with 
ProtoMat) 

1. Open the *.cbf file you previously saved in CircuitPro PM. 
2. Switch to the pane Processing. 
3. Select MountMaterialTop from the drop-down list and click on . 
 The message Processing Phase: MountMaterialTop is displayed. 
4. Place the multi-layer PCB onto the system’s processing table with the Top side 

(TopLayer) facing upwards and fasten it using adhesive tape. 
Ensure that the positioning holes are located in the right front corner. 

5. Perform the following phases: 
− MaterialSettings_3 

− Placement_3 

 The phases ReadFiducialsTop, MarkingDrills, DrillingUnplated and 
ContourRouting are performed. 

6. When the message Processing Phase: DismountMaterial_2 is displayed, remove 
the multi-layer PCB from the system and click on [OK]. 

7. Rinse the multi-layer PCB with tap water and dry it using compressed air. 

 The unplated through holes have been drilled and the multi-layer PCB has been 
cut out. 

 

The multi-layer PCB must remain attached to the original material. Do not break 
or cut the breakout tabs yet. 
 

 Drilling plated through holes into the multi-layer PCB (with ProtoMat) 

1. When the message Processing Phase: ApplyProtectionFilm is displayed, apply the 
protective film onto both sides of the multi-layer PCB and click on [OK]. 

 The message Processing Phase: MountMaterialTop_1 is displayed. 
2. Place the multi-layer PCB with the Top side (TopLayer) facing upwards onto the 

system’s processing table, fasten it with adhesive tape and click on [OK]. 
Ensure that the positioning holes are located in the right front corner. 

3. Perform the Placement_4 phase. 
 The phases ReadFiducialsTop_1 and DrillingPlated are performed. 
4. When the message Processing Phase: DismountMaterial_3 is displayed, remove 

the multi-layer PCB from the system and check it for burrs and residual material 
within the holes. 

 

Check whether the fiducials are covered by the protective film and expose them if 
necessary. 
 

 The plated through holes have been drilled into the multi-layer PCB. 
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 Plating through holes (with ProConduct) 

1. Place the mat onto the vacuum table (ProtoMat mounted or standalone). 
2. Place the multi-layer PCB onto the mat. 
3. Apply the ProConduct paste along the edge of the multi-layer PCB. 
4. Spread the paste on the whole surface of the multi-layer PCB (do not spread over 

the fiducials). 
5. Turn on the extraction system on the highest setting and wait for at least 

30 seconds. 
6. Spread the paste remaining on the multi-layer PCB surface with the vacuum 

turned on. 
7. Switch off the extraction system. 
8. Turn the multi-layer PCB over and repeat the steps 1 to 7 on the other side. 
9. Slowly peel off the protective film at an angle of 90° from both sides of the multi-

layer PCB. 
10. Place the multi-layer PCB horizontally into the convection oven for 30 minutes 

(160 °C / 320 °F). 
11. Remove the multi-layer PCB and let it cool down to ambient temperature. 
12. Spray the multi-layer PCB with LPKF Cleaner and use a brush to clean the 

multi-layer PCB. 
13. Rinse the multi-layer PCB with tap water and dry it with compressed air. 
14. Cut out or break out the multi-layer PCB from the board. 

 The through holes have been plated. 

 

For detailed information on non-galvanic through-hole plating refer to the process 
description of ProConduct. 
 

 

The multi-layer PCB production is finished. 
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3.4 How to produce a multi-layer PCB with blind vias and buried 
vias 

This chapter describes how to create a 4-layer PCB with blind vias and buried vias 
using a laser system, a circuit board plotter, a multi-layer press, and a galvanic 
through-hole plating system. 

Ensure that the following consumables and auxiliaries are available before performing 
the described tasks: 

Consumables Auxiliaries System 
• 1 × Base material IS400 

235 mm × 305 mm × 
0.46 mm, 18/18 μm 
copper-clad 
(order code 10092752) 

• 2 × Copper foil 0/5 μm, 
212 mm × 282 mm × 
0.2 mm with carrier foil  
(order code 10097444) 

• 2 × Prepreg IS400, type 
1080, 205 mm × 275 mm 
× 0.1 mm  
(order code 10092750) 

• 1 set of tools for ProtoMat 
• Spiral Drill Blind via for 

ProtoMat 1/8″, 38 mm, 
d = 0.20 mm  
(order code 10099689) 

• Convection oven  
(order code 115877) 

• LPKF Cleaner  
(order code 115891) 

• Brush 
• Portable hand-held 

microscope 
• Oil-free compressed air 
• Tap water 

• ProtoLaser U4/S4/R4 
• MultiPress S 
• ProtoMat S or E 
• Contac S4 

 

 

 

 

The copper foil consists of a copper layer and the carrier foil that is attached to the 
copper layer. The side with the copper layer has a darker color tone, the side with the 
carrier foil has a lighter color tone. It is important to know the difference of both sides. 
The following figure shows both sides of the copper foil. 
 

 
1 Copper layer  2 Carrier foil 

  

 

 

The following steps are performed in this tutorial: 

• Preparing the data in CircuitPro PM 
• Drilling buried vias into the core material (with ProtoMat) 
• Galvanic through-hole plating the core material (with Contac S4) 
• Preparing the data in CircuitPro PL 
• Structuring the core material (with ProtoLaser) 
• Assembling and pressing the multi-layer stack (with MultiPress S) 
• Drilling plated through holes into the multi-layer PCB (with ProtoMat) 
• Drilling blind vias into the multi-layer PCB (with ProtoLaser) 
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• Galvanic through-hole plating the multi-layer PCB (with Contac S4) 
• Structuring the outer layers of the multi-layer PCB (with ProtoLaser) 
• Drilling unplated through holes and cutting out the multi-layer PCB (with ProtoMat) 

 

 

It is essential that you read the design guidelines described in chapter 1.8 before 
starting this tutorial. 
 

 

 Preparing the data in CircuitPro PM 

 

For detailed information on preparing the data in CircuitPro PM refer to chapter 2.2. 

 

1. In the tab Templates of the dialog New document, select the template: 
PM_PL_4Layer_GalvanicTHP_MultiPressS_Blind (IS400).cbf. 

2. Click on File > Import or on . 
3. Navigate to the folder that contains the data you want to import. 
4. Select the files you want to import and click on [Open]. 

 

If you are not sure which files to select, then select all of them. You will see the 
preview of the files later and you can deselect those you do not need. 
 

 The following dialog is displayed: 

 
Fig. 203: Dialog Import | Assigned layers 

5. Assign the data to the corresponding layers (in the Layer/Template column). Pay 
special attention to correct assignment of drill files, since multiple drill layers are 
used in this process. 

 

If the drop-down lists in the Layer/Template column cannot be activated, proceed as 
follows: 

− Click on the sub-tab Options (on the right side of the dialog Import). 
− Deactivate Use layer name. 
− Activate Apply to all Gerber files. 

 

6. Click on [OK]. 
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 The imported data are displayed in the CAM view: 

 
Fig. 204: CAM view multi-layer PCB with blind vias and buried vias 

7. If desired, multiply the layout (in this example the layout is not multiplied). 
8. Select the layout. 
 The layout is highlighted in gray. 
9. Click on . 
10. Keep the left mouse button pressed to drag and drop the layout to the desired 

location. 
 The layout has been moved. 
11. Click on Toolpath > Technology Dialog… or on . 
 The dialog Technology Dialog is displayed. 
12. Click on [Start]. 
 The Computation results are displayed in a dialog. 
13. Click on [Close]. 
 The toolpaths have been calculated. 
14. Save the file. 

 The data have been prepared in CircuitPro PM. 
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 Drilling buried vias into the core material (with ProtoMat) 

1. Load the tool magazine and assign the tools to positions. 
2. Click on Machining > Process all or on . 
3. Perform the following phases with the core material: 

− MountCore 

− MaterialSettings 
− Placement 

 The phases DrillFiducial, PrepareCore, Marking DrillBuriedVias (L2-L3) and 
DrillBuriedVias (L2-L3) are performed. 

4. When the message Processing Phase: ThroughHolePlating_1 is displayed, 
remove the core material from the system and click on [Cancel] to temporarily stop 
the process. 

 The buried vias have been drilled into the core material. 

 

For detailed information on ProtoMat phases refer to the how-to guides of ProtoMat. 

 

 Galvanic through-hole plating the core material (with Contac S4) 

 

During and after galvanic plating, handle the core material with care. The core 
material is thin and cracks in the copper barrels can occur, if it is bent too much. 
 

1. Switch on the system. 
2. Select a profile. 

 

The recommended total copper thickness after through-hole plating is 30 µm to 
35 µm. 
 

3. Start the process. 
4. Prepare the core material for through-hole plating. 
5. Clean the core material. 
6. Condition the core material. 
7. Activate the core material. 
8. Clean the holes with LPKF ViaCleaner. 
9. Copper-plate the core material. 
10. Switch off the system. 

 The core material has been galvanically through-hole plated. 

 

For detailed information on galvanic through-hole plating, refer to the user manual of 
Contac S4. 
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 Preparing the data in CircuitPro PL 

 

For detailed information on preparing the data in CircuitPro PL refer to chapter 2.2. 

 

1. Switch to the user guidance step New. 
2. Click on [Open project...]. 
 The dialog Open is displayed. 
3. Navigate to the folder that contains the file you previously saved in CircuitPro PM. 
4. Select CBF document (*.cbf) from the drop-down list. 
 Only .cbf files are displayed. 
5. Select the appropriate file and click on [Open]. 
 The dialog Upgrade project is displayed. 
6. Perform the following steps: 

− Select 4-layer-Multilayer from the drop-down list. 
− Select your laser system from the drop-down list (in this example PL U4). 
− Activate the check box Supported by ProtoMat. 
− Select the template 4 Layers, ProtoLaser U4, ProtoMat, galvanic through-hole 

plating, MultiPress S, blind-buried vias (IS400). 

 The dialog Upgrade project changes as follows: 

 
Fig. 205: Upgrade selected 

7. Click on [Upgrade] or double-click on the template. 
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 The user guidance step Material is displayed. 
8. Select the material LPKF 4-Layer_Galvanic_Blind-Buried vias_IS400. 

 
Fig. 206: Material selection 

9. Click on [Select material] or double-click on the material. 
 The layout of the opened project is displayed in the user guidance step Layout. 
10. Switch to the user guidance step Toolpaths. 

 
Fig. 207: Opened project 

11. Click on [Compute toolpaths] or on . 
 The following dialog is displayed: 

 
Fig. 208: Dialog Computing toolpaths 

12. Click on [Continue]. 
 The toolpaths are being calculated. The message Computation results is 

displayed. 
13. Check the computation results for any possible warnings or errors and make 

corrections, if needed. 
14. Click on [Close]. 
15. Save your project. 

 The data have been prepared in CircuitPro PL. 
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 Structuring the core material (with ProtoLaser) 

1. Switch to the user guidance step Processing. 

 
Fig. 209: User guidance step Processing 

2. Click on  or click on [Start production]. 
 The following message is displayed: 

 
Fig. 210: Message Processing phase: Custom instruction 

3. Click on [OK]. 
 When the message Processing phase: Galvanic through-hole plating is displayed, 

click on [OK]. 
 When the message Processing phase: Mount material bottom is displayed, place 

the core material with the Bottom side (Layer3) facing upwards in the center of 
the processing table. 
Ensure that the positioning holes are located in the right rear corner. 

4. Click on . 
 The core material is fastened onto the processing table by vacuum. 
5. Click on [OK]. 
 The following dialog is displayed: 

 
Fig. 211: Dialog Copper thickness 
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6. Enter the total copper thickness after galvanic through-hole plating into the input 
field. 

 

You can determine the total copper thickness by performing one of the following 
steps: 

− Calculate the copper thickness from the copper deposition rate in Contac S4 
(approx. 0.15 μm/min). 

− Measure the thickness with the ProtoMat S104. 

 

7. Click on [OK]. 
 The dialog Placement is displayed: 

 
Fig. 212: Dialog Placement 

8. Move the dialog Placement to get a better overview. 
9. Click on the tab Processing data. 
10. Place the processing data.  

The location of the layout must match the location of the core material and 
fiducials on the processing table. 

 

For detailed information on project placement according to fiducial positions refer to 
chapter 1.1. 
 

11. After project placement is complete, click on [OK]. 
 The laser system reads the fiducials on the Bottom side of the core material 

(Layer3). 

 

For detailed information on fiducial recognition refer to chapter 1.2. 

 

After fiducial recognition, the laser system starts the material thickness 
measurement. The message Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, the dialog Test tool settings is displayed. 

 

In this example, testing and setting the tools is to be skipped. 
 
For detailed information on testing and setting the tools, refer to chapter 1.5. 
 

12. Click on [Resume]. 
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 Structuring the Bottom side of the core material (Layer3) is started. 
13. When the message Processing phase: Flip material is displayed, turn the core 

material over around the symmetry axis of the system and click on [OK]. 
Ensure that the positioning holes are located in the right front corner. 

 The dialog Placement is displayed. 
14. Place the processing data matching the location of the core material and fiducials 

on the processing table. 
15. When project placement is complete, click on [OK]. 
 The laser system reads the fiducials on the Top side of the core material (Layer2). 

After fiducial recognition, the laser system starts the material thickness 
measurement and the message Thickness measurement running is displayed. 
When finished, the dialog Test tool settings is displayed. 

16. Click on [Resume]. 
 Structuring the Top side of the core material (Layer2) is started. 

The following message is displayed: 

 
Fig. 213: Message Processing phase: Press all layers 

17. Click on [Cancel] to temporarily stop the process. 
18. Remove the core material from the system. 
19. Spray the core material with LPKF Cleaner and use a brush to clean it. 
20. Rinse the core material with tap water and dry it with compressed air. 

 The core material has been structured. 
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 Assembling and pressing the multi-layer stack (with MultiPress S) 

 

For detailed information on assembling and pressing the multi-layer stack refer to 
chapter 1.6. 
 

 

The materials are assembled in the press mold according to the following figure: 

 
Fig. 214: Assembly of the materials in the press mold 
 

 

Two outer positioning markers (1) and two inner positioning markers (2) on the core 
material help you with the correct positioning of materials during the assembly in the 
press mold. 

 
Fig. 215: Positioning markers core material   

1 Outer positioning marker (for copper foil)  2 Inner positioning marker (for prepreg 
material) 

 

 

1 

2 

2 

1 
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1. Start the pre-heating process of the MultiPress S. 
2. Prepare the materials. 

 

Dry the materials in a convection oven at 100 °C (212 °F) for 30 minutes before 
assembling them in the press mold. Do not dry the prepreg material. 
 

3. Assemble the lower part of the aluminum press mold, the press cushion and the 
steel press sheet. 

4. Place the copper foil with the carrier foil downwards at the center of the steel 
press sheet. 

 
Fig. 216: Copper foil on the lower steel press sheet 
 

 

The copper foil is extremely thin and needs to be handled with care! 

 

5. Place the prepreg material at the center of the copper foil. 

 
Fig. 217: Prepreg material on the copper foil 
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6. Place the core material on the dowel pins of the press mold. 

 
Fig. 218: Core material on the dowel pins 

7. Place the prepreg material on the core material. 
Align it with the inner positioning markers (2). 

 
Fig. 219: Prepreg material on the core material 
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8. Place the copper foil on the prepreg material. 
Align it with the outer positioning markers (1). 

 
Fig. 220: Copper foil on the prepreg material 
 

 

The copper foil is extremely thin and needs to be handled with care! 

 

9. Assemble the steel press sheet, the press cushion and the upper part of the 
aluminum press mold. 

10. Select the profile IS400 (available in the firmware version 1.12). 
11. Press the multi-layer stack. 

 The multi-layer stack has been assembled and pressed. 

  

 
Using sealing rings to assemble the multi-layer stack 

You do not need to use sealing rings when producing a 4-layer PCB with blind vias 
and buried vias. 
 
When producing a 6-layer or an 8-layer PCB with blind vias and buried vias, you 
need to use two sealing rings wherever 2 sheets of material are used  
together – e.g. between two core materials (see page 56). 
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 Drilling plated through holes into the multi-layer PCB (with ProtoMat) 

 

Do not remove the carrier foil from the top and from the bottom of the multi-layer PCB 
yet! 
 

1. Open the *.cbf file you previously saved in CircuitPro PM. 
2. Switch to the pane Processing. 
3. Select MountMaterialBottom from the drop-down list and click on . 
 The message Processing Phase: MountMaterialBottom is displayed. 
4. Place the multi-layer PCB onto the system’s processing table with the Bottom 

side (BottomLayer) facing upwards and fasten it using adhesive tape. 
Ensure that the positioning holes are located in the right rear corner. 

5. Perform the following phases: 
− MaterialSettings_1 
− Placement_2 

 The phases ReadFiducialsBottom, MarkingDrillPlated and DrillingPlated are 
performed. 

6. When the message Processing Phase: ProtoLaserBlindViaDrilling is displayed, 
remove the multi-layer PCB from the system and click on [Cancel] to temporarily 
stop the process. 

7. Rinse the multi-layer PCB with tap water and dry it with compressed air. 

 The plated through holes have been drilled into the multi-layer PCB. 

 

For detailed information on ProtoMat phases refer to the how-to guides of ProtoMat. 
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 Drilling blind vias into the multi-layer PCB (with ProtoLaser) 

1. Click on File > Open or . 
 The dialog Open is displayed. 
2. Select the file you previously saved in CircuitPro PL. 
3. Click on [Open]. 
 The opened project is displayed in the user guidance step Processing. 
4. In the pane Workflow setup expand [Top-Bot] Drilling Bottom. 

 
Fig. 221: Pane Workflow setup 

5. Right-click on Mount Material Bottom. 
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 The following context menu is displayed: 

 
Fig. 222: Context menu Process from here 

6. Select Process from here. 
 When the message Processing phase: Mount material bottom is displayed, place 

the multi-layer PCB with the Bottom side (TopLayer) facing upwards onto the 
processing table. 
Ensure that the positioning holes are located in the right rear corner. 

7. Click on . 
 The multi-layer PCB is fastened to the processing table by vacuum. 
8. Click on [OK]. 
 The dialog Placement is displayed. 
9. Move the dialog Placement to get a better overview. 
10. Click on the tab Processing data. 
11. Place the processing data. The location of the layout must match the location of 

the multi-layer PCB and fiducials on the processing table. 

 

For detailed information on project placement according to fiducial positions, refer to 
chapter 1.1. 
 

12. After project placement is complete click on [OK]. 
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 The laser system reads the fiducials on the Bottom side (BottomLayer). 

 

For detailed information on fiducial recognition, refer to chapter 1.2. 

 

After fiducial recognition, the laser system starts the material thickness 
measurement. The message Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, the following dialog is displayed: 

 
Fig. 223: Dialog Test tool settings 

 

It is recommended that you process the blind via test sample on your multi-layer 
PCB before you continue with production. 
 

13. Select Place and process “Drill Blind Via test sample 5x5 mm”. 

 

For detailed information on placing and processing the test sample, refer to 
chapter 1.5. 
 

14. Check the created test sample with a portable hand-held microscope. 
15. Select a blind via on the test sample. This should have the same diameters as the 

blind vias of your future project. 
For the diameters of blind vias on the test sample see page 183. 

16. Use the following conditions to determine whether the processing quality is 
satisfactory: 
− The blind via has reached the target copper layer. 
− The copper surface at the bottom of the blind via is clean (e.g., free of epoxy 

resin remains) and is not punctured. 
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 The following figure shows a blind via of good quality: 

 
Fig. 224: Blind via of good quality under the microscope 
1 Bottom of blind via (in this example Layer3)  2 Bottom side of the multi-layer PCB  

(in this example BottomLayer) 

17. If you are not satisfied with the result, adjust the tool settings. 

 

For detailed information on tuning the tool settings, refer to chapter 1.5. 

 

18. If you are satisfied with the result, click on [Resume]. 
 The laser system drills the blind vias on the Bottom side (BottomLayer). 
19. When the message Processing phase: Flip material is displayed, turn the 

multi-layer PCB over around the symmetry axis of the system and click on [OK]. 
Ensure that the positioning holes are located in the right front corner. 

 The dialog Placement is displayed. 
20. Place the processing data matching the location of the multi-layer PCB and 

fiducials on the processing table. 
21. When project placement is complete, click on [OK]. 
 The laser system reads the fiducials on the Top side (TopLayer). 

After fiducial recognition, the laser system starts the material thickness 
measurement and the message Thickness measurement running is displayed. 
When finished, the dialog Test tool settings is displayed. 

22. Click on [Resume]. 
 The laser system drills the blind vias on the Top side (TopLayer). 
23. When the message Processing phase: Galvanic through-hole plating is displayed, 

remove the multi-layer PCB from the system and click on [Cancel] to temporarily 
stop the process. 

24. Spray the multi-layer PCB with LPKF Cleaner and use a brush to clean it. 
25. Rinse the multi-layer PCB with tap water and dry it with compressed air. 

 The blind vias have been drilled into the multi-layer PCB. 

  

1 

2 
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Diameters of blind vias on the test sample 

The processed test sample includes blind vias with different diameters: 
 

 

 
 

 

  
 

 

 Galvanic through-hole plating the multi-layer PCB (with Contac S4) 

1. Switch on the system. 
2. Select a profile. 

 

The recommended total copper thickness after through-hole plating is 30 µm to 
35 µm. 
 

3. Start the process. 
4. Prepare the multi-layer PCB for through-hole plating. 
5. Clean the multi-layer PCB. 
6. Condition the multi-layer PCB. 
7. Activate the multi-layer PCB. 
8. Remove the carrier foil on the bottom side and on the top side of the multi-layer 

PCB. 
9. Clean the holes with LPKF ViaCleaner. 
10. Copper-plate the multi-layer PCB. 
11. Switch off the system. 

 The multi-layer PCB has been galvanically through-hole plated. 

 

For detailed information on galvanic through-hole plating, refer to the user manual of 
Contac S4. 
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 Structuring the outer layers of the multi-layer PCB (with ProtoLaser) 

1. Open the *cp2d file you previously saved in CircuitPro PL. 
 The opened project is displayed in the user guidance step Layout. 
2. Switch to the user guidance step Processing. 
3. In the pane Workflow setup expand the group Processing. 
4. Right-click on [Top-Bot] Structure Bottom and select Process from here. 

 
Fig. 225: Context menu Process from here 

5. When the message Processing phase: Mount material bottom is displayed, place 
the multi-layer PCB with the Bottom side (BottomLayer) facing upwards onto the 
processing table. 
Ensure that the positioning holes are located in the right rear corner. 

6. Click on . 
 The multi-layer PCB is fastened to the processing table by vacuum. 
7. Click on [OK]. 
 The following dialog is displayed: 

 
Fig. 226: Dialog Copper thickness 
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8. Enter the total copper thickness after galvanic through-hole plating into the input 
field. 

 

You can determine the total copper thickness by performing one of the following 
steps: 

− Calculate the copper thickness from the copper deposition rate in Contac S4 
(approx. 0.15 μm/min). 

− Measure the copper thickness with the ProtoMat S104. 

 

9. Click on [OK]. 
 The dialog Placement is displayed. 
10. Move the dialog Placement to get a better overview. 
11. Click on the tab Processing data. 
12. Place the processing data. The location of the layout must match the location of 

the multi-layer PCB and fiducials on the processing table. 

 

For detailed information on project placement according to fiducial positions, refer to 
chapter 1.1. 
 

13. After project placement is complete, click on [OK]. 
 The laser system reads the fiducials on the Bottom side (BottomLayer). 

 

For detailed information on fiducial recognition, refer to chapter 1.2. 

 

After fiducial recognition, the laser system starts the material thickness 
measurement. The message Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, the dialog Test tool settings is displayed. 

 

In this example, testing and setting the tools is to be skipped. 
 
For detailed information on testing and setting the tools, refer to chapter 1.5. 
 

14. Click on [Resume]. 
 Structuring the Bottom side (BottomLayer) is started. 
15. When the message Processing phase: Flip material is displayed, turn the 

multi-layer PCB over around the symmetry axis of the system and click on [OK]. 
Ensure that the positioning holes are located in the right front corner. 

 The dialog Placement is displayed. 
16. Place the processing data matching the location of the multi-layer PCB and 

fiducials on the processing table. 
17. When project placement is complete, click on [OK]. 
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 The laser system reads the fiducials on the Top side (TopLayer). 
After fiducial recognition, the laser system starts the material thickness 
measurement and the message Thickness measurement running is displayed. 
When finished, the dialog Test tool settings is displayed. 

18. Click on [Resume]. 
 Structuring the Top side (TopLayer) is started. 

The following message is displayed: 

 
Fig. 227: Message Processing phase: Process drilling on a ProtoMat 

19. Click on [Cancel]. 
20. Remove the multi-layer PCB from the system. 

 The outer layers of the multi-layer PCB have been structured. 

 Drilling unplated through holes and cutting out the multi-layer PCB 
(with ProtoMat) 

1. Open the *.cbf file you previously saved in CircuitPro PM. 
2. Switch to the pane Processing. 
3. Select MountMaterialTop from the drop-down list and click on . 
 The message Processing Phase: MountMaterialTop is displayed. 
4. Place the multi-layer PCB onto the system’s processing table with the Top side 

(TopLayer) facing upwards and fasten it using adhesive tape. 
Ensure that the positioning holes are located in the right front corner. 

5. Perform the following phases: 
− MaterialSettings_2 

− Placement_3 

 The phases ReadFiducialsTop, MarkingDrillUnplated, DrillingUnplated and 
ContourRouting are performed. 

6. When the message Process finished is displayed, remove the multi-layer PCB 
from the system. 

7. Spray the multi-layer PCB with LPKF Cleaner and use a brush to clean it. 
8. Rinse the multi-layer PCB with tap water and dry it with compressed air. 

 The unplated through holes have been drilled and the multi-layer PCB has been 
cut out. 

 

For detailed information on ProtoMat phases refer to the how-to guides of ProtoMat. 

 

 

The multi-layer PCB production is finished. 
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4 Other how-to examples 

 

The production of PCBs as described in this chapter is only available in the license 
level Advanced of CircuitPro PL. If you have any questions contact the LPKF sales 
department. 
This chapter contains more how-to examples of varying degrees of difficulty. To create 
a polyimide stencil as well as to structure a solder mask, basic knowledge of handling 
laser systems and the system software is sufficient. To create a flex-rigid PCB and an 
RF PCB, advanced knowledge of multi-layer PCBs is required. 

4.1 Producing a polyimide stencil 
This chapter describes how to create a polyimide stencil using a laser system. 

Ensure that the following consumables are available before performing the described 
tasks: 

Consumables System 
• Polyimide Foil A4, 125 μm, format for 

Stencils (order code: 108321) 
• ProtoLaser U4/S4/R4 

 

 

The following steps are performed in this tutorial: 

• Preparing the data in CircuitPro PL 
• Cutting the stencil (with ProtoLaser) 

 Preparing the data in CircuitPro PL 

 

For detailed information on preparing the data in CircuitPro PL refer to chapter 2.1. 

 

1. In the user guidance step New select Single-sided from the drop-down list. 
2. Select your laser system from the drop-down list (in this example PL U4). 
 A list of templates for single-sided materials is displayed: 

 
Fig. 228: List of single-sided templates 
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3. Select the template Stencil for ProtoPrint, A4 for QR 266 x 380, ProtoLaser U4. 
4. Click on [Load template] or double-click on the template. 
 The user guidance step Material is displayed. 
5. Select Foil from the drop-down list. 
6. Select the material Polyimide Foil, 0.125 mm. 

 
Fig. 229: Material selection 

7. Click on [Select material] or double-click on the material. 
 The user guidance step Import is displayed. 
8. Click on . 
 The dialog Open is displayed. 
9. Navigate to the folder that contains the data you want to import. For the example 

data that are used for this tutorial, refer to the folder: 
C:\Program Files\LPKF Laser & Electronics AG\ 

LPKF CircuitPro PL\Example Data\UseCase_PolyimideStencil. 
10. Select the files you want to import. In this example: Tutor.SPT. 
11. Click on [Open]. 
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 The data are automatically assigned to the correct layer and the user guidance 
step Import is displayed: 

 
Fig. 230: User guidance step Import 

12. Click on [Import]. 
 The layout is displayed in the user guidance step Layout. 

 
Fig. 231: Layout of a polyimide stencil 
 

 

The layout needs to be moved to the center of the base material. 

 

13. Select the entire layout. 
 The layout is highlighted and changes its color. 
14. Perform one of the following steps: 

− Right-click on the highlighted layout and select Move object. 
− Click on . 

15. Click on a point in the original layout to specify the reference point. 
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 A copy of the layout is displayed. 
16. Move the copied layout with the mouse to the desired position. 
17. When you reach the desired position, left-click to specify the target point. 
18. In the user guidance step Layout click anywhere on the black background or press 

 to disable the Move object function. 
 The layout has been moved to the desired position. 
19. Switch to the user guidance step Toolpaths. 
20. Click on [Compute toolpaths] or on . 
 The dialog Computing toolpaths is displayed. 
21. Click on [Continue]. 
 The toolpaths are being calculated. The message Computation results is 

displayed. 
22. Check the computation results for any possible warnings or errors and make 

corrections, if needed. 
23. Click on [Close]. 
24. Save your project. 

 The data have been prepared in CircuitPro PL. 

 

 Cutting the stencil (with ProtoLaser) 

1. Switch to the user guidance step Processing. 

 
Fig. 232: User guidance step Processing 

2. Click on [Start production] or on . 
3. When the message Processing phase: Mount material is displayed, place the 

polyimide foil in the center of the processing table. 
4. Click on . 
 The polyimide foil is fastened onto the processing table by vacuum. 
5. Click on [OK]. 
 The dialog Placement is displayed. 
6. Move the dialog Placement to get a better overview. 
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7. Determine the processing area. The base material position and base material size 
must match the processing area used by the CircuitPro PL software. 

 

For detailed information on project placement by determining the processing area, 
refer to chapter 1.1. 
 

8. Click on the tab Processing data. 
9. Click on [Center on material]. 
10. Click on [OK]. 
 The laser system starts the material thickness measurement. The message 

Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, cutting the polyimide foil is started. 
11. When the message Board production finished is displayed, remove the polyimide 

stencil from the system. 
12. Check whether the cut stencil can be fully removed from the residual polyimide 

foil. 
13. Carefully detach the stencil from the residual polyimide foil. 
14. Clean the processing area. 

 The stencil has been cut. 

The polyimide stencil production is finished. 
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4.2 Producing a flex-rigid PCB 
This chapter describes how to create a flex-rigid PCB using a laser system, a 
multi-layer press, and a galvanic through-hole plating system. 

A flex-rigid PCB merges the properties of rigid and flexible PCBs and consists of three 
different materials. 

Ensure that the following consumables and auxiliaries are available before performing 
the described tasks: 

Consumables Auxiliaries System 
• 1 × Base material FR4 

229 mm × 305 mm × 
1.5 mm, 0/18 μm 
copper-clad 
(order code 115968) 

• 1 × Thin Laminate ML104 
0/5 μm, 229 mm × 
305 mm × 0.2 mm with 
protection foil 
(order code 119571) 

• 1 × Prepreg Type 2125, 
200 mm × 275 mm × 
0.1 mm  
(order code 119572) 

• Convection oven  
(order code 115877) 

• LPKF Cleaner  
(order code 115891) 

• Spray adhesive 
• Portable hand-held 

microscope 
• Brush 
• Oil-free compressed air 
• Tap water 

• ProtoLaser U4/S4/R4 
• MultiPress S 
• Contac S4 

 

 

The following steps are performed in this tutorial: 

• Selecting a template 
• Creating a new material 
• Importing the data 
• Setting the parameters for the new layers 
• Creating the positioning holes for prepreg material and flexible material 
• Modifying the workflow settings 
• Computing toolpaths 
• Preparing the flexible material (with ProtoLaser) 
• Preparing the prepreg material (with ProtoLaser) 
• Preparing the rigid material (with ProtoLaser) 
• Assembling and pressing the flex-rigid stack (with MultiPress S) 
• Drilling plated through holes into the flex-rigid PCB (with ProtoLaser) 
• Galvanic through-hole plating the flex-rigid PCB (with Contac S4) 
• Structuring the outer layers of the flex-rigid PCB (with ProtoLaser) 
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 Selecting a template 

1. In the user guidance step New select 4-layer-Multilayer from the drop-down list. 
2. Select your laser system from the drop-down list (in this example PL U4). 
 A list of templates for 4-layer multilayer materials is displayed. 
3. Select the template 4 Layers, ProtoLaser U4, galvanic through-hole plating, 

MultiPress S. 

 

There is no predefined template for the production of a flex-rigid PCB. For this 
example, it is essential that you select a template that contains register holes for the 
MultiPress S, since creating a flex-rigid PCB requires bonding of rigid and flexible 
materials. The register holes ensure that the different physical layers can be aligned 
for bonding using the registration system of the MultiPress S. 
 

4. Click on [Load template] or double-click on the template. 
 The user guidance step Material is displayed. 

 The template has been selected. 

 Creating a new material 

 

In CircuitPro PL there is no material suitable for the production of a flex-rigid PCB. 
Therefore, it needs to be created and saved to the material library. 
 

1. In the user guidance step Material select 4 layer multilayer from the drop-down list. 
 A list of 4-layer multi-layer materials is displayed. 
2. Select the material LPKF 4-Layer_Galvanic. 

 
Fig. 233: User guidance step Material 

3. Click on . 
 A copy of the selected material is created: 

 
Fig. 234: Copy of selected material 

4. Click on . 
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 The view Modify parameters is displayed: 

 
Fig. 235: View Modify parameters 

5. Enter the new material name in the input field Material name (in this example 
LPKF Flex-rigid). 

 
Fig. 236: Entering the material name 

 Delete the top five materials in the set of materials by clicking on  next to the 
material name. 

 
Fig. 237: Deleting the materials 
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 The view Modify parameters changes as follows: 

 
Fig. 238: Materials deleted 

6. Select Single-sided from the drop-down list. 
 A list of single-sided materials is displayed. 
7. Select the material FR4, 1.5 mm, 18 µm and add it to the top of the new set of 

materials by drag & drop or by clicking on . 

 
Fig. 239: Adding the material 

 The material FR4 Single-sided, 1.5 mm, 18 µm is added to the top of the new set 
of materials: 

 
Fig. 240: Material added to the new set of materials 

8. Click on [Save]. 
 The material LPKF Flex-rigid has been saved. 
9. Click on the user guidance step Material to leave the view Modify parameters. 
10. Select All materials from the drop-down list. 
 A list of all materials is displayed. 
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11. Select the material LPKF Flex-rigid. 

 
Fig. 241: Selecting the material 

12. Click on [Select material] or double-click on the material. 
 The user guidance step Import is displayed. 

 A new material has been created. 

 Importing the data 

1. In the user guidance step Import click on . 
 The dialog Open is displayed. 
2. Navigate to the folder that contains the data you want to import. For the example 

data that are used for this sequence, refer to the folder: 
C:\Program Files\LPKF Laser & Electronics AG\ 

LPKF CircuitPro PL\Example Data\UseCase_FlexRigidPCB. 
3. Select the files you want to import (in this example FlexRigid.BOT, FlexRigid.DRL, 

FlexRigid.TOP, PrepregCutout.GKO and RigidCutout.GTO). 
4. Click on [Open]. 
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 The user guidance step Import changes as follows: 

 
Fig. 242: User guidance step Import 

5. For the file FlexRigid.BOT assign the board outline to the layer BoardOutline in the 
column Target. 

 
Fig. 243: Assigning board outline to layer BoardOutline 

6. Deactivate the check box BoardOutline in the column Source. 

 
Fig. 244: Deselecting the source BoardOutline 

7. In the column Target assign the data FlexRigid.DRL to the layer DrillPlated. 

 
Fig. 245: Assigning the holes to layer DrillPlated 

8. Click on [Import]. 
 The following message is displayed: 

 
Fig. 246: Message Info 
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9. Click on [Close]. 
 The user guidance step Layout is displayed: 

 
Fig. 247: User guidance step Layout 

 The data have been imported. 

 Setting the parameters for the new layers 

1. Select the entire layout. 
 The layout is highlighted and changes its color. 

 
Fig. 248: Highlighted layout 
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2. Perform one of the following steps: 
− Right-click on the highlighted layout and select Move object. 
− Click on . 

3. Click on a point in the original layout to specify the reference point. 
 A copy of the layout is displayed. 
4. Move the copied layout with the mouse to the desired position. 
5. When you reach the desired position, left-click to specify the target point. 
6. In the user guidance step Layout click anywhere on the black background or press 

 to disable the Move object function. 
 The layout has been moved to the desired position. 

 
Fig. 249: Layout moved 

7. In the pane Workflow setup expand the group Layout and expand the node 
Layers. 

 A list of layers is displayed. 



 
 

 

ProtoLaser U4/S4/R4 
 

Other how-to examples 

V. 4.0 | LPKF Laser & Electronics d.o.o.  201/274 

8. Right-click on the layer PrepregCutout and click on the context menu item 
PCB layer > Prepreg 1. 

 
Fig. 250: Context menu PCB layer > Prepreg 1 

9. Right-click on the layer PrepregCutout and click on the context menu item 
Display mode > True Width. 

 
Fig. 251: Context menu Display mode > True Width 
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10. Right-click on the layer PrepregCutout and click on the context menu item 
Technology > Cutting. 

 
Fig. 252: Context menu Technology > Cutting 

11. Right-click on the layer RigidCutout and click on the context menu item 
PCB layer > Top Layer. 

12. Right-click on the layer RigidCutout and click on the context menu item 
Display mode > True Width. 

13. Right-click on the layer RigidCutout and click on the context menu item 
Technology > Cutting. 

 The parameters for the new layers have been set. 
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 Creating the positioning holes for prepreg material and flexible material 

 

The register holes in the selected template are located outside the prepreg's area. 
Therefore, three prepreg positioning holes and three flexible material positioning 
holes with a 2 mm diameter have to be created in the layout. These positioning 
holes will be used to position the prepreg material and the flexible material correctly in 
the press mold. 
 

1. In the pane Workflow setup expand the group Layout and expand the node 
Layers. 

2. Right-click on the node Layers and click on the menu item Add new layer. 

 
Fig. 253: Menu item Add new layer 

 A new layer is created. 
3. Right-click on the new layer and click on the context menu item Rename. 

 
Fig. 254: Context menu item Rename 
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4. Enter FlexPositioningHoles in the input field. 

 
Fig. 255: Renaming layer 

5. Press . 
 The layer is renamed. 
6. Set the parameters of the layer FlexPositioningHoles by performing the following 

steps: 
− Right-click on the layer and click on the context menu item 

PCB layer > Bottom Layer. 
− Right-click on the layer and click on the context menu item 

Display mode > True Width. 
− Right-click on the layer and click on the context menu item 

Technology > Cutting. 

7. In the user guidance step Layout, right-click on the black background and select 
Circle by diameter or click on . 

 The input fields for Specify center point are displayed: 

 
Fig. 256: Input fields Specify center point 

 



 
 

 

ProtoLaser U4/S4/R4 
 

Other how-to examples 

V. 4.0 | LPKF Laser & Electronics d.o.o.  205/274 

 

The three prepreg positioning holes and three flexible material positioning holes 
should be located anywhere inside the prepreg area. It is best to position them 
approximately 30 mm off the corners of the flex-rigid PCB data. 
 

8. Click on a desired point on the black background to specify the center point of the 
first flexible material positioning hole. 

 The center point is specified and the input field for Specify diameter is displayed: 

 
Fig. 257: Input fields Specify diameter 

9. Enter the diameter in the input field (in this example 2 mm) and press [Enter]. 
 The first flexible material positioning hole is created in the layout. The input fields 

for specifying the center point of the next flexible material positioning hole are 
displayed: 

 
Fig. 258: Specifying the next center point 
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 Repeat the steps 8 and 9 for creating another two flexible material positioning 
holes. 

10. Press  to exit the function Circle by diameter. 
 The three flexible material positioning holes have been created on the layer 

FlexPositioningHoles: 

 
Fig. 259: Flexible material positioning holes 

11. In the pane Workflow setup, right-click on the node Layers and click on the menu 
item Add new layer. 

 A new layer is created. 
12. Right-click on the new layer and click on the context menu item Rename. 
13. Enter PrepregPositioningHoles in the input field. 
14. Press . 
 The layer is renamed. 
15. Set the parameters of the layer PrepregPositioningHoles by performing the 

following steps: 
− Right-click on the layer and click on the context menu item 

PCB layer > Prepreg 1. 
− Right-click on the layer and click on the context menu item 

Display mode > True Width. 
− Right-click on the layer and click on the context menu item 

Technology > Cutting. 

16. Right-click on the layer FlexPositioningHoles and click on the context menu item 
Select by layer. 

 All the objects on this layer are selected and highlighted. 
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17. Right-click on the black background and click on the context menu items 
Copy to layer > PrepregPositioningHoles. 

 
Fig. 260: Context menu Copy to layer 

 All the objects on the layer FlexPositioningHoles are copied to the layer 
PrepregPositioningHoles. 

 

The prepreg positioning holes need to be larger than the flexible material positioning 
holes. This prevents the prepreg material from spreading onto the flexible material 
during the bonding process. 
 

18. Right-click on the layer PrepregPositioningHoles and click on the context menu 
item Select by layer. 

 All the objects on this layer are selected and highlighted. 
19. Right-click on the black background and click on the context menu item Scale or 

click on . 
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 The input fields for Non-uniform scaling (in percent) and a drop-down list are 
displayed: 

 
Fig. 261: Input fields Non-uniform scaling (in percent) 

20. Enter 150 % for Scale factor x and press the  key. 
21. Enter 150 % for Scale factor y and press the  key. 
 The drop-down list is activated. 
22. Press the ↓  key twice. 
 The option Individually is selected in the drop-down list. 

 
Fig. 262: Values for Non-uniform scaling (in percent) 

23. Press  to confirm the selection. 
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 The scaled prepreg positioning holes is highlighted in orange: 

 
Fig. 263: Preview of the scaled positioning holes 

24. Press  to exit the function Scale. 
25. Press  to deselect the objects. 
 The prepreg positioning holes are increased in size. 

 
Fig. 264: Prepreg positioning holes 

26. Save your project. 

 The positioning holes for prepreg material and flexible material have been created. 
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 Modifying the workflow settings 

1. Switch to the user guidance step Workflow. 
2. In the pane Workflow setup expand the group Workflow and right-click on the 

phase Prepare Laminate Bottom. 
3. Click on the context menu item Rename. 

 
Fig. 265: Rename 

4. Enter the name Prepare Flex in the input field. 
5. Press . 
 The phase is renamed and selected. 
6. In the user guidance step Workflow select the work package Cut Reference Holes. 

 
Fig. 266: Work package selected 
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7. Under Input layer activate the check box FlexPositioningHoles. 

 
Fig. 267: Modified settings 

8. Click on [Apply]. 
 The workflow settings for the phase Prepare Flex are modified. 
9. In the pane Workflow setup right-click on the phase Prepare Laminate Top and 

click on the context menu item Rename. 
10. Enter the name Prepare Prepreg in the input field. 
11. Press . 
 The phase is renamed and selected. 
12. In the user guidance step Workflow select the work package Cut Reference Holes. 

 
Fig. 268: Work package selected 
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13. Under Input layer perform the following steps: 
− Deactivate the check box PrepareLaminate. 
− Activate the check box PrepregCutout. 
− Activate the check box PrepregPositioningHoles. 

 The settings of the work package Cut Reference Holes are displayed as follows: 

 
Fig. 269: Settings of the work package Cut Reference Holes 

14. Expand the group Parameters. 
15. Enter 20 µm in the input field Channel width. 

 
Fig. 270: Channel width modified 

16. Click on [Apply]. 
 The workflow settings for the phase Prepare Prepreg are modified. 
17. In the pane Workflow setup right-click on the phase [Core] StructureLayer 3 and 

click on the context menu item Rename. 
18. Enter the name Prepare Rigid in the input field. 
19. Press . 
 The phase is renamed and selected. 
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20. In the user guidance step Workflow deactivate the check box of the work package 
Structure Layer 3. 

 
Fig. 271: Work package deselected 

 The work package is deselected. 
21. Select the work package Cut Reference Holes. 

 
Fig. 272: Work package selected 
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22. Under Input layer activate the check box RigidCutout. 

 
Fig. 273: Modified settings 

23. Click on [Apply]. 
 The workflow settings for the phase Prepare Rigid are modified. 
24. In the pane Workflow setup select the phase [Core] StructureLayer 2 and press 

 or click on . 
 The phase is deleted. 

 

When you use a newly created material, it is recommended that you test the tool 
settings before processing. 
 

25. In the user guidance step Workflow select the phase [Top-Bot] Galvanic THP from 
the drop-down list and select the work package Drill Plated Through-Holes. 

 
Fig. 274: Phase and work package selected 
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26. Activate the check box Test tool settings. 

 
Fig. 275: Modified settings 

27. Click on [Apply]. 
 The workflow settings for the phase [Top-Bot] Galvanic THP are modified. 

 The workflow settings have been modified. 

 Computing toolpaths 

1. Switch to the user guidance step Toolpaths. 
2. Click on [Compute toolpaths] or on . 
 The dialog Computing toolpaths is displayed. 
3. Click on [Continue]. 
 The toolpaths are being calculated. The message Computation results is 

displayed. 
4. Check the computation results for any possible warnings or errors and make 

corrections, if needed. 
5. Click on [Close]. 
6. Save your project. 

 The toolpaths have been computed. 
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 Preparing the flexible material (with ProtoLaser) 

1. Switch to the user guidance step Processing. 

 
Fig. 276: User guidance step Processing 

2. Click on [Start production] or on . 
 When the message Processing phase: Mount laminate is displayed, place the 

flexible material with the copper side facing upwards in the center of the 
processing table. 

3. Click on . 
 The flexible material is fastened to the processing table by vacuum. 
4. Click on [OK]. 
 The dialog Placement is displayed. 
5. Move the dialog Placement to get a better overview. 
6. Determine the processing area. The base material position and base material size 

must match the processing area used by the CircuitPro PL software. 

 

For detailed information on project placement by determining the processing area, 
refer to chapter 1.1. 
 

7. Click on the tab Processing data. 
8. Click on [Center on material]. 
9. Click on [OK]. 
 The laser system starts the material thickness measurement. The message 

Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, the laser system drills the fiducials, the positioning holes, the 
register holes, and the positioning holes of the flexible material. 

10. When the message Processing phase: Dismount material is displayed, remove the 
flexible material from the system. 

 The flexible material has been prepared. 
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 Preparing the prepreg material (with ProtoLaser) 

1. In the message Processing phase: Dismount material click on [OK]. 
 When the message Processing phase: Mount laminate is displayed, place the 

prepreg material in the center of the processing table. 
2. Click on . 
 The prepreg material is fastened to the processing table by vacuum. 
3. Click on [OK]. 
 The dialog Placement is displayed. 
4. Move the dialog Placement to get a better overview. 
5. Determine the processing area. The base material position and base material size 

must match the processing area used by the CircuitPro PL software. 

 

For detailed information on project placement by determining the processing area, 
refer to chapter 1.1. 
 

6. Click on the tab Processing data. 
7. Click on [Center on material]. 
8. Click on [OK]. 
 The laser system starts the material thickness measurement. The message 

Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, the laser system drills the prepreg positioning holes and the cutout 
is being created in the prepreg material. 

9. When the message Processing phase: Dismount material is displayed, remove the 
prepreg material from the system. 

 The prepreg material has been prepared. 

 

 Preparing the rigid material (with ProtoLaser) 

1. In the message Processing phase: Dismount material click on [OK]. 
 When the message Processing phase: Mount core is displayed, place the rigid 

material in the center of the processing table. 
2. Click on . 
 The rigid material is fastened to the processing table by vacuum. 
3. Click on [OK]. 
 The dialog Placement is displayed. 
4. Move the dialog Placement to get a better overview. 
5. Determine the processing area. The base material position and base material size 

must match the processing area used by the CircuitPro PL software. 

 

For detailed information on project placement by determining the processing area, 
refer to chapter 1.1. 
 

6. Click on the tab Processing data. 
7. Click on [Center on material]. 
8. Click on [OK]. 
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 The laser system starts the material thickness measurement. The message 
Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, the laser system drills the fiducials, the positioning holes and the 
register holes into the rigid material. The cutout is being created in the rigid 
material. 

 

Save the residual material that has been cut out of the rigid material. You will need it 
later for assembling and pressing of the flex-rigid stack. 
 

9. When the message Processing phase: Press all layers is displayed, remove the 
rigid material from the system and click on [Cancel] to temporarily stop the 
process. 

10. Spray the rigid material with LPKF Cleaner and use a brush to clean it. 
11. Rinse the rigid material with tap water and dry it with compressed air. 

 The rigid material has been prepared. 

 

 Assembling and pressing the flex-rigid stack (with MultiPress S) 

 

For detailed information on assembling and pressing the multi-layer stack refer to 
chapter 1.6. 
 

1. Start the pre-heating process of the MultiPress S. 
2. Prepare the materials. 

 

Dry the materials in a convection oven at 100 °C (212 °F) for 30 minutes before 
assembling them in the press mold. Do not dry the prepreg material. 
 

3. Assemble the flex-rigid stack in the press mold using the following order: 
− Flexible material (ML104) 
Assemble the flexible material according to the pins in the press mold. Make sure 
that the copper side faces downwards. 
− Prepreg material 
Align the prepreg material to the flexible material. Match the position of the three 
prepreg positioning holes to the flexible material positioning holes. Apply some 
spray adhesive on the corners of the prepreg material to ensure that its position 
will remain correctly during assembling. 
− Rigid material (FR4) 
Assemble the rigid material according to the pins in the press mold. 

 

Insert a strip from the base material in a matching size into the cutout of the rigid 
material. For the strip you can use the residual material that has been created during 
the cutout in the sequence Preparing the rigid material (see page 217). This strip 
supports the flexible material during pressing. This way, better pressing results can be 
achieved. 
 
Apply self-adhesive sealing rings on positioning holes, register holes and fiducials. 
This prevents the prepreg materials from entering the holes. 
 

4. Press the flex-rigid stack. 

 The flex-rigid stack has been assembled and pressed. 
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 Drilling plated through holes into the flex-rigid PCB (with ProtoLaser) 

1. Click on File > Open or . 

 

You can open the file also by clicking in the user guidance step New on 
[Open project…]. 
 

 The dialog Open is displayed. 
2. Select the file you previously saved. 
3. Click on [Open]. 
 The opened project is displayed in the user guidance step Processing. 
4. In the pane Workflow setup expand the group Processing and expand the phase 

[Top-Bot] Galvanic THP. 
5. Right-click on Mount Material Top and select Process from here. 

 
Fig. 277: Context menu Process from here 

6. When the message Processing phase: Mount material top is displayed, place the 
flex-rigid PCB with the Top side (TopLayer) facing upwards onto the processing 
table. 
Ensure that the positioning holes are located in the right front corner. 

7. Click on . 
 The flex-rigid PCB is fastened to the processing table by vacuum. 
8. Click on [OK]. 
 The dialog Placement is displayed. 
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9. Move the dialog Placement to get a better overview. 
10. Click on the tab Processing data. 
11. Place the processing data. The location of the layout must match the location of 

the flex-rigid PCB and fiducials on the processing table. 

 

For detailed information on project placement according to fiducial positions, refer to 
chapter 1.1. 
 

12. After project placement is complete click on [OK]. 
 The laser system reads the fiducials on the Top side (TopLayer). 

 

For detailed information on fiducial recognition, refer to chapter 1.2. 

 

After fiducial recognition, the laser system starts the material thickness 
measurement. The message Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, the following dialog is displayed: 

 
Fig. 278: Dialog Test tool settings 
 

 

It is recommended that you process the through-hole test sample on your flex-rigid 
PCB before you continue with production. 
 

13. Select Place and process “Drill TH test sample 5x5 mm”. 

 

For detailed information on placing and processing the test sample, refer to 
chapter 1.5. 
 

14. Check the processed test sample with a portable hand-held microscope. 
15. Determine if the processing quality is satisfactory. 
16. If the processing quality is not satisfactory, tune the tool settings. 

 

For detailed information on tuning the tool settings, refer to chapter 1.5. 

 

17. If the processing quality is satisfactory, click on [Resume]. 
 The laser system drills the plated through holes. 
18. When the message Processing phase: Galvanic through-hole plating is displayed, 

click on [Cancel] to temporarily stop the process. 
19. Remove the flex-rigid PCB from the system. 

 The plated through holes have been drilled into the flex-rigid PCB. 
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 Galvanic through-hole plating the flex-rigid PCB (with Contac S4) 

1. Switch on the system. 
2. Select a profile. 

 

The recommended total copper thickness after through-hole plating is 30 µm to 
35 µm. 
 

3. Start the process. 
4. Prepare the flex-rigid PCB for through-hole plating. 
5. Clean the flex-rigid PCB. 
6. Condition the flex-rigid PCB. 
7. Activate the flex-rigid PCB. 
8. Clean the holes with LPKF ViaCleaner. 
9. Copper-plate the flex-rigid PCB. 
10. Switch off the system. 

 The flex-rigid PCB has been galvanically through-hole plated. 

 

For detailed information on galvanic through-hole plating, refer to the user manual of 
Contac S4. 
 

 Structuring the outer layers of the flex-rigid PCB (with ProtoLaser) 

1. Open the *cp2d file you previously saved. 
 The opened project is displayed in the user guidance step Processing. 
2. In the pane Workflow setup expand the group Processing. 
3. Right-click on [Top-Bot] Bottom Side. 
4. Select Process from here in the context menu. 
5. When the message Processing phase: Mount material bottom is displayed, place 

the flex-rigid PCB with the flexible side (BottomLayer) facing upwards onto the 
processing table. 
Ensure that the positioning holes are located in the right rear corner. 

6. Click on . 
 The flex-rigid PCB is fastened to the processing table by vacuum. 
7. Click on [OK]. 
 The following dialog is displayed: 

 
Fig. 279: Dialog Copper thickness 
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8. Enter the total copper thickness after galvanic through-hole plating into the input 
field. 

 

You can determine the total copper thickness by calculating the thickness from the 
copper deposition rate in Contac S4 (approx. 0.15 μm/min). 
 

9. Click on [OK]. 
 The dialog Placement is displayed. 
10. Move the dialog Placement to get a better overview. 
11. Click on the tab Processing data. 
12. Place the processing data. The location of the layout must match the location of 

the flex-rigid PCB and fiducials on the processing table. 

 

For detailed information on project placement according to fiducial positions, refer to 
chapter 1.1. 
 

13. After project placement is complete click on [OK]. 
 The laser system reads the fiducials on the Bottom side (BottomLayer). 

 

For detailed information on fiducial recognition, refer to chapter 1.2. 

 

After fiducial recognition, the laser system starts the material thickness 
measurement. The message Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, the following dialog is displayed: 

 
Fig. 280: Dialog Test tool settings 
 

 

It is recommended that you process a test sample on your flex-rigid PCB before you 
continue with production. 
 

14. Select Place and process “Large test sample 35x25 mm”. 

 

For detailed information on testing and setting the tools, refer to chapter 1.5. 

 

15. Check the processed test sample with a portable hand-held microscope. 
16. Determine if the processing quality is satisfactory. 
17. If the processing quality is not satisfactory, tune the tool settings. 

 

For detailed information on tuning the tool settings, refer to chapter 1.5. 

 

18. If the processing quality is satisfactory, click on [Resume]. 
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 Structuring the flexible part of the flex-rigid PCB (BottomLayer) is started. 
19. When the message Processing phase: Flip material is displayed, turn the flex-rigid 

PCB over around the symmetry axis of the system and click on [OK]. 
Ensure that the positioning holes are located in the right front corner. 

 The dialog Placement is displayed. 
20. Place the processing data matching the location of the flex-rigid PCB and 

fiducials on the processing table. 
21. When project placement is complete, click on [OK]. 
 The laser system reads the fiducials on the Top side (TopLayer). 

After fiducial recognition, the laser system starts the material thickness 
measurement and the message Thickness measurement running is displayed. 
When finished, the dialog Test tool settings is displayed. 

22. Repeat the steps 14 to 17. 
23. If the processing quality is acceptable, click on [Resume]. 
 The laser system structures the Top side (TopLayer) and cuts out the flex-rigid 

PCB. 
24. When the message Board production finished is displayed, remove the flex-rigid 

PCB from the system. 
25. Spray the flex-rigid PCB with LPKF Cleaner and use a brush to clean it. 
26. Rinse the flex-rigid PCB with tap water and dry it with compressed air. 

 The outer layers of the flex-rigid PCB have been structured. 

The flex-rigid PCB production is finished. 
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4.3 Structuring the solder mask with the laser system 
This chapter describes how to remove solder resist selectively from solder pads on a 
PCB with the laser system. The benefit of this procedure is avoiding printing the 
artwork and avoiding handling of chemicals. 

 

The solder resist is removed with the hatching method. 
 
For detailed information on processing methods of the ProtoLaser refer to chapter 1.7. 
 

Ensure that the following consumables and auxiliaries are available before performing 
the described tasks: 

Consumables Auxiliaries System 
• Fully structured and 

through-plated PCB 
• LPKF Cleaner  

(order code: 115891) 
• Convection oven  

(order code: 115877) 
• Brush 
• Oil-free compressed air 
• Tap water 

• ProtoLaser U4/S4/R4 
• ProMask 

 

 

The following steps are performed in this tutorial: 

• Applying the solder resist on the PCB (with ProMask) 
• Preparing the data for solder mask structuring in CircuitPro PL 
• Structuring the solder mask (with ProtoLaser) 

When any PCB production is finished, a green solder resist can be applied on its 
surface. A solder mask eliminates the risk of short circuits by soldering of SMDs or 
conventional components on the PCB. 

 

Work with PCBs that have not yet been broken at the breakout tabs! Thus, perform 
the contour routing only after the completion of this application example. 
 
If contour routing has already been done, make sure you do not break or cut the 
breakout tabs. This way the PCB remains attached to the base material. 
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 Applying the solder resist on the PCB (with ProMask) 

 

Spray the already structured PCB with LPKF Cleaner and use a brush to clean the 
PCB, rinse with tap water and dry it with compressed air. 
 

1. Mix Component A and Component B. 
2. Coat the PCB. 

 

Ensure that the fiducials are not coated! 

 

3. Predry the PCB in a convection oven. 
4. Expose the PCB without the artwork to the UV light. 
5. Postcure the PCB in a convection oven. 

 The solder resist has been applied on the PCB. 

 

For detailed information on applying the solder mask on the PCB refer to the process 
description of ProMask/ProLegend. 
 

 Preparing the data for solder mask structuring in CircuitPro PL 

 

For detailed information on preparing the data in CircuitPro PL refer to chapter 2.1. 

 

1. Open the file you have been using for the production of your PCB. 

 

Your file needs to include solder mask layers. 
 
Should your file not include these layers, you can import them by clicking in the user 
guidance step Import on . Make sure you assign them to the layers 
SolderMaskBottom and SolderMaskTop. 
 

2. Switch to the user guidance step Layout. 
 The layout changes as follows: 

 
Fig. 281: User guidance step Layout  
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3. Select the entire layout. 
 The layout is highlighted and changes its color. 
4. Click on Edit > Copy or press  + . 
 The layout has been copied to the clipboard. 
5. Switch to the user guidance step New and select Double-sided from the 

drop-down list. 
6. Select your laser system from the drop-down list (in this example PL U4). 
7. Select the template ProMask_Removal, ProtoLaser U4. 
8. Click on [Load template] or double-click on the template. 
 The user guidance step Material is displayed. 
9. Select the material ProMask removal, 2 layer multilayer. 

 
Fig. 282: Material selection 

10. Click on [Select material] or double-click on the material. 
 The user guidance step Import is displayed. 
11. Switch to the user guidance step Layout. 
12. Click on Edit > Paste or press  + . 
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 A copy of the layout (in orange) and the input fields for Specify target point are 
displayed: 

 
Fig. 283: Specify target point 

13. Move the copied layout with the mouse to the desired position. 
14. Left-click to specify the target point. 
15. Click anywhere on the black background or press  to deselect the layout. 
 The layout has been pasted and is displayed in the user guidance step Layout: 

 
Fig. 284: Pasted layout 

16. Switch to the user guidance step Toolpaths. 
17. Click on [Compute toolpaths] or on . 
 The dialog Computing toolpaths is displayed. 
18. Click on [Continue]. 
 The toolpaths are being calculated. The message Computation results is 

displayed. 
19. Check the computation results for any possible warnings or errors and make 

corrections, if needed. 
20. Click on [Close]. 

 The data have been prepared for solder mask structuring in CircuitPro PL. 
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 Structuring the solder mask (with ProtoLaser) 

1. Switch to the user guidance step Processing. 
2. Click on  or click on [Start production]. 
3. When the message Processing phase: Mount material bottom is displayed, place 

the coated PCB with the Bottom side (SolderMaskBottom) facing upwards onto 
the processing table. 

4. Click on . 
 The coated PCB is fastened onto the processing table by vacuum. 
5. Click on [OK]. 
 The dialog Placement is displayed. 
6. Move the dialog Placement to get a better overview. 
7. Click on the tab Processing data. 
8. Place the processing data. 

The location of the layout must match the location of coated PCB and fiducials on 
the processing table. 

 

For detailed information on project placement according to fiducial positions, refer to 
chapter 1.1. 
 

9. After project placement is complete, click on [OK]. 
 The laser system reads the fiducials on the Bottom side of the coated PCB 

(SolderMaskBottom). 

 

For detailed information on fiducial recognition refer to chapter 1.2. 

 

After fiducial recognition, the laser system starts the material thickness 
measurement. The message Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 

 

When finished, removing the solder resist from the solder pads on the Bottom side 
of the coated PCB (SolderMaskBottom) is started. 

10. When the message Processing phase: Flip material is displayed, turn the coated 
PCB over around the symmetry axis of the system and click on [OK]. 
Ensure that the positioning holes are located in the right front corner. 

 The dialog Placement is displayed. 
11. Place the processing data matching the location of the coated PCB and fiducials 

on the processing table. 
12. When project placement is complete, click on [OK]. 
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 The laser system reads the fiducials on the Top side of the coated PCB 
(SolderMaskTop). 
After fiducial recognition, the laser system starts the material thickness 
measurement and the message Thickness measurement running is displayed. 
When finished, removing the solder resist from the solder pads the Top side of the 
coated PCB (SolderMaskTop) is started. 

13. When the message Board production finished is displayed, remove the PCB from 
the system. 

14. Spray the PCB with LPKF Cleaner and use a brush to clean it. 
15. Rinse the PCB with tap water and dry it with compressed air. 

 The solder mask has been structured. 

The solder resist has been removed from the solder pads of a PCB with the laser 
system. 
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4.4 Producing an RF PCB 
This chapter describes how to create an RF PCB using a laser system. 

 

The RF PCB is produced with the hatching method. 
 
For detailed information on processing methods of the ProtoLaser refer to chapter 1.7. 
 

Ensure that the following consumables and auxiliaries are available before performing 
the described tasks: 

Consumables Auxiliaries System 
• Base material Aluminum 

oxide - Al2O3, 0.5 mm, 
0/23 μm gold-plated 

• LPKF Cleaner  
(order code: 115891) 

• Brush 
• Oil-free compressed air 
• Tap water 

• ProtoLaser U4/S4/R4 

 

 

The following steps are performed in this tutorial: 

• Preparing the data in CircuitPro PL 
• Processing the PCB (with ProtoLaser) 

 Preparing the data in CircuitPro PL 

 

For detailed information on preparing the data in CircuitPro PL refer to chapter 2.1. 

 

1. In the user guidance step New select Single-sided from the drop-down list. 
2. Select your laser system from the drop-down list (in this example PL R4). 
 A list of templates for single-sided materials is displayed. 
3. Select the template Single-sided, Top, ProtoLaser R4. 
4. Click on [Load template] or double-click on the template. 
 The user guidance step Material is displayed. 
5. Select the material Al2O3_Au22, Single-sided, 0.5 mm, 22 µm. 

 
Fig. 285: Material selection 

6. Click on [Select material] or double-click on the material. 
 The user guidance step Import is displayed. 
7. Click on . 
 The dialog Open is displayed. 
8. Navigate to the folder that contains the data you want to import. 
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9. Select the files you want to import. 
10. Click on [Open]. 
 The data are automatically assigned to the correct layer and the user guidance 

step Import is displayed: 

 
Fig. 286: User guidance step Import 

11. Click on [Import]. 
 The layout is displayed in the user guidance step Layout. 

 
Fig. 287: Layout of an RF PCB 

 

Before processing an RF PCB, the workflow settings need to be modified. 
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12. Switch to the user guidance step Workflow. 

 
Fig. 288: User guidance step Workflow 

13. Select the work package Structure Top. 

 
Fig. 289: Work package Structure Top selected 
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14. Expand the group Parameters. 

 
Fig. 290: Group Parameters 

15. In the sub-group Hatching select xy parallel from the drop-down list Pattern. 
16. Enter 7.5 µm in the input field Hatching grid. 
 The sub-group Hatching changes as follows: 

 
Fig. 291: Sub-group Hatching 
 

 

The order of the tools Isolate and Hatch needs to be reversed for this how-to 
example. 
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17. Select the tool Isolate. 

 
Fig. 292: Tool selected 

18. Move it to the second position using drag & drop. 

 
Fig. 293: Tool moved 

 

Alternatively, you can change the order of the tools via the drop-down lists. 

 

 The order of the tools Isolate and Hatch has been reversed. 
19. Click on [Apply]. 
 The workflow settings have been modified. 
20. Switch to the user guidance step Toolpaths. 
21. Click on [Compute toolpaths] or on . 
 The dialog Computing toolpaths is displayed: 
22. Click on [Continue]. 
 The toolpaths are being calculated. The message Computation results is 

displayed. 
23. Check the computation results for any possible warnings or errors and make 

corrections, if needed. 
24. Click on [Close]. 
25. Save your project. 

 The data have been prepared in CircuitPro PL. 
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 Processing the PCB (with ProtoLaser) 

1. Switch to the user guidance step Processing. 

 
Fig. 294: User guidance step Processing 

2. Click on [Start production] or on . 
3. When the message Processing phase: Mount material is displayed, place the 

base material onto the processing table. 
4. Click on . 
 The base material is fastened onto the processing table by vacuum. 
5. Click on [OK]. 
 The dialog Placement is displayed. 
6. Move the dialog Placement to get a better overview. 
7. Determine the processing area. The base material position and base material size 

must match the processing area used by the CircuitPro PL software. 

 

For detailed information on project placement by determining the processing area, 
refer to chapter 1.1. 
 

8. Click on the tab Processing data. 
9. Click on [Center on material]. 
10. Click on [OK]. 
 The laser system starts the material thickness measurement. The message 

Thickness measurement running is displayed. 

 

For detailed information on material thickness measurement, refer to chapter 1.3. 
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When finished, the through holes are drilled and the dialog Test tool settings is 
displayed. 

 

In this example, testing and setting the tools is to be skipped. 
 
For detailed information on testing and setting the tools, refer to chapter 1.5. 
 

11. Click on [Resume]. 
 Structuring the Top side (TopLayer) is started. 
12. When the message Board production finished is displayed, remove the PCB from 

the system. 
13. Spray the PCB with LPKF Cleaner and use a brush to clean it. 
14. Rinse the PCB with tap water and dry it with compressed air. 

 The PCB has been processed. 

The RF PCB production is finished. 
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5 Processing files 
 

This chapter describes how to import different file formats (CAD files) and prepare 
them for processing. It also shows typical errors during the import and suitable 
measures for troubleshooting. 

5.1 Processing DXF files in CircuitPro PL 

 

Processing DXF files is only available in the license level Advanced of CircuitPro PL.  
If you have any questions contact the LPKF sales department. 
 

This chapter describes how to import and convert DXF files in CircuitPro PL. 

The following steps are performed in this tutorial: 

• Importing DXF files 
• Combining open paths 
• Modifying the workflow settings 
• Computing toolpaths 

 Importing DXF files 

1. In the user guidance step New, select the template that suits the type of project 
you have. 
In this example the template Single-sided, Top, ProtoLaser U4 is used. 

2. Click on [Load template] or double-click on the template. 
 The user guidance step Material is displayed. 
3. Select the material AL2O3_Au22, Single-sided, 0.5 mm, 22 µm. 

 
Fig. 295: Select material 

4. Click on [Select material] or double-click on the material. 
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 The user guidance step Import is displayed. 
5. Click on . 
6. Navigate to the folder that contains the data you want to import. The example data 

used for this tutorial are located in the folder: 
C:\Program Files\LPKF Laser & Electronics AG\ 

LPKF CircuitPro PL\Example Data\UseCase_DXFFiles. 
7. Select the files you want to import (in this example Tutor_dxf.dxf). 
8. Click on [Open]. 
 The user guidance step Import is displayed. 
9. In the drop-down list of the column Target, select the entry CutInside. 

 
Fig. 296: Select CutInside 

 The data to be imported are assigned to the layer CutInside. 

 

In the column Size/Format check the measurement unit which the DXF file was 
originally created with (in this example it is mm). Make sure the same unit is displayed 
in the sub-tab File under Unit. Should this not be the case, select the correct unit from 
the drop-down list. 
 

10. Click on [Import]. 
 The imported data is displayed in the user guidance step Layout: 

 
Fig. 297: Imported data 

 The DXF file has been imported. 
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 Combining open paths 

 

Data imported from a DXF file can consist of open paths. To avoid problems during 
processing, open paths need to be converted to closed paths. 
 

1. Select the entire layout. 

 
Fig. 298: Layout selected 

2. Click on the right mouse button and in the context menu select the entry Combine 

open paths. 

 
Fig. 299: Combine open paths 

 The open paths have been combined. 
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 Modifying the workflow settings 

 

Before processing the DXF file, the workflow settings need to be modified. 

 

1. Switch to the user guidance step Workflow. 

 
Fig. 300: User guidance step Workflow 

2. Select the work package Cut Inside. 

 
Fig. 301: Selecting the work package Cut Inside 
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3. Expand the group Parameters. 

 
Fig. 302: Group Parameters expanded 

4. Select the entry Center from the drop-down list Position. 

 
Fig. 303: Entry Center selected 

5. Click on [Apply]. 

 The workflow settings have been modified. 

 

 

  

 
Modifying the workflow settings 

The most important parameters when modifying the workflow settings before 
processing DXF files are Position and Channel width. 
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The parameter Position defines the position of the toolpaths (in yellow) in comparison 
to the DXF object (in magenta). There are three options: 
 
 

Option Definition Example of toolpaths 

Inside The toolpaths are located inside  
the DXF object. 

 
Outside The toolpaths are located 

outside the DXF object. 

 
Center The toolpaths are located 

outside and inside of the DXF 
object. 

 
 
The parameter Channel width defines the width of the cutting channel on the 
material. 
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 Computing toolpaths 

1. Switch to the user guidance step Toolpaths. 
2. Click on [Compute toolpaths] or on . 
 The dialog Computing toolpaths is displayed. 
3. Click on [Continue]. 
 The toolpaths are being calculated. The message Computation results is 

displayed. 
4. Check the computation results for any possible warnings or errors and make 

corrections, if needed. 
5. Click on [Close]. 
6. Save your project. 

 The toolpaths have been computed. 

The DXF file has successfully been imported in and converted for CircuitPro PL. 
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5.2 Processing Gerber and Ecxellon files in CircuitPro PL 
This chapter describes how to process Gerber and Excellon files in CircuitPro PL. It 
also shows typical errors during the import and suitable measures for troubleshooting. 

The following steps are performed in this tutorial: 

• Importing DXF files 
• Selecting the file format 
• Assigning the desired target layer during import 
• Assigning the desired target layer after import 
• Setting/Correcting the size and format 
• Checking/Modifying aperture properties 
• Using layer names from the Gerber file for import 
• Using layer names from the Gerber file as default 

 Selecting Gerber and Excellon files 

1. In the user guidance step New, select the template that suits the type of PCB you 
want to process. 
In this example the template Single-sided, Top, ProtoLaser U4 is used. 

2. Click on [Load template] or double-click on the template. 
 The user guidance step Material is displayed. 
3. Select the suitable material. 

In this example the material FR4, Sigle-sided, 1.5 mm, 18 µm is used. 

  
Fig. 304: Selecting the material 

4. Click on [Select material] or double-click on the material. 
 The user guidance step Import is displayed. 
5. Click on . 
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 The dialog Open is displayed. 
6. Navigate to the folder that contains the data you want to import. The example data 

used for this sequence are located in the folder: 
C:\Program Files\LPKF Laser & Electronics AG\ 

LPKF CircuitPro PL\Example Data\UseCase_GerberExcellonFiles. 
7. Select the files you want to import (in this example: Tutor.BOA, Tutor.BOT, 

Tutor.DRL, Tutor.SMB, Tutor.SMT, Tutor.SPT, Tutor.TOP). 
8. Click on [Open]. 
 The user guidance step Import is displayed. 

 
Fig. 305: User guidance step Import 
 

 

The following information on the imported files is displayed: 
 

Item Information Description 

1 File name Displays the name of the imported file. 

2 Format Displays the format of the selected file. If CircuitPro PL has not 
recognized the file format correctly, you can assign the correct 
format in the corresponding drop-down list. 

3 Aperture/Tool list Displays the aperture list/tool list that is usually a part of the 
Gerber or Excellon file. The apertures contained are displayed in 
the tab Apertures/Tools. 

4 Source Indicates the names of the paths/3D elements within the 
imported file. Activate the check boxes of the files that you want 
to import. 

5 Target Displays the layer to be assigned. 

6 Size/Format Displays the size/format of the imported layer. 
 

 

2 1
4 

3 

6 5 4 
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9. Deactivate the check boxes of the files you do not want to import (in this example: 
Tutor.BOT, Tutor.SMB, Tutor.SMT and Tutor.SPT). 

 The files have been deselected. 
The user guidance step Import changes as follows: 

 
Fig. 306: Deselected files 

 The Gerber and Excellon files have been selected. 
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 Selecting the file format 

In some cases it is possible that the format of the selected files is not recognized 
correctly. 

 

Note that the file problem described in this procedure was created intentionally. The 
files in the folder Example Data do not contain these problems. 
 

1. In the dialog Open, select the files you want to import (in this example: Tutor.BOA, 
Tutor.DRL and Tutor.TOP). 

2. Click on [Open]. 
 

 In the user guidance step Import, the file format as well as other file-specific 
information are missing (= Undefined). A yellow warning symbol is displayed next 
to the file name: 

 
Fig. 307: Format undefined 
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3. Select the appropriate file format from the drop-down list (in this example 
GerberX): 

 
Fig. 308: Selecting the appropriate file format 

 The missing file-specific information is displayed automatically. 

 
Fig. 309: Appropriate file format selected 
 

 The file format has been selected. 

If CircuitPro PL does not assign the file to the desired layer automatically, there are 
two ways to assign it manually. This takes place either during or after import of the 
files. Both possibilities are described as follows. 
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 Assigning the desired target layer during import 

1. In the dialog Open, select the files you want to import (in this example: Tutor.BOA, 
Tutor.DRL and Tutor.TOP). 

2. Click on [Open]. 
 In the user guidance step Import, the file Tutor.DRL has not been automatically 

assigned to an existing layer (the column Target is active and contains the name 
of the file): 

 
Fig. 310: Unassigned layer 

3. Select the desired target layer from the drop-down list (in this example DrillPlated): 

 
Fig. 311: Selecting the target layer 
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 The user guidance step Import changes as follows: 

 
Fig. 312: Selected target layer 

4. Click on [Import]. 
 The processing data are displayed in the user guidance step Layout. 

 
Fig. 313: User guidance step Layout 
 

 The desired target layer has been assigned during import. 
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 Assigning the desired target layer after import 

1. In the dialog Open, select the files you want to import (in this example: Tutor.BOA, 
Tutor.DRL and Tutor.TOP). 

2. Click on [Open]. 
 In the user guidance step Import, the file Tutor.DRL has not been automatically 

assigned to an existing layer: 

 
Fig. 314: Unassigned layer 

3. Click on [Import]. 
 The following message is displayed: 

 
Fig. 315: Info about new layer created 

4. Click on [Close]. 
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 A new layer Tutor.DRL has been created and the processing data are displayed in 
the user guidance step Layout: 

 
Fig. 316: User guidance step Layout | processing data 

5. In the pane Workflow setup, expand the group Layout and expand the node 
Layers. 

 A list of layers is displayed. 
6. Right-click on the layer Tutor.DRL (64) and click on the context menu item Select 

by layer. 

  
Fig. 317: List of layers | Select by layer 
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Alternatively, you can select the layer from the drop-down list: 
 

 

 
 
Right-click on the black background and select the context menu item Select by layer. 
 

 All objects on this layer are selected and highlighted. 
7. Right-click on the black background. 
8. In the context menu, click on Assign to layer > DrillPlated: 

 
Fig. 318: Assigning objects to target layer 

9. In the user guidance step Layout, click anywhere on the black background or 
press  to deselect the highlighted objects. 



 
 

 

ProtoLaser U4/S4/R4 
 

Processing files 

V. 4.0 | LPKF Laser & Electronics d.o.o.  255/274 

 The color of the holes changes to turquoise. 

 
Fig. 319: Assigned holes 
 

 The desired target layer has been assigned after import. 
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 Setting import assignments 

During file import, some files are automatically assigned to target layers and the 
column Target is inactive. This is a result of Import assignments settings. If you 
frequently use file names with the same suffixes, you can adapt the Import 
assignments to your requirements. 
 
Perform the following steps: 
 
 

1. Click on File > Options… 
 The dialog Options is displayed. 
2. Click on Import assignments. 
 The dialog changes as follows: 

 
 

 
3. Click on [New]. 
 The dialog Save As is displayed. 
4. Enter the new name of the .xml file and click on [Save]. 
 The dialog changes as follows: 

 
 

 
5. Click on [Add]. 
6. Enter the suffix of the file name in the column File Name. 
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7. Select the corresponding values from the drop-down lists in the columns Format, 
Layer/Template and Aperture/Tool list. 

8. Repeat the steps 6 and 7 for creating further Import assignments. 
9. When you have finished creating the desired Import assignments, click on [OK]. 
 The following figure displays an example of an import assignment setting for the 

file names with the suffix *.CUT: 

 
 

  
 

 

 Setting/Correcting the size and format 

In some cases, the layout of the file is not displayed correctly in CircuitPro PL. There 
are four possible causes for this: 

− Incorrect measurement unit: A wrong measurement unit was selected when 
importing the file (inch instead of mm). 

− Incorrect number of decimal digits: The number of decimal digits entered does 
not match the file's contents. 

− Incorrect declaration of the value (relative/absolute). 
− Incorrect zero suppression (decimal). 

 

Note that the file problem described in this procedure was created intentionally. The 
files in the folder Example Data do not contain these problems. 
 

1. In the dialog Open, select the files you want to import (in this example: Tutor.BOA, 
Tutor.DRL and Tutor.TOP). 

2. Click on [Open]. 
 

 In the user guidance step Import, the file Tutor.DRL displays a peculiarly large 
size of the layout: 

 
Fig. 320: Large size of the layout 
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The measurement unit for GerberX files is preset as default and cannot be modified. 
The measurement unit for all other file types (Excellon, Gerber etc.) can be modified. 
 

3. Check the Unit in the sub-tab File of the user guidance step Import (in this 
example Inches are selected). 

4. Select Millimeters from the drop-down list. 

 
Fig. 321: Selecting the appropriate unit 

 The dimensions of the layout change automatically: 

 
Fig. 322: Changed dimensions of the layout 

 The measurement unit has been checked and corrected. 
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If the layout is still not displayed correctly in the tab 2D, you should check the number 
of decimal digits. An incorrect preview of the layout data is displayed as follows: 

 
Fig. 323: Incorrect preview of the layout 

5. Check the Digits m.n in the sub-tab File of the user guidance step Import. 
6. Enter 3 in the n digit count. 
 The user guidance step Import changes as follows: 

 
Fig. 324: Correct preview of the layout 

 The number of decimal digits has been checked and corrected. 

 The size and format have been set/corrected. 
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 Checking/Modifying aperture properties 

1. In the user guidance step Import, select the file whose apertures you want to 
check (in this example Tutor.BOA). 

 The user guidance step Import changes as follows: 

 
Fig. 325: File Tutor.BOA selected 

2. Click on the tab Apertures/Tools and then on the sub-tab Attributes. 
 The user guidance step Import changes as follows: 

 
Fig. 326: Tab Apertures/Tools and sub-tab Attributes 
 

 

The following aperture properties can be modified in the sub-tab Attributes: 
 

− Shape of the aperture (circle, square, oval etc.) 
− aperture rotation 
− parameters of the aperture geometry 
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In this example, the aperture’s shape is to be changed from a circle to a rectangle. 

3. In the sub-tab Attributes under Type, select Rectangle from the drop-down list. 

 
Fig. 327: Selecting the type of aperture 

4. Enter 1.5 in the input field a:. 
 A preview of the modified aperture is displayed in the sub-tab Attributes: 

 
Fig. 328: Preview of the modified aperture 

 The aperture properties have been checked/modified. 
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The Gerber file format has an input field for the layer name. There are two ways to use 
the layer name for an import. Either you define for each import whether the layer name 
from the Gerber file is to be used or you set this function as default in the options. 
Both possibilities are described as follows. 

The layer name defined in the Gerber file is displayed in the tab Text of the user 
guidance step Import (in this example the file Tutor.BOA which contains the layer 
name BoardOutline is used): 

 
Fig. 329: Layer name in the file Tutor.BOA 
 

 Using layer names from the Gerber file for import 

1. In the dialog Open, select the files you want to import (in this example: Tutor.BOA, 
Tutor.DRL and Tutor.TOP). 

2. Click on [Open]. 
 The user guidance step Import is displayed. The layer names defined in the 

Gerber file are not used and not displayed in the column Target and in the column 
Source: 

 
Fig. 330: Layer names not used in the Gerber file 
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3. Select one of the Gerber files (in this example Tutor.BOA) and switch to the 
sub-tab Format. 

 
Fig. 331: Gerber file selected 

4. Activate the check boxes Use layer name and Apply to all Gerber files. 

 
Fig. 332: Activated check boxes 
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 The layer names defined in the Gerber files are displayed in the column Target 
and in the column Source: 

 
Fig. 333: Layer names defined in Gerber files displayed 

 The layer names from the Gerber file have been used for import. 

 Using layer names from the Gerber file as default 

1. Click on File > Options… 
 The dialog Options is displayed. 
2. Click on Formats > Gerber. 

 
Fig. 334: Dialog Options | Gerber 
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3. Set the value in line 1.5 Use layer name to True. 

 
Fig. 335: Selecting value True for Use layer name 
 

 

If the value False is selected, the option is not activated as default. In such cases, 
when importing Gerber files, you must always define whether you want to use the 
layer names contained in the files. 
 

4. Click on [OK]. 
 The option for the default use of the layer name contained in the Gerber file has 

been activated. 
5. In the dialog Open, select the files you want to import (in this example: Tutor.BOA, 

Tutor.DRL and Tutor.TOP). 
6. Click on [Open]. 
 The user guidance step Import is displayed. The layer names defined in the 

Gerber file are displayed in the column Target and in the column Source: 

 
Fig. 336: Layer names defined in Gerber files displayed 

 The layer names from the Gerber file have been used as default. 

The Gerber and the Excellon files have been processed in CircuitPro PL. 
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